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Prefacio

Prefacio

Gracias por comprar este producto Topcon. La informacién que se
incluye en el presente Manual (el “Manual”) ha sido preparada por
Topcon Positioning Systems, Inc. (“TPS”) para los propietarios de
productos Topcon y su objetivo es facilitarles el uso del receptor,
estando el mismo sujeto a los presentes términos y condiciones (los
“Términos y Condiciones”).

Por favor, lea detenidamente estos Términos y
Condiciones.

Términos y Condiciones

USO Este producto se diseid para ser utilizado por un profesional. Es
necesario que el usuario sepa como utilizar el producto en forma
segura e implemente los tipos de procedimientos de seguridad
recomendados por la agencia gubernamental local de proteccion tanto
para uso privado como comercial.

DERECHOS DE PROPIEDAD INTELECTUAL Toda la informacién
que se incluye en el presente Manual constituye propiedad intelectual
de TPS y se encuentra sujeta a los derechos de autor de TPS. Se
reservan todos los derechos. Usted no puede utilizar, leer, copiar,
guardar, mostrar, crear obras derivadas, vender, modificar, publicar,
distribuir, o permitir el acceso de terceros a los graficos, contenido,
informacién o datos incluidos en el presente Manual sin el expreso
consentimiento por escrito de TPS y tinicamente podra utilizar esta
informacién para cuidar y operar su receptor. La informacién y datos
que se incluyen en el presente Manual constituyen un activo valioso
de TPS, han sido desarrollados invirtiendo trabajo, tiempo y dinero
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Prefacio

considerables y son resultado de la seleccion, coordinacién y
adaptacion originales efectuadas por TPS.

MARCAS REGISTRADAS GR-3™, Topcon Tools™, Topcon
Link™, TopSURV™, Modem-TPS™, Topcon® y Topcon
Positioning Systems™ son marcas comerciales o marcas registradas
de TPS. Windows® es una marca registrada de Microsoft
Corporation. La marca Bluetooth® y sus respectivos logotipos son
propiedad de Bluetooth SIG, Inc. y Topcon Positioning Systems, Inc.
se encuentra autorizado, mediante una licencia, a hacer uso de tales
marcas. Los demds productos y nombres de compaiifas a los que se
hace mencién en el presente manual son marcas registradas de sus
respectivos propietarios.

EXCLUSION DE GARANTIAS CON EXCEPCION DE LAS
GARANTIAS QUE SE DESCRIBEN EN UN ANEXO O EN LA
TARJETA DE GARANTIA QUE ACOMPANA AL PRODUCTO,
EL PRESENTE MANUAL Y EL RECEPTOR SE ENTREGAN
“TAL COMO ESTAN”. NO EXISTEN OTRAS GARANTIAS. TPS
DESCONOCE CUALQUIER GARANTIA IMPLICITA DE
COMERCIALIZACION O IDONEIDAD PARA UN USO O FIN
PARTICULAR. TPS Y SUS DISTRIBUIDORES NO ASUMIRAN
RESPONSABILIDAD ALGUNA POR ERRORES TECNICOS O
EDITORIALES U OMISIONES COMETIDAS EN EL PRESENTE
DOCUMENTO; NI EN CASO DE DANOS INCIDENTALES O
QUE SURJAN A RAIZ DEL SUMINISTRO, DESEMPENO O USO
DEL PRESENTE MANUAL O DEL RECEPTOR. DICHOS
DANOS INCLUYEN, ENTRE OTROS, PERDIDA DE TIEMPO,
PERDIDA O DESTRUCCION DE DATOS, LUCRO CESANTE,
PERDIDAS DE AHORROS O GANANCIAS O PERDIDAS
GENERADAS POR EL USO DE PRODUCTOS. ADEMAS, TPS
NO SE RESPONSABILIZA POR DANOS O COSTOS
INCURRIDOS EN RELACION CON LA OBTENCION DE
PRODUCTOS O SOFTWARE SUSTITUTOS, RECLAMOS DE
TERCEROS, INCONVENIENCIA U OTROS COSTOS. EN
CUALQUIER CASO, TPS NO ASUMIRA RESPONSABILIDAD
POR LOS DANOS U OTROS ANTE USTED O CUALQUIER
OTRA PERSONA O ENTIDAD POR UN MONTO SUPERIOR AL
PRECIO DE COMPRA DEL RECEPTOR.
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Términos y Condiciones

ACUERDO DE LICENCIA El uso de programas o software de
computadora suministrados por TPS o que hayan sido descargados de
un sitio web de TPS (el “Software”) que se relacionen con el receptor
constituye la aceptacion de los Términos y Condiciones que se
describen en el presente Manual e indica su conformidad de continuar
aceptando los presentes Términos y Condiciones. Se otorga al usuario
una licencia personal, no exclusiva e intransferible de utilizar dicho
Software de conformidad con los términos sefialados en el presente
documento y, en cualquier caso, inicamente con un receptor o una
sola computaodra. Usted no debera ceder o transferir el Software o
esta licencia sin el expreso consentimiento por escrito de TPS. Esta
licencia tendré validez hasta que se dé por terminada. Usted puede dar
por terminada la licencia en cualquier momento mediante la
destruccién del Software y del Manual. TPS podra dar por terminada
la licencia si usted no cumple con cualquiera de los Términos y
Condiciones. Usted se compromete a destruir el Software y el manual
después de dejar de utilizar el receptor. Todos los derechos de
propiedad, derechos de autor y de propiedad intelectual del Software
pertenecen a TPS. Si considera que los términos de esta licencia no
son aceptables, devuelva el software y el manual sin utilizar.

CONFIDENCIALIDAD EI presente Manual, su contenido el Software
(denominados en conjunto, “Informacién Confidencial”’) constituyen
informacién confidencial y son propiedad de TPS. Usted se
compromete a tratar la Informacién Confidencial de TPS con un nivel
de cuidado no menos estricto que el que tendria para proteger sus
documentos comerciales secretos de mayor valor. Nada de lo
expresado en este parrafo implica que usted quede impedido de
divulgar Informacién Confidencial a sus empleados que resulte
necesaria o conveniente para operar o cuidar el receptor. Dichos
empleados también deben mantener de manera confidencial la
Informacién Confidencial. En caso de que usted se vea legalmente
obligado a divulgar la Informacién Confidencial, debera
comunicdrselo de inmediato a TPS de manera que TPS pueda buscar
una orden de proteccién u otro remedio adecuado.

SITIO WEB; OTRAS DECLARACIONES Ninguna declaracién
incluida en el sitio web de TPS (o en cualquier otro sitio web) o en
publicidad o literatura de de TPS o efectuada por un empleado o un
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contratista independiente de TPS modifica los presentes Términos y
Condiciones (incluyendo la licencia, garantia y limitacién de
responsabilidad del Software).

SEGURIDAD IEI uso inadecuado del receptor puede ocasionar dafios
a personas o propiedad y/o el funcionamiento incorrecto del producto.
El receptor unicamente deberd ser reparado en los centros de servicio
y garantia autorizados de TPS. Los usuarios deben revisar y prestar
atencion a las advertencias de seguridad que se incluyen en algtin
Anexo.

VARIOS Topcon podra enmendar, modificar, anular o cancelar los
Términos y Condiciones antes mencionados en cualquier momento.
Los Términos y Condiciones antes mencionados se regirdn e
interpretardn de conformidad con las leyes del Estado de California,
sin referencia a conflictos juridicos.

Convenciones Utilizadas en el
Manual

El presente manual utiliza las siguientes convenciones:

Ejemplo Descripcién
File » Exit Haga clic en el mend File (Archivo) y después en
Exit (Salir).
Conexion Indica el nombre de un cuadro de didlogo o pantalla.
Frecuencia Indica un campo en un cuadro de didlogo o pantalla o
una pestaiia dentro de un cuadro de didlogo o
pantalla.
Enter Presione o haga clic sobre el botén o tecla Enter.
% Informacién importante que debe tenerse en cuenta
g = parala Fonﬁguracmn, mantenimiento o instalacién
__~r de un sistema.
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Convenciones Utilizadas en el Manual

RECOMENDACION

Informacién complementaria que puede ayudarlo a
configurar, mantener o instalar un sistema.

<

Informacién complementaria que puede tener un
efecto sobre la operacidon o desempeiio del sistema,
mediciones o seguridad personal.

Notificacién de que una accién puede tener efectos
adversos sobre la operacion o rendimiento del
sistema, integridad de los datos o la salud personal.

Notificacién de que una accidn generara el dafio del
sistema, pérdida de datos, pérdida de la garantia o
dafios personales.

Bajo ninguna circunstancia debe ejecutar esta
accion.
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Notas:
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Capitulo 1

Introduccion

El receptor GR-3 (Figura 1-1 en la pagina 1-2) es un receptor GPS+
multi-frecuencia desarrollado para ser el receptor mas avanzado y
compacto del mercado topografico. El receptor es un receptor
multifuncional y multi-propésito disefiado para mercados de
precision. El término mercados de precision hace referencia a
equipos, subsistemas, componentes y software para topografia,
construccién, mapas comerciales, ingenieria civil, agricultura de
precisién y construccion en tierra y control de maquinaria para
agricultura, mapeo fotogramétrico, hidrografia y todo uso que se
relacione, de manera razonable, con los que se han mencionado
anteriormente.

El GR-3 puede recibir y procesar multiples tipos de sefiales
(incluyendo las senales GPS L2C, GPS L5, GLONASS C/A L2y
GALILEO més recientes) mejorando la precision y confiabilidad de
sus puntos y posiciones de levantamiento, especialmente si las
condiciones del lugar de trabajo son dificiles. Las funciones
multifrecuencia y GPS+ del receptor se combinan para ofrecer un
sistema de posicionamiento preciso para cualquier levantamiento.
Otras caracteristicas mds, entre las que se incluyen la minimizacién
del efecto multipath, garantizan la recepcién con follaje denso y con
sefales débiles. El receptor ofrece la funcionalidad, precision,
disponibilidad e integridad requeridas para colectar datos en forma
répida y sencilla.
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Introduccién

Figura 1-1. Receptor GR-3

Principios de Operacion

Si el usuario utilza el receptor GPS correcto, podré efectuar
levantamientos con un posicionamiento preciso y exacto, lo cual
constituye un requisito indispensable para cualquier proyecto
topografico.

Esta seccion le ofrece una descripcion general de los Sistemas
Satelitales de Navegacion Global (GSNS) propuestos y de las
funciones del receptor con el objeto de ayudarlo a comprender y
aplicar los principios operativos basicos que le permitan sacarle el
maximo provecho a su receptor.

Descripcion General de GNSS

En la actualidad, los siguientes tres sistemas satelitales de navegacion
global (GNSS) ofrecen navegacién y posicionamiento de radio de
topologia de red, velocidad y servicios horarios a nivel mundial y con
cualquier clima a cualquier usuario que cuente con un receptor GNSS
en o cerca de la superficie terrestre:

* GPS - Sistema de Posicionamiento Global a cargo del
Departamento de Defensa de los Estados Unidos. Si desea
obtener informacién con respecto al estado de este sistema, visite
el sitio web del Observatorio Naval de los Estados Unidos (http://
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Principios de Operacién

tycho.usno.navy.mil/) o el sitio web de la Guardia Costera de los
Estados Unidos (http://www.navcen.uscg.gov/).

* GLONASS - Sistema Satelital de Navegacion Global a cargo del
Ministerio de Defensa de la Federacién Rusa. Si desea obtener
informacién con respecto a este sistema, visite el sitio web del
Coordinational Scientific Information Center (http://
www.glonass-center.ru/frame_e.html).

* GALILEO - Préximo sistema de posicionamiento global que
estard a cargo de Galielo Industries, joint-venture formada por
varias agencias/compaiiias espaciales europeas que trabajan en
forma estrecha con la Agencia Espacial Europea. A diferencia de
GPS y GLONASS, éste es un esfuerzo civil y actualmente se
encuentra en etapa de desarrollo y validacién. Si desea obtener
informacion con respecto al estado de este sistema, sirvase visitar
el sitio web de Galileo Industries (http://www.galileo-
industries.net).

A pesar de las numerosas diferencias técnicas en la implementacién
de estos sistemas, los sistemas de posicionamiento global constan de
tres componentes basicos:

* Espacio — Los satélites GPS, GLONASS y GALILEO orbitan
aproximadamente a 12,000 millas nduticas sobre la Tierra y estan
equipados con un reloj y un radio. Estos satélites transmiten
sefiales de alcance y diversa informacion digital (efemérides,
almanaques, correcciones de tiempo y frecuencia, etc.).

» Control — Estaciones terrestres ubicadas alrededor de la tierra que
monitorean los satélites y cargan datos, incluyendo correcciones
horarias y efemérides nuevas (posiciones satelitales como una
funcién de tiempo) con el fin de garantizar que los satélites
transmitan correctamente los datos.

* Usuario — La comunidad civil y militar que utiliza los receptores
GNSS para calcular posiciones.
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Introduccién

Calculo de Posiciones Absolutas

Al calcular una posicién absoluta, un receptor fijo o en movimiento
determina su posicién tridimensional con respecto al origen de un
sistema de coordenadas ECEF (Earth-Center Earth-Fixed). Para
calcular esta posicidn, el receptor mide la distancia (denominada
pseudorangos) entre éste y un minimo de cuatro satélites. Se corrigen
las diferencias horarias de los pseudorangos (receptor y satélites) y
los retardos de propagacién de la sefial debido a efectos atmosféricos.
Las posiciones de los satélites se calculan a partir de los datos de
efemérides transmitidas al receptor en los mensajes de navegacion.
Cuando se utiliza un soélo sistema satelital, el ndmero minimo de
satélites que se requieren para calcular una posicién es cuatro. En un
escenario de satélites mixtos (GPS, GLONASS y GALILEO), el
receptor debe capturar cinco o mas satélites para representar las
diferentes escalas temporales que se utilizan en estos sistemas y
obtener una posicién absoluta.

Calculo de Posiciones Diferenciales

DGPS, o GPS diferencial, es una técnica de posicionamiento relativo
que combina y procesa las mediciones de dos o mds receptores
remotos mediante algoritmos sofisticados que permiten calcular las
coordenadas relativas de los receptores con alta precision.

DGPS se adecua a diversas técnicas de implementacién que pueden
clasificarse de acuerdo con los siguientes criterios:

¢ El tipo de mediciones GNSS utilizado, ya sea mediciones
diferenciales de c6digo-fase o mediciones diferenciales de
portadora-fase

* Si se requieren resultados en tiempo real o post-misién

Las aplicaciones en tiempo real pueden sub-dividirse de acuerdo
con la fuente de datos diferenciales y del enlace de comunicacién
que utilicen.

Con DGPS, en su enfoque maés tradicional, un receptor se coloca en
una ubicacién conocida levantada y se le denomina receptor de
referencia o estacion base. Otro receptor se coloca en una ubicacién
desconocida y se le denomina receptor remoto o rover. La estaciéon de
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Principios de Operacién

referencia colecta las mediciones de cddigo-fase y de portadora-fase
para cada satélites GNSS visible.

* Para aplicaciones en tiempo real, estas mediciones y las
coordenadas de la estacién de referencia se efectian de acuerdo
con estandares de la industria (RTCM o diversos estandares
propietarios) que se establecen para transmitir correcciones
diferenciales al(os) receptor(es) remoto(s) utilizando un enlace de
comunicacion de datos. El receptor remoto aplica la informacion
de medicion transmitida a sus mediciones observadas de los
mismos satélites.

* Para aplicaciones post-mision, las mediciones simultdneas de
estaciones de referencia y rover se registran, por lo general, en la
memoria intenra del receptor (no se envian sobre el enlace de
comunicacion). Después los datos se descargan a la computadora,
combinan y procesan.

Con esta técnica, los errores correlacionados a nivel espacial,
tales como errores orbitales satelitales, errores ionosféricos,
pueden reducirse en forma considerable, mejorando la precisién
de la solucion de posicionamiento.

Existe una serie de implementaciones de posicionamiento diferencial,
incluyendo el levantamiento de post-proceso, levantamiento
cinematico en tiempo real, radiofaros maritimos, satélites
geoestacionarios (como el servicio OmniSTART), y sistemas de
aumentacion basados en satélites (WAAS, EGNOS, MSAS).

El método cinemético en tiempo real (RTK) es el método mds preciso
de levantamiento GPS. El método RTK requiere un minimo de dos
receptores que colecten datos de navegacion y un enlace de datos de
comunicacién entre los dos receptores. Uno de los receptores se
encuentra, por lo general, en una ubicacién conocida (Base) y el otro
en una ubicacién desconocida (Rover). El receptor Base colecta
mediciones de fase portadora, genera correcciones RTK, y envia estos
datos al receptor Rover. El Rover procesa estos datos transmitidos con
sus propias observaciones de fase portadora para calcular su posicion
relativa con alta precision, logrando una precisiéon RTK de hasta 1 cm
horizontal y 1.5 cm vertical.
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Componentes Basicos para un Levantamiento
de Calidad

Para lograr resultados de posicionamiento de calidad, se requieren los
siguientes elementos:

* Precisién — La precision de una posicién depende basicamente de
la geometria satelital (Dilucién Geométrica de la Precisién o
GDOP) y de los errores de medicion.

— El posicionamiento diferencial (DGPS y RTK) disminiye
consideramente los errores atmosféricos y orbitales, y
contrarresta las sefiales de Disponibilidad Selectiva (SA)
transmitidas por el Departamento de Defensa de los Estados
Unidos con las sefiales GPS.

— Mientras mayor sea el nimero de satélites visibles, mds fuerte
serd la sefial, menor el nimero de DOP y mds preciso el
posicionamiento.

* Disponibilidad — La disposnibilidad de los satélites afecte el
célculo de las posiciones vélidas. Mientras mayor sea el niimero
de satélites disponibles, mas valida y precisa serd la posicion. Los
objetos naturales y aquellos creados por el hombre pueden
bloquear, interrumpir y debilitar las sefiales, reduciendo el
nimero disponible de satélites y afectando de manera negativa la
recepcién de sefiales.

* Integridad — La tolerancia a las fallas hace posible que una
posicioén sea mas integra, mejorando asi la precision de la misma.
Diversos factores se combinan para ofrecer una tolerancia a las
fallas, entre los que se incluyen:

— EI Monitoreo Auténomo de la Integridad del Receptor
(RAIM, por sus siglas en inglés) detecta satélites GNSS
defectuosos y los elimina del célculo de la posicién.

— Cinco o mas satélites visibles s6lo para GPS o sé6lo para
GLONASS; seis o més satélites visibles para escenarios
mixtos.

— Los Sistemas de Aumentacién Basados en Satélites (WAAS,
EGNOS, etc.) crean y transmiten, junto con las correcciones
DGPS, informacién acerca de la integridad de los datos (por
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ejemplo, advertencias con respecto a la condicién de los
satélites).

— Efemérides y almanaques actuales.

Conclusion

Esta descripcion general explica, de manera sencilla, los conceptos
bésicos del posicionamiento satelital. Si desea obtener informacién
mas detallada, visite el sitio web de TPS.

Descripcion General del Receptor

Una vez encendido el receptor y que se ha completado la prueba
automdtica, se inicializan los 72 canales del receptor y comienzan a
rastrear satélites GPS visibles. Cada uno de los canales del receptor
puede utilizarse para rastrear cualquiera de las sefiales GPS,
GLONASS o GALILEO. EL nidmero de canales disponibles permite
al receptor rastrear todos los satélites de posicionamiento global
visibles en cualquier momento y ubicacidon.

Mediante un cable coaxial, la antena GPS+ equipada con un
amplificador de bajo ruido (LNA, por sus siglas en inglés) se conecta
con el dispositivo de radiofrecuencia (RF) del receptor. La senal de
banda ancha recibida se convierte, filtra, digitaliza y asigna a canales
diferentes. El procesador del receptor controla el proceso de rastreo
de la senal.

Una vez que el canal capta la sefial, ésta es demodulada y se miden
los pardmetros de sefial necesarios (portadora y fases de c6digo).
Asimismo, los datos de navegacion transmitidos son recuperados
desde el marco de navegacion.

Después que el receptor captura cuatro o mas satélites, se calcula su
posicion absoluta en WGS-84 y el ajuste horario entre el reloj del
receptor y la hora GPS. Esta informacién y los datos de medicién

pueden guardarse en una tarjeta MMC o SD opcional1 y descargarse
después en una computadora, para luego ser procesado con un
paquete de software de post-proceso. Cuando el receptor opera en el

1. MMC = Tarjeta multimedia; SD = segura digital
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modo RTK, las mediciones de datos brutos también pueden
registrarse en la memoria interna del receptor. Esto le permite al
operador corregir, en tiempo real, los resultados obtenidos en el
campo.

Dependiendo de sus opciones, las capacidades del receptor incluyen:
* Reduccioén del efecto multipath

¢ Sistemas de aumentacion basados en satélites (WAAS, EGNOS,
etc.)

* Circuitos ajustables de bucle de enganche de fase (PLL) y
pardmetros de bucle de enganche o retardo (DLL)

* Modos de doble frecuencia o multi-frecuencia, incluyendo modos
de levantamiento estitico, cinemdtico, cinemético en tiempo real
(RTK) y GPS diferencial (DGPS) (los modos DGPS incluyen
estatico, cinematico y RTK)

* Registro automatico de datos
* Configuracion de diferentes angulos de error
» Configuracién de pardmetros de levantamiento diferentes

e Modos estatico o dinamico
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Procedimientos Iniciales

El GR-3 es un receptor GPS de 72 canales con baterias externas
desmontables, dos puertos de datos, una interfaz para controlar y ver
el registro de datos, ranura para tarjetas de memoria externas, un radio
modem interno, un médulo con la tecnologia inaldmbrica Bluetooth®
y un médulo GSM/GPRS opcional.

Baterias

El receptor GR-3 viene equipado con dos baterias recargables y
desmontables (Figura 1-2) para alimentar el receptor.

Figura 1-2. Baterias del GR-3

El receptor se alimenta con una bateria a la vez antes de pasar a la
segunda bateria. Cada baterfa desmontable puede alimentar al
receptor entre 4h30m y 8h30m (aproximadamente) de operacion,
dependiendo del modo de éste.

La base de carga de la bateria (Figura 1-3 en la pagina 1-10) se
conecta a un tomacorriente estdndar con el cable adaptador de energia
y la unidad del cable de alimentacién/fuente de alimentacién. Cuando
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se conecta a un tomacorriente, las baterias se cargardn por completo
en aproximadamente seis horas. Las baterias funcionardn a no menos
del 80% de su capacidad después de 500 ciclos de carga. Estas
baterias no necesitan descargarse antes de ser recargadas.

El cargador tiene dos puertos, un boton y tres LEDs.

Los dos puertos conectan el cargador al receptor o a una fuente de
alimentacién externa. Los puertos cargan o consumen las baterias
en forma simultanea.

El botén STATUS (Estado) activa los LEDs de la bateria.
Presione STATUS para conocer el nivel de carga para la bateria
correspondiente.
Los LEDs de las dos baterias muestran el porcentaje de carga de
la bateria conectada.

— Verde: indica una carga de méas del 85%.

— Anaranjado: indica una carga intermedia.

— Rojo: indica una carga de menos del 15%.
El LED de alimentacion se enciende cuando el cargador se
conecta a una fuente de alimentacion externa; como es el caso de
una toma eléctrica u otra fuente de alimentacidn (bateria de 12

voltios).
Dos puertos de entrada/salida de energia

Botonde
Bateria ESTADO Bateria & TOPQON _

(]

O]
l—\u T > 4
o O] 5 g n jumd] D
(® STATUS @ ~ " ~ ~

Alimentacion

0

J

Figura 1-3. Cargado de Baterias con Baterias
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El cargador de baterias puede acoplarse también a un tripode, a un
cinturén o a un bastén RTK para proporcionar alimentacidn externa a
la estacion base o rover.

El estuche para baterias AA (Figura 1-4) aloja cuatro baterias AA
para brindar una fuente de alimentacién de respaldo portatil para el
receptor en forma sencilla. Debido a las diferencias e ncuanto a la
capacidad de las baterias AA, y al modo de receptor y tipo de médem,
variard el tiempo de alimentacion de un receptor a otro.

) o] o
- 1 | }
| A !
o] O Q) 9

Figura 1-4. Estuche para Baterias AA (Abierto)

No utilice baterias AA recargables.
/\ o o o
CEID  Noutilice el estuche para baterias si el radio médem

se encuentra en el modo de trasmision.

Receptor GR-3

El disefio avanzado del receptor GR-3 reduce el nimero de cables
requeridos para la operacion, lo cual le permite efectuar
levantamientos en forma mds confiable y eficiente. La carcasa tiene
espacio para dos baterfas recargables extraibles, ranuras para tarjetas
SD/MMC y SIM, un médulo con la tecnologia inaldmbrica
Bluetooth, una tarjeta de receptor multi-sistema y una tarjeta de
comunicaciones para radio médem.

El GR-3 viene con una de las siguientes configuraciones:

e con radio médem FH915 Plus TX/RX/RP!

* con un radio médem FH915 Plus TX/RX/RP y un médulo GSM/
GPRS

¢ sin un radio médem

1. RP =repetidora
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Otras caracteristicas incluyen dos puertos de datos, un puerto de
alimentacién y una MINTER para visualizar el estado y controlar la
entrada/salida de datos.

MINTER

La MINTER es la interfaz minima de Topcon que se utiliza para
desplegar y controlar la entrada y salida de datos (Figura 1-5).

Los LEDs de las baterias muestran el estado de alimentacion de
cada bateria:

* Verde — indica una carga de mas del 85%.
* Anaranjado — indica una carga intermedia.

* Rojo —indica una carga de menos del 15%.

El LED STAT muestra el estado de los satélites rastreados.

* Parpadeo de color rojo — El receptor se encuentra encendido, pero
no estan rastredndose satélites.

» Parpadeo de color verde — el receptor se encuentra encendido y
estd rastreando satélites; un parpadeo por satélite GPS rastreado.

» Parpadeo de color anaranjado — el receptor se encuentra
encendido y estd rastreando satélites; un parpadeo por satélite
GLONASS rastreado.

REC RX TX
STAT -\ -\ /- /- BT
i !

Botén de J \_ Botén de /‘777‘\

Encendido FUNCION

Bateria Bateria

Figura 1-5. MINTER del GR-3
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El LED REC muestra el estado de grabacién de datos. Consulte el
“El botén de FUNCION” en la pagina 1-15 donde encontrard més
informacién con respecto al comportamiento del LED REC cuando se
utiliza el botén de FUNCION.

* Parpadeos de color verde — Cada parpadeo indica que los datos
estdn escribiéndose en la tarjeta SD/MMC.

* Anaranjado Fijo — indica que el receptor estd cambiando de
modo.

» Parpadeos de color anaranjado — indica que el receptor estd
verificando su sistema interno de archivos (después de borrar la
NVRAM o cargar un firmware nuevo). Durante esta operacion,
no serd posible acceder al sistema de archivos para aplicaciones
CDU (unidad de pantalla de control) o para la grabacién de datos.
Esta operacion podria requerir desde fracciones de segundo hasta
varios minutos, dependiendo de las circunstancias y del estado de
la memoria interna.

* Rojo Fijo — indica una condicién de falla con el receptor
(memoria agotada, no se inserté una tarjeta SD/MMC, problema
de hardware o un OAF incorrecto).

La Tabla 1-2 de la pagina 1-15 describe el estado del LED REC
cuando se utiliza el botén de FUNCION.

El LED RX TX muestra el estado del médem

La Tabla 1-1 de la pagina 1-14 describe los colores y patrones de
LEDs para los diferentes médems disponibles para el receptor GR-3.
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Tabla 1-1. Indicaciones del LED RX TX

* Luz apagada — el médem estd apagado.

¢ Parpadeo de color verde — el médem se encuentra en el modo
receptor.

¢ Verde Fijo — se ha establecido un radio enlace; el médem estd
listo para recibir datos.

* Verde Fijo mds Parpadeo de color rojo — el médem estd

, recibiendo datos.
Médem FH915

Plus * Rojo Fijo —el médem esta trasmitiendo datos.

* Parpadeo de color rojo — se ha detectado una falla. Verifique la
condicién de la antena del radio médem para descartar que se
encuentre dafiada, y y asegurarse de que encuentre conectada y
asegurada correctamente. Ademds, aseguirese de que nada
interrumpa la sefial.

* Parpadeos de color rojo mds parpadeos de color verde — el
moddem se encuentra en el modo de comando.

* Anaranjado Fijo (Rojo y Verde) - el médem esta
inicializdndose.

* Parpadeos de color verde — el médem esta encendido,
registrado en la red, y esperando llamadas entrantes (modo

Esclavo).

GSM/GPRS R . )
* Rojo Fijo — se ha establecido una conexion.

* Parpadeos de color verde - el médem se encuentra en el modo
de control directo (Cadena tipo Margarita).

¢ Parpadeos de color anaranjado — se produjo un error (error de
inicializacién, cédigo PIN incorrecto, etc.).

El LED BT indica el nivel de actividad en el enlace de comunicacion
de la tecnologia inaldmbrica Bluetooth:

* Parpadeos de color azul — el médulo Bluetooth se encuentra
encendido pero no se ha establecido una conexion.

* Azul Fijo — el médulo Bluetooth se encuentra encendido y se ha
establecido una conexion.

* Luz apagada — el médulo Bluetooth estd apagado.

El botén de Alimentacion enciende y apaga el receptor.
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El botén de FUNCION alterna entre los modos de informacion y los
modos de post-proceso, inicia/detiene la grabacion de datos y cambia
la velocidad de transferencia en baudios del puerto serial a 9600.
Consulte “Operacién de la MINTER” en la pagina 4-8 donde
encontrard mds informacién al respecto. La Tabla 1-2 de

la pagina 1-15 describe el estado del LED REC cuando se utiliza el
botén de FUNCION.

Tabla 1-2. Operaciones del Boton de FUNCION y Estado del LED REC

Teclade
FUNCION

LED REC

Estado

Si la grabacién de

datos se encuentra desactivada, y la tecla de FUNCION est4...

Sin presionar

Luz apagada | No se graban datos.

Parpadeo de | Prueba del sistema interno de archivos en
color progreso.

anaranjado

Rojo Sin memoria libre, problema del hardware al

grabar datos. Sin tarjeta SD/MMC.

Presionada
durante < de 1
segundo

Si el modo de la tecla de FUNCION se encuentra en “control
del modo de parpadeo del LED”

Anaranjado

Soltar para cambiar el modo de informacién.

Siel modo del
ocupacién”

a tecla de FUNCION ES “Control del modo de

Anaranjado

Sin funcioén.

Presionada de 1
a 5 segundos

Si el modo de la tecla de FUNCION es “Control del modo de
parpadeo del LED”

Verde

Soltar para iniciar registro (modo de
ocupacidn de post-proceso Cinemético o
Estatico no definido).

Si el modo de la tecla de FUNCION se encuentra en el
“Control del modo de ocupacién”

Verde

Soltar para iniciar grabacién (modo de
ocupacidn de post-proceso cinemadtico o
estatico)
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Tabla 1-2. Operaciones del Boton de FUNCION y Estado del LED REC

Teclade
FUNCION

LED REC

Estado

Presionada de 5
a 8 segundos

Rojo

Soltar para que la tasa de transferencia en
baudios del puerto serial A sea 9600 bps.

Presionada
durante > de 8
segundos

Apagado

Sin funcion.

Cuando la grabaci
estd...

6n de datos se encuentra activada, y la tecla de FUNCION

Sin presionar

Rojo

Sin memoria libre, problema del hardware al
grabar datos.

Si el modo de la tecla de FUNCION se encuentra en “control
del modo de parpadeo del LED”

Verde

Grabacion de datos iniciada (modo
indefinido de ocupacién de post-proceso).

Si el modo de la tecla de FUNCION se encuentra en “Control
del modo de ocupacién”

Verde Grabacion de datos iniciada (modo de
ocupacién de post-proceso cinematico).
Anaranjado Grabacion de datos iniciada (Modo de

ocupacién de post-proceso estatico).

Presionada
durante < de 1
segundo

Si el modo de la tecla de FUNCION se encuentra en “control
del modo de parpadeo del LED”

Anaranjado

Soltar para cambiar el modo de informacién.

Si el modo de la tecla de FUNCION se encuentra en “Control
del modo de ocupacién”

a 8 segundos

Anaranjado Soltar par adesplazarse entre los modos de
post-proceso Estético y Cinematico.
Presionada de Apagado Soltar para detener la grabacién de datos.
1-5 segundos
Presionadade 5 | Rojo Soltar para que la tasa de transferencia en

bauidos del puerto serial A sea 9600 bps.

1-16
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Tabla 1-2. Operaciones del Boton de FUNCION y Estado del LED REC

Tecla de

FUNCION LED REC Estado
Presionada Apagado Sin funcién (grabacién de datos atin en
durante > de 8 proceso).
segundos

Puertos de Datos y Alimentacion

El GR-3 tiene los siguientes tres puertos (Figura 1-6):

* USB - con borde amarillo, se utiliza para la transferencia y
comunicacién de datos a alta velocidad entre el receptor y un

dispositivo externo.

El cuerpo del conector del cable correspondiente es amarillo.

* Serial — con borde negro; se utiliza para la comunicacién entre el

receptor y un dispositivo externo.

El cuerpo del conector del cable correspondiente es negro.

» Alimentacion — con borde rojo; se utiliza para conectar el
receptor a una fuente de alimentacion externa. Este puerto puede

utilizarse también para cargar las baterias.

El cuerpo del conector del cable correspondiente es rojo.

USB Serial Alimentacion

(negro)

(ame{rillo) (ro}o)

s
S ‘11‘ f 00 \?;/ 10

Figura 1-6. Puertos GR-3
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Conector de la Antena de Radio Externa

La antena SS se conecta al conector de la antena externa en el radomo
del GR-3 (Figura 1-7). La antena SS/GSM utiliza una conexién TNC
de polaridad invertida.

Conector de
la Antena
Externa

Figura 1-7. Radomo del GR-3 'y Conector de Antena Externa

Conector

El conector inferior (Figura 1-8) conecta el receptor a cualquier
bastén roscado/adaptador de 5/870 al adaptador de desconexion
rdpida (consulte “El dispositivo de desconexion rapida” en la
pagina 1-23 donde encontrard mds informacion al respecto).

Conector inferior para
Instalacién Estandar

Figura 1-8. Conector Rapido del GR-3
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Ranuras para Tarjetas SD/MMC y SIM

Las ranuras para tarjetas SD/MMC! y SIM se ubican debajdo de las
baterias cerca de la base del domo.

Laranura para tarjetas SD/MMC se ubica a la izquierda de la
MINTER dentro del compartimiento para baterias (Figura 1-9 en la
pégina 1-20) y conecta una tarjeta opcional SD/MMC a la tarjeta del
receptor para dotarlo de memoria. Una vez instalada, la tarjeta SD/
MMC permance, por lo general, dentro del receptor. Es posible
acceder a los datos que residen en la tarjeta SD/MMC via el puerto
USB o serial, o la tecnologia inalimbrica Bluetooth. Las tarjetas
seguras digitales pueden adquirirse en tiendas locales de venta de
suministros de computo.

Laranura para tarjetas SIM se ubica a la derecha de la MINTER
dentro del compartimiento para baterias y permite instalar una tarjeta
SIM estandar en el receptor. Una vez instalada, la tarjeta SIM
proporciona una identificacion tnica para el médulo GSM del
receptor y hace posible la funcionalidad GSM del receptor de acuerdo
con los servicios suscritos (la tarjeta del receptor accede al médulo
GSM que accede a la tarjeta SIM). La tarjeta SIM permanece, por lo
general, dentro del receptor. Es posible acceder al médulo GSM de la
tarjeta SIM instalada via el Modem-TPS para propdésitos de
configuracién. Puede adquirir tarjetas SIM de su proveedor celular
local.

1. MMC = tarjeta multimedia; SD = segura digital
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Ranura para
Tarjeta SD/MMC
(para tjarta

Figura 1-9. Ejemplo de Ranuras para Tarjetas del GR-3

Cables

El paquete del GR-3 incluye cables de comunicacion y alimentacion
estdndar para configurar el receptor y suministrarle una fuente de
alimentacion. La Tabla 1-3 enumera los cables que se incluyen en el

paquete del GR-3.

Tabla 1-3. Cables del Paquete del GR-3

Descripcion del Cable

llustracién del Cable

Cable de Alimentacién

un tomacorriente.

p/n para Estados Unidos
14-008052-01

p/n para Europa 14-008054-01

p/n para Australia 14-008053-01

Conecta la unidad de alimentacién a

Cable de alimentacion/carga del
receptor

Conecta el receptor y la unidad de
alimentacion via conectores SAE

para cargar las baterias. El cuerpo
del conector es rojo.

p/n 14-008016-03

@
A

&
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Tabla 1-3. Cables del Paquete del GR-3 (Continuacion)

Descripcion del Cable llustracion del Cable

Cable de la base al receptor

Conecta el receptor a la base de

: d @@@@@@@C@@@@" )]
carga para proveer alimentacion )

externa. JEDDEDDEE®ED_
p/n 14-008072-01 (1.5m de largo)
p/n 14-008072-02 (0.5 m de largo)

Cable USB

Conecta el receptor a un dispositivo
externo (controlador o computadora
para la transferencia de datos de alta
velocidad y la configuracion del
receptor). El cuerpo del conector es
amarillo.

p/n 14-008070-01

Cable serial

Conecta el receptor a un dispositivo
externo (controlador o computadora)
para la transferencia de datos y la
configuracion del receptor. El
cuerpo del conector es negro.

p/n 14-008005-02

Otros Accesorios

Junto con los siguientes accesorios, el paquete del GR-3 incluye una
tarjeta de memoria SD de 128 MB, cinta métrica de 3 metros, un jalén
ajustable y un estuche para cables.

La unidad de Alimentacion (p/n 22-034101-01) carga las baterias
internas cuando se encuentra conectada a un tomacorriente puesto a
tierra (Figura 1-10 en la pagina 1-22). Esta unidad convierte la
corriente alterna (CA) que se obtiene normalmente de un
tomacorriente eléctrico en corriente continua (CC) que se utiliza para
cargar las baterias y/o alimentar el receptor.
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La unidad de alimentacion debe utilizarse
Unicamente para cargar las baterias. No la utilice
como fuente de alimentacidn durante trabajos de
levantamiento.

A

PRECAUCION
A

La unidad de alimentacién puede conectarse a la base de carga o
directamente al receptor. Si desea obtener mds informacién al
respecto, consulte las secciones correspondientes en el Capitulo 2.

Figura 1-10. Unidad de Alimentacion

La antena del modem Sde Espectro Ensanchado incluye un soporte
para un médem GSM (Figura 1-11). La antena de Espectro
Ensanchado es una conexion RF TNC de polaridad invertida

(p/n 30-030012-01).

Antena SS/GSM

Figura 1-11. Antena del Médem
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Procedimientos Iniciales

La base universal (tribrach) y el adaptador para tribrach (p/n
22-006008-01 y p/n 22-006009-011) se utilizan para nivelar el tripode
y asegurar el receptor o antena al tripode (Figura 1-12).

Figura 1-12. Base nivelante (tribrach) universal y adaptador de base nivelante

El dispositivo de desconexién rapida (p/n 02-850905-01) se
conecta al jalon para deslizar el receptor hacia arriba. Con los broches
laterales, el receptor puede colocarse/retirarse rdpidamente del jalén

(Figura 1-13).

Figura 1-13. Dispositivo de desconexién rapida

Si desea obtener mds informacion con respecto a los accesorios y
opciones de paquetes disponibles para el GR-3, sirvase ponerse en
contacto con su distribuidor local de Topcon.
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Introduccién

Accesorios Opcionales

Topcon ofrece una amplia variedad de accesorios especialmente
disefiados para hacer su trabajo mas confiable y eficiente. Si desea
obtener mds informacion con respecto a los accesorios opcionales
disponibles para el GR-3, sirvse ponerse en contacto con su
distribuidor local de Topcon.

El adaptador de la base nivelante de precision (Figura 1-14) se
utiliza para centrar, alinear y nivelar el tripode de manera segura sobre
un punto. El espaciador horizontal (p/n 60419) se inserta en la base
nivelante de precision y permite colocar el receptor en forma segura
en la base nivelante de precision.

Figura 1-14. Adaptador de la Base Nivelante de Precisién y Espaciador
Horizontal

Un controlador portéatil (Figura 1-15 en la padgina 1-25) permite
configurar y monitorear los sistemas Base y Rover del GR-3
directamente en el campo, TopSURYV (software de coleccion de datos
de campo) y CE-CDU (software de configuracién y monitoreo de
receptores) pueden utilizarse en controladores de Topcon para
configurar y manejar el receptor.
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Procedimientos Iniciales

FC-100 FC-2000

Figura 1-15. Ejemplos de Controlador Portatil

El cable de la ODU a las pinzas cocodrilo (p/n 14-008097-01LF)
conecta la base de carga o el receptor a una bateria auxiliar para
alimentar al receptor durante operaciones de levantamiento

(Figura 1-13).

Figura 1-16. Cable de Alimentacién Auxiliar - ODU a Pinzas Cocodrilo
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Introduccién

Archivo de Autorizacion de
Opciones (OAF)

Topcon Positioning Systems expide un Archivo de Autorizacion de
Opciones (OAF, por sus siglas en inglés) para habilitar las opciones
especificas adquiridas por el cliente. Un Archivo de Autorizacién de
Opciones permite a los clientes personalizar y configurar el receptor
de acuerdo con sus necesidades particulares, por lo cual s6lo
adquieren las opciones que necesitan.

Por lo general, todos los receptores incluyen un OAF temporal que
permite utilizar el receptor durante un periodo determinado de
tiempo. Al comprar el receptor, un OAF nuevo activa las opciones
deseadas y compradas de manera permanente. Las opciones del
receptor permanecen intactas al borrar la NVRAM o reiniciar el
receptor.

El OAF habilita los siguientes tipos de funciones. Si desea la lista
completa de opciones y detalles disponibles, visite el sitio web de
TPS o consulte con su distribuidor de TPS.

* Tipo de sefial (estdndar L1; L2 opcional, GPS L5, GLONASS,
GALILEO)

* Tarjeta de memoria SD externa

* Velocidad estdndar de actualizacién 1 Hz (opcional 5, 10 6 20
Hz)

* RTK a 1Hz, 5Hz, 10Hz y 20Hz

» Entrada/Salida RTCM/CMR

* Reduccién avanzada del efecto multipath

* Sistema de Aumentacién de Area Amplia (WAAS)

* Monitoreo Auténomo de la Integridad del Receptor (RAIM)
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Capitulo 2

Preparacion previa al
Levantamiento

Antes de comenzar a levantar con el receptor GR-3, necesita instalar
el siguiente software y aplicar las siguientes configuraciones:

O

O

Instale el software para configurar el receptor

Consulte “Instalacién del Software de Topcon” en la pagina 2-2.

Opcional: instale una tarjeta SD y/o tarjeta SIM

Consulte “Instalacion de las Tarjetas Opcionales SD y SIM” en la
pagina 2-7.

Cargue las baterias

Consulte “Carga de las Baterias” en la pagina 2-10.

Habilite los valores de la fuente de alimentacién (ya sea interna o
externa)

Consulte “Gestion de Energia” en la pdgina 2-11 y “Alimentacién
del Receptor” en la pagina 2-15.

Configure el mddulo de tecnologia inaldmbrica Bluetooth
Consulte “Configuracion del Médulo Bluetooth” en

la pagina 2-24.

Colecte almanaques y efemérides (después de las actividades de
configuracion que efectie la primera vez tal como se describe en
el Capitulo 3)

Consulte “Coleccion de Almanaques y Efemérides” en la
pagina 2-28.
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Preparacion previa al Levantamiento

Este capitulo trata también acerca de cémo conectar las baterias al
receptor, conectar el receptor y una computadora y alimentar el
receptor utilizando diferentes fuentes.

Instalacion del Software de
Topcon

El CD de GPS+ de Topcon incluye los siguientes programas de
software para configurar y dar mantenimiento al receptor. Este
software se encuentra disponible también en el sitio web de TPS para
usuarios registrados.

 PC-CDU Lite « BTCONF
ver. 2.1.15 o mas reciente ver. 1.2 o mas reciente
¢ Modem-TPS ¢ FlLoader
ver. 2.0 o mas reciente ver 1.0.07 o mas reciente

Si instala el(los) programa(s) del CD de GPS+, inserte el CD en la
lectora (CD-ROM) de la computadora. Si descarga el(los)
programa(s) del sitio web, guarde los archivos de programa en una
carpeta de su disco duro.

Las siguientes secciones describen la instalacion de este software, y
otras secciones a lo largo del manual describen cémo utilizar este
software con el receptor.

Instalacion de PC-CDU

PC-CDU™ es un producto integral de software de Windows® para
controlar receptores GPS+ desarrollados por Topcon Positioning
Systems. PC-CDU emplea el Lenguaje de Interfaz de Receptores
GPS (GRIL) para configurar diversos valores del receptor y
determinar el rendimiento del mismo.

El software PC-CDU viene en dos versiones: una version totalmente
funcional denominada PC-CDU MS y una versién menos funcional
denominada PC-CDU Lite. PC-CDU Lite se encuentra disponible en
forma gratuita en el sitio web de Topcon o en el CD de GPS+.
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Instalacién del Software de Topcon

Los requerimientos de la computadora para PC-CDU son: Windows®
98 0 una version posterior y un puerto RS-232C o USB port, o
habilitada para Bluetooth. Utilice PC-CDU versién 2.1.15 o mas
reciente para configurar el receptor en forma correcta.

donde encontrara toda la informacién que necesita

@ Consulte el Manual de Referencia de PC-CDU
para instalar y utilizar PC-CDU.

1. Cree una carpeta PC-CDU en su disco duro y coloque el archivo
zip de PC-CDU (obtenido del sitio web o del CD de GPS+) en
esta carpeta.

2. Busque la carpeta de PC-CDU y haga doble clic en el archivo zip
de PC-CDU.

3. Extraiga el archivo PCCDU.EXE y el archivo *.dll asociado a la
carpeta de PC-CDU (Figura 2-1).

4. Cree un acceso directo en el escritorio de la computadora para un
acceso rapido a PC-CDU (Figura 2-1).

File Edt View Favorites Tools  Hslp 7

Qe - @ (T | O (= Folders | il
Address |3 C:itopeonipecdu v a Go
Folders X Name Size | Type Date Modified
(@ Desktop | Blpccoy_ms .z B54KB WinZip File 14512004 4:56 PM #
5} My Documents %] LPTACCES V3D 6KE Virtudl devic...  §{1/2000 6:39 PM
= 4 My Computer ¥ PecDULEXE 2,224KB  Application 12j23{2003 5:16 PM IE-tI.'II.I

S 3% Floppy (81
e New Yolume [C:)
I3 Documents and Settings
I2) Program Files
|2 gquarantine
1 TEMP
= 1) topcon
3 peedu
123 unzipped
12 WINDOWS
ik €D Drive (D)
b CD Drive (E:) L/
< >

Figura 2-1. Extraer Programay Crear Acceso Directo

Para desinstalar PC-CDU, busque la ubicacién del archivo *.exe.
Seleccione el archivo y presione Delete.
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Preparacion previa al Levantamiento

Instalacion de Modem-TPS

Modem-TPS es un programa de configuracién para la tarjeta del radio
moédem del receptor. Modem-TPS se encuentra disponible en el sitio
web de TPS o en el CD de GPS+.

Los requerimientos de la computdora para Modem-TPS son:
Windows® 98 o posterior y un puerto RS-232C, o tecnologia
inaldmbrica Bluetooth. Utilice Modem-TPS version 2.0 o posterior
para configurar correctamente el receptor.

1. Busque la ubicacién del programa Modem-TPS y haga doble clic
en el icono Setup.exe.

2. Conserve la ubicacién de instalacién por defecto o seleccione una
nueva ubicacion. Haga clic en Finish (Figura 2-2).

Modem-TPS Installation

Please enter the directary in which to instal
Madem-TRS

Installing Files...

Extracting file to C:\Proaram Files M odem-TPS Wt dil

s

Modem-TPS Directony:

C:%Program Files'Modem-TPS

Change

Finish Cancel |

Figura 2-2. Seleccionar la Ubicacion donde se instalarda Modem-TPS e Instalar

3. Haga clic en OK para completar la instalacién (Figura 2-3).

4. Silo desea, cree un acceso directo en el escritorio de la
computadora para acceder rapidamente a Modem-TPS.

Modem-TPS Installation

Maodem-TPS installation successhull

AIDEM

Figura 2-3. Instalacién Completa y Acceso Directo
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Instalacién del Software de Topcon

Para desinstalar Modem-TPS, utilice el ment de Inicio de su
computadora:

Haga clic en Inicio » Programas » Modem-TPS » Uninstall
Modem-TPS, y haga clic en Yes en el aviso. A continuacion,
haga clic en OK al terminar la desinstalacion.

Instalacion de BTCONF

BTCONEF es un programa de configuracion para el médulo habilitado
con la tecnologia inaldmbrica Bluetooth que se encuentra dentro del
receptor. BTCONF se encuentra disponible en el sitio web de TPS o
en el CD de GPS+.

Los requerimientos de la Computer para BTCONF son: Windows®
98 0 mas reciente y un puerto RS-232C o la tecnologia inalambrica
Bluetooth. Utilice BTCONF version 1.2 o mds reciente para
configurar correctamente el receptor.

1. Cree una carpeta BTCONF en su disco duro y coloque el archivo
zip BTCONF comprimido (obtenido del sitio web o del CD de
GPS+) en esta carpeta.

2. Busque la carpeta BTCONF y haga doble clic en el archivo
BTCONTF zip.

3. Extraiga el archivo btconf.exe a la carpeta BTCONE.

4. Cree un acceso directo en el escritorio de la computadora para
acceder rapidamente a BTCONF (Figura 2-4 en la pagina 2-6).

Para desinstalar BTCONF, busque la ubicacion del archivo *.exe.
Seleccione el archivo y presione Delete.

Cada vez que ejecute BTCONF y configure el médulo Bluetooth,
BTCONF guarda sus configuraciones en un archivo (btconf.ini).
BTCONTF actualiza autométicamente el archivo cada vez que haga
cambios en las configuraciones del médulo Bluetooth.

Si desea mantener configuraciones tnicas del médulo
a Bluetooth para fines diferentes, copie el BTCONFG

RECOMENDACION

= en carpetas diferentes.
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Preparacion previa al Levantamiento

& btconf @@g\
File Edt View Favorites Tools Help o
@k - () (T D e [ Fders | [
Address |3 Ciftopeontbeanf | Bz
Folders X Name size | Type Date Modified “
(@ Deskton | Ebteonf zip 273KB WinZip File 8/17/2005 2:18 PM
{5} My Documents A btconf exe SS4KE  Application 6/20/200% 10:23 AM I?
= ' My Computer
S 3% Floppy (81 @mﬁﬂ
B % New Yolume [C1)
I3 Documents and Settings
1) Program Files
15 quarantine
1) TEMP
= 53 topcon
3 bicorf
9 peedu
15 unzipped
1) WINDOWS
< CD Drive (D) b
< I >

Figura 2-4. Extraer Programay Crear Acceso Directo

Instalacion de FLoader

FLoader es un programa que se utiliza para cargar firmware para la
tarjeta de alimentacion, médulo GPS y tarjeta de médem que se
encuentran dentro del receptor. FL.oader se encuentra disponible en el
sitio web de TPS o en el CD de GPS+.

Los requerimientos de la computadora para FLoader son: Windows®
98 o posterior y un puerto RS-232C o tecnologia inalaimbrica
Bluetooth. Utilice FLoader version 1.0.07 o posterior para configurar
correctamente el receptor.

1. Cree una carpeta FLoader en su disco duro y coloque el archivo
zip Floader (obtenido del sitio web o del CD de GPS+) en esta
carpeta.

2. Busque la carpeta FLoader y haga doble clic en el archivo
FLoader zip.

3. Copie el archivo FLoader.exe en la carpeta FLoader folder
(Figura 2-5 en la pagina 2-7).

4. Cree un acceso directo en el escritorio de la computadora para
acceder rapidamente al FLoader (Figura 2-5 en la pagina 2-7).
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Instalacion de las Tarjetas Opcionales SD y SIM

& floader E]@E|
File Edt View Favorites Tools Help I
Q- Q¥ ) sesrch | [ Folders | [711)-
Address | Ciitopcon’loader v | ] 6o
Folders X Name Size | Type Date Modified
(@ Desktop | C¥fioader_app.zip | 234KB  WinZip Flle 8i17/2005 2:17 PM #
{5) My Documents ¥ Floader.exe S24KE  Application 2i12{2002 5:49 PM FL
= ' My Computer IE‘
S 3% Floppy (81 ﬁlm
B % New Yolume [C1)
I3 Documents and Settings
1) Program Files
I quarantine
1) TEMP
= ) topcon
(23 breonf
3 floader
9 peedu
1) unzipped
1) WINDOWS v
< ¥ < >

Figura 2-5. Extraer Programay Crear Acceso Directo

Para desinstalar el FLoader, busque la ubicacién del archivo *.exe.
Seleccione el archivo y presione Delete.

Instalacion de las Tarjetas
Opcionales SD y SIM

Detrés de cada bateria desmontable se ubica una ranura para la tarjeta
opcional SD o para la tarjeta opcional SIM. La tarjeta SD proporciona
espacio en memoria en el cual se guardan los datos registrados; la
tarjeta SIM proporciona comunicacion telefénica para la transferencia
de datos entre dos receptores con capacidad GSM. Puede adquirir la
tarjeta SD en su tienda de suministros de cémputo local; y la tarjeta
SIM, en su tienda de suministros celulares local. El receptor
actualmente soporta una tarjeta SD con una capacidad de hasta 1GB.

Una vez instalada(s), la(s) tarjeta(s) por lo general permanece(n)
instalada(s). Se puede acceder a la tarjeta via la tarjeta del receptor
utilizando un puerto de datos o la tecnologia inalambrica Bluetooth.
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Preparacion previa al Levantamiento

Para instalar la tarjeta SD (Figura 2-6):
1. Asegirese de que el receptor se encuentre apagado.
2. Retire la abaterfa a la izquierda de la MINTER.

3. Con cuidado inserte la tarjeta SD, con la etiqueta hacia abajo, en
la ranura para tarjetas SD que se ubica arriba del compartimiento
para baterias.

Figura 2-6. Instalar la tarjeta SD

A No retire la tarjeta si el receptor se encuentra
encendido. Si retira la tarjeta en forma incorrecta
A

podrian dafarse los datos.

Una vez que el receptor se encuentre encendido, la tarjeta del receptor
detectard la tarjeta SD y estard lista para ser utilizada cuando se le
necesite.
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Instalacion de las Tarjetas Opcionales SD y SIM

Para instalar la tarjeta SIM (Figura 2-7):

La tarjeta SIM debe soportar Datos Conmutados por Circuito para la
comunicacién directa entre receptores. La tarjeta SIM debe tener
soporte GPRS para comunicarse con una direccién IP de la Red GPS.

Tanto el receptor Base como el Rover deben tener

@ una tarjeta SIM instalada (que soporte Datos
Conmutado por Cirucuito) y estar abonados al
mismo proveedor de servicios para una
comunicacién adecuada.

Asegtlrese de que el receptor se encuentre apagado.
Retire la bateria a la derecha de la MINTER.
Si fuese necesario, calce la tarjeta SIM en su soporte.

Ll e

Con cuidado inserte el soporte, con la etiqueta hacia abajo, en la
ranura para tarjetas SIM que se ubica arriba del compartimiento
para baterias.

Figura 2-7. Instalar la Tarjeta SIM

Una vez que el receptor se encuentre encendido, la tarjeta del receptor
detectard la tarjeta SIM y estard lista para ser utilizada cuando se le
necesite.

P/N 7010-0736-SP 2-9



Preparacion previa al Levantamiento

Carga de las Baterias

Antes de comenzar a trabajar, cargue completamente las baterias para
obtener el mdximo tiempo de operacién (Figura 2-8 en
la pagina 2-11).

* Si las baterias se encuentran conectadas a la base de carga,
bastard con un ciclo de carga de aproximadamente 6 horas para
cargar las baterfas; las baterias se cargardn en forma simultanea.

¢ Si las baterias se encuentran conectadas al GR-3, bastara con un
ciclo de carga de aproximadamente 6 horas para cargar las
baterias; las baterias se cargardn en forma simultdnea.

Las baterias no pueden cargarse en exceso.

% Las baterias se embarcan descargadas desde la
NOTA fabrica. Cargue completamente las baterias antes de
__r comenzar a levantar.

Cada bateria desmontable puede proporcionar energia entre 4.5 y 8.5
horas (aproximadamente, a temperatura ambiente) de operacion,
dependiendo del modo del receptor.

Y Si las baterias se encuentran conectadas al receptor,
.. conecte el cable del adaptador de energia al puerto de
RECOMELIDACION

= alimentacién del receptor para cargar las baterias. Las
baterfas se cargardn en forma simultdnea.

1. Retire las baterias del receptor e insértelas en la base de carga.
Conecte el cable de alimentacién a la unidad de alimentacién.

3. Conecte los conectores SAE del cable de alimentacion y el cable
del adaptador de energia y la unidad de alimentacién.

4. Conecte el cable del adaptador de energia a uno de los puertos de
la base de carga (cualquier puerto cargard ambas/una bateria).

5. Enchufe el cable de alimentacién a un tomacorriente disponible.
Espere aproximadamente 6 horas hasta que las baterias se
carguen por completo.
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Gestién de Energia

Figura 2-8. Insertar las Baterias en el Cargador y Conectar al Tomacorriente

Las baterias de Litio-Ion que utilizan los paquetes de baterias deben
funcionar a no menos del 80% de su capacidad después de 500 ciclos
de carga. Estas baterfas no necesitan descargarse antes de ser
recargadas.

Gestion de Energia

El software PC-CDU de Topcon proporciona una interfaz para
diversas funciones de configuracién, monitoreo y gestion para el
receptor.

Para la gestién de alimentacion del receptor, PC-CDU habilita la
fuente de alimentacion, habilita el modo de carga y muestra la tensién
actual para las baterfas.

1. Conecte su receptor y la computadora. Consulte “Conexién del
Receptor y una Computadora” en la pagina 2-21 para obtener
informacién con respecto a este procedimiento.

2. Una vez conectados, haga clic en Configuration » Receiver.
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Preparacion previa al Levantamiento

3. Seleccione la lista desplegable Power Mode (Modo de Energia)
para configurar la fuente de energia deseada (Figura 2-9). Current
Mode (Modo Actual) muestra la fuente de alimentacion en uso; si
utiliza la base, mostrard “exbat” (bateria externa).

* Auto — el receptor selecciona la fuente de energia
automdticamente

* Mix — las baterias se descargardn casi simultdneamente

» Battery A — ambas baterias se descargaran en forma

secuencial; primero A, después B, A, B, etc. En este caso, la
bateria B durara de 1 a 2 horas mas.

» Battery B — ambas baterias se descargardn en forma
secuencial: primero B, después A, B, A, etc. En este caso la
bateria A durara de 1 a 2 horas mas.

[ Receiver Configuration ]

| Genessl | MINTER | Pocifioning | Bace | Rewe | Pouts | Events | Advarced |

e
[l Povor sgns [vols)

T Elervaliors Mask 5 Muxke »

Antenng Arterns Stahus resd o] Cunent Hods B
2 S = e s i
| =], Eoverd] | et
;m:::::l:. hosel) — = CunnrdMods: [ | Chaigee] A . .
Cusaet fArg) urrent Mode T
Fowet oulgnd modes Tuan om) Eattery A
[ A | Battery B
[ I [ T
¥ Enablo Low Power Mode I )

Refiesh | |

Dt | Save | et oll povometers o defauks

Figura 2-9. Seleccionar el Modo de Energia

4. Seleccione la lista desplegable Charger Mode (Modo del
Cargador) para definir el modo del cargador deseado (Figura 2-10
en la pagina 2-13). Current Mode muestra la bateria de carga: a,
b, ab, or none (off) (ninguna (apagado)).
* Off — el receptor no cargard las baterias
* Auto — el receptor detecta y carga automaticamente ambas
baterias
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Gestion de Energia

[ Receiver Configuration
|G | MINTER | Positioning | Base | Rover | Pouts | Events | Advarced |

" P it
[ideyames] sl vl ~Charger
T Elervaliors Mask 5 Muxke Bt
e Mode :

Arionna Arteris Stotus s onki Wi Boas
-

Cument Input sl .
b ] B | =] || e | Sp=ed:

I Esl. OC Stobus : [ | "% | Curent Mode :
Temperatusn (Colsus dogeess| Cunend Mocs S
s f——— - - Current [Amp) : IZUB?

Cunnern (e : |
[prp—— Tun ool
aeifon =]
| ] [ |
¥ Enable Low Powsr biode [ 2

Refiesh | |

Dt | Save | Set ol povameters bo dfauks

Figura 2-10. Seleccionar el Modo del Cargador
5. Seleccione la lista desplegable Turn on/off Slots para configurar la
salida de energia en las ranuras internas (Figura 2-11).

* On - laranura C se alimenta si el receptor se encuentra
encendido

* Off — la ranura interna no se alimenta incluso si el receptor se
encuentra encendido

* Always — la ranura interna se alimenta incluso si el receptor
se encuentra apagado

Kl Receiver Configuration ]
| Genesal | MINTER | Posiioning | Bae | Fowns | Pruts | Events | Advarced |
. Pure managermert
[l Power Viokages [vols)

Tourririal Elenvalions Mask, 5 Mexds: Extemal ;

Pi— Arberna Stotas (reed ork) Cutent Mods: O Biowd: |

(o) Chaw ol

£ Cument Input i [ =] || Bonera Tumn on/off Slots

I Est DT Status - | seers:| 210: [on -

Temparahus [Colsus degeess| . . Chasges :

Bowd tempessture ; E Cunmmbtest - ”
Cusient fare): |

Fowt oulprt mocdes: Tusn onvlolt Slels

2[C]: |On 1
I I
[+ Enable Low Power Mode | J

Refiesh | |

Dt | Save | Set ol povameters bo dfauks

Figura 2-11. Seleccionar Modos de Salida de Energia — Puertos y Ranuras

6. Consulte informacion sobre Voltages (Figura 2-12 en
la pagina 2-14).
¢ External — muestra la tension de la fuente de alimentacion
externa
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Preparacion previa al Levantamiento

* On Board — muestra la tensién consumida por la tarjeta del
receptor

» Battery A — muestra la tension de la bateria A A
 Battery B — muestra la tension de la bateria B

* Charger — muestra la tension de salida del receptor durante la
carga de la bateria

= Woltages [volts]
[ Genesal | MINTER | Pociioning | Base | Rowns | Pouts | Events | Advarced | External :
(dogunes) Liek aogns (vola] OnBoard :
Toirririd Elevealicrs Mack: 5 Mot el 25
Aniznna Arberr Stoar (rood onki Curtort Mode : o Biod: | Battery A :
! - S
- £ :,::,,W [ =] | |- Battery B :
] Esd. DT Status - ] [poee: |
Tompetatun [Coksus dogenes| Connbioss: [T || [t | Charger :
Dowd tempesahure c el | - — ’—
At H
Powes oulgrd mades Tuan onloll Skls
zi:fon =
[ ] [ |
¥ Enable Low Powser Mode [ =
Refiesh | |

Dt | Save | Set ol povameters bo dfauks

Figura 2-12. Ver Informacién sobre Tensién

7. Seleccione y marque la casilla de habilitacién de Enable Low
Power Mode para poner el procesador del receptor en el modo de
bajo consumo de energia (Figura 2-13).

[ Receiver Configuration ]

| Genesal | MINTER | Posiioning | Bae | Fowns | Pruts | Events | Advarced |
. Pure managermert
[l Power Vitages [vols)
Tourririal Elenvalions Mask, 5 Mexds: Extemal ;
Pi— Arberna Stotas (reed ork) Cutent Mods: O Biowd: |
; Curment Input Chorger Balioey &
- Est. DF Status : Mode: l = Batiew8: [
- 8 ,—_| atleny B |
Tompatatun [Colsus dogees| . . Chasgas: |
[= Mo ot |
Bowd lempesshure © e y T
Cusient fare): |
Pow oulgrst maodes: Tuan ool Skls
|_ 2ic): [o -
¥ Enable Low Power Maode [ I [ u |
[+ Enable Low Power Mode [ 2l
Relresh | |
£ | _Swe | ot pwometer o defuks

Figura 2-13. Habilitar y Aplicar los Valores de Energia

8. Haga clic en Apply.
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Alimentacion del Receptor

Si se alimenta con baterias internas, el receptor pasard, en forma
constante, de una bateria a la otra, manteniendo una diferencia de 0.4
V entre las baterias.

Para verificar el estado de las baterias internas, vea el LED
BATT o verifique el estado con el software de Topcon.
* Verifique el estado de la bateria en los LEDs BATT.
— Una luz verde indica una carga de mas del 85%.
— Una luz anaranjada indica una carga intermedia.

— Una luz roja indica una carga de menos del 15%.

* Siga uno de los siguientes procedimientos utilizando PC-CDU:

—Haga clic en Configuration » Receiver para ver las tensiones
de la bateria en la pantalla Receiver Configuration.

— Haga clic en Help » About para ver las tensiones de las
baterias en la pantalla About PC-CDU.

Con las Baterias Desmontables

El receptor GR-3 viene con dos baterfas recargables y desmontables y
un compartimiento para baterias AA. Cada bateria desmontable
puede proporcionar energia entre 4.5 y 8.5 horas (aproximadamente)
de operacién a temperatura ambiente, dependiendo del modo del
receptor y de la capacidad de la bateria.

Tabla 2-1. Tiempos de Operacion Estimados con Dos Baterias Totalmente
Cargadas

Con Baterias Desmontables

Condiciones del receptor: Bluetooth = activado; 10-12 satélites rastrados;
tempratura ambiente

Médem apagado 17 horas
Moédem 915+ en el modo de sélo recepcion 13 horas
Médem 915+ en el modo de transmision de 11 horas
250mW

Médem 915+ en el modo de transmisién de 1W | 9 horas

P/N 7010-0736-SP 2-15



Preparacion previa al Levantamiento

Tabla 2-1. Tiempos de Operacion Estimados con Dos Baterias Totalmente
Cargadas

Con Compartimientos para Baterias y Baterias AA
Condiciones del receptor: Bluetooth = activado; 10-12 satélites rastreados

Médem apagado ‘ 2.5 horas

Para colocar las baterias (Figura 2-14):

1. Con la bateria ligeramente inclinada, coloque la parte inferior de
la bateria en el fondo del compartimiento para baterias.

2. Empuje ligeramente la parte superior de la bateria en el
compartimiento para baterias hasta que calce en su lugar.
Asegtrese de que el gancho que se encuentra en la parte superior
de la bateria calce completamente en su lugar.

Figura 2-14. Insertar las Baterias del GR-3
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Para sacar las baterias:

Con el gancho de la parte superior de la bateria, suavmente empuje
hacia abajo y hacia afuera para sacar la bateria del receptor
(Figura 2-15).

Figura 2-15. Sacar las Baterias del GR-3

Para ensamblar el compartimiento para baterias AA
(Figura 2-16 en la pagina 2-18):

No utilice baterias AA recargables.
/\ h % | Lo
™  Noutilice el estuche para baterias si el radio médem

se encuentra en el modo de transmision.

1. Deslice la tapa posterior del compartimiento para baterias AA
hacia abajo y levantela.

2. Inserte cuatro baterias AA tal como se observa en la parte interior
del compartimiento (y en la Figura 2-16 en la pagina 2-18 mads
adelante).

* Las baterias de la izquierda se colocan con el extremo
positivo hacia el fondo de la carcasa.

* Las baterias de la derecha se colocan en el extremo positivo
hacia arriba del compartimiento.

3. Cambie la tapa posterior del compartimiento.

Inserte el compartimiento para baterias AA en el bolsillo para
baterias del receptor tal como se observa en ‘“Para colocar las
baterfas” en la pagina 2-16.
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Figura 2-16. Retirar la Tapa e Insertar las Baterias AA

Con una Fuente de Alimentacion
Auxiliar
Ademas de las baterias internas, el receptor se conecta a baterfas

externas. Las baterfas externas le permiten continuar utilizando el
receptor en caso de que se descarguen las baterias internas.

% Las baterias que se encuentran en la base de carga
% no cargardn las baterfas internas/desmontables.
- La base de carga se utiliza para alimentar el

receptor.

Para conectar el receptor y la base de carga (Figura 2-17 en la
pagina 2-19):

La base de carga con baterias extra se engancha en un tripode o correa
para alimentar el receptor en forma conveniente. El nimero de parte
del cable que va del receptor a la base de carga es 14-008072-01 6
14-008072-02.

1. Conecte el extremo del cable que va de la base al receptor a la
base de carga.

2. Conecte el otro extremo al puerto de alimentacion del receptor.
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Al receptor y a la base
de carga con el cable
que va del receptor

al cargador

Figura 2-17. Conectar la Base de Cargay el Receptor

Para conectar el receptor a una bateria auxiliar (Figura 2-18 en la
pagina 2-20):
Utilice el cable que va de la ODU a las pinzas cocodrilo (p/n 14-

008097-01LF) para conectar directamente la bateria auxiliar y el
puerto de alimentacién del receptor (sin SAE).

configure el modo del cargador como Off. De lo
contrario, se cargardn también las baterias
desmontables, con lo cual disminuird el tiempo de
operacién. Consulte “Gestion de Energia” en la
pégina 2-11 donde encontrard mds informacién con
respecto a la configuracién del modo del cargador.

@ Si alimenta el receptor con las baterias externas,

1. Conecte el cable que va de la ODU a las pinzas cocodrilo a una
bateria de 12 voltios.

2. Conecte el cable que va de la ODU a las pinzas cocodrilo al
puerto de alimentacién del receptor.

3. Encienda el receptor.
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] Del receptor a la
bateria auxiliar con
el cable que va de
la ODU a las
pinzas cocodrilo.

) S
— =

Figura 2-18. Conectar una Bateria Auxiliar y el Receptor

Una sola bateria externa de 12 V, 2.3 A*h debe alimentar al receptor
durante aproximadamente 4.5 horas y al receptor durante 6 horas.

Encendido/Apagado del Receptor

Para Encender el receptor, presione y mantenga presionado el botén
de encendido del receptor hasta que los LEDs parpadeen brevemente.

Para Apagar el receptor, presione y mantenga presiona la tecla de
encendido durante mas de un y menos de cuatro segundos (hasta que
ambos LEDs, el STAT y el REC estén apagados). Este retardo (de
aproximadamente 1 segundo) evitard que el usuario apague el
receptor por error.
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Conexion del Receptor y una
Computadora

El software PC-CDU de Topcon proporciona una interfaz para
diversas funciones de configuracién, monitoreo y gestién para el
receptor..

Para configurar, gestionar archivos o darle mantenimiento al receptor,
conecte el receptor y una computadora utilizando uno de los
siguientes métods y inicie PC-CDU:

* un dispositivo externo habilitado con Bluetooth (computadora/
controlador)

* un cable RS232 y una computadora/controlador

* un cable USB y una computadora/controlador con el driver USB
de TPS instalado

Una vez que ha establecido la conexién entre el receptor y la
computadora/controlador, podra configurar el receptor y sus
componentes, enviar comandos al receptor, descargar archivos desde
la memoria del receptor, asi como cargar nuevo firmware utilizando
FLoader™, y cargar archivos de configuracién a un receptor.

Establecimiento de una Conexion
Inalambrica

El receptor GR-3 incluye tecnologia inaldmbrica Bluetooth que
permite la transferencia de archivos y la sincronizacién entre el
receptor y cualquier otro dispositivo externo que soporte la tecnologia
inaldmbrica Bluetooth; por ejemplo, un FC-100, o una computadora
con un adaptador USB a Bluetooth o un adaptador PCMA a
Bluetooth instalados.

Si cambia las configuraciones por defecto del
@ Puerto D del receptor, el enlace Bluetooth se vera
afectado. Los valores por defecto para el Puerto D

son: 115200 bps, 8 bits de datos, 1 bit de parada, sin
paridad y sin negociacion.
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El receptor y el procedimiento de conexién de dispositivos externos
varia ligeramente dependiendo del tipo de dispositivo externo que se
utilice. Por lo general, el procedimiento de conexidn es el siguiente.

en el que ha habilitado el Bluetooth si desea obtener

@ Consulte la documentacién del dispositivo externo
informacién detallada acerca de la conexion.

Encienda el dispositivo externo habilitado con el Bluetooth y su
receptor. El modo del dispositivo externo por defecto es Master;
el modo del médulo Bluetooth del receptor es Slave.

Haga que el dispositivo externo (Master) busque el receptor
(Slave).

Una vez que el dispositivo Master detecte al receptor, utilice el
procedimiento descrito en la documentacién del dispositivo
externo para conectarlo con el receptor.

Conéctese al software de configuracién deseado (PC-CDU,
Modem-TPS, etc.), tal como se describe en las secciones de
configuracion.

Si no puede establecer una conexion, verifique que la ranura 3 del
receptor se encuentre habilitada.

1.

Conecte su receptor y una computadora con un cable RS232 o un
cable USB y PC-CDU, tal como se indica a continuacion.

Haga clic en Configuration » Receiver » General.

En el 4rea Turn on/off Slots, asegtirese de que la Slot 2 (C) se
encuentre habilitada.
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Establecimiento de una Conexion
con un Cable RS232

1.

Con el cable RS232, conecte el puerto serial de su computadora
(por lo general, COM1) en el puerto serial del receptor.

Presione los botones de encendido del receptor y la computadora
para encenderlos.

Conéctese al software de configuracién deseado (PC-CDU,
Modem-TPS, etc.), tal como se describe en las secciones de
configuracion.

Establecimiento de una Conexion
UsSB

Asegtrese de que el driver USB de TPS se encuentre instalado y que
la opcién USB se encuentre habilitada.

1.

Con el cable USB, conecte el puerto USB de su computadora al
puerto USB del receptor.

Presione los botones de encendido del receptor y de la
computadora para encenderlos.

Conéctese al software de configuraciéon deseado (PC-CDU), tal
como se describe en las secciones de configuracién.
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Configuracion del Médulo
Bluetooth

Utilice BTCONEF, el programa de configuracién del médulo
Bluetooth de Topcon y su computadora para:
* ingresar al médulo habiiltado con la tecnologia inaldmbrica
Bluetooth

* configurar el médulo Bluetooth

* revisar o cambiar la configuracién del médulo
Para acceder al médulo habilitado con la tecnologia inaldmbrica
Bluetooth, primero descargue e instale el BTCONF, después conecte
su computadora y el receptor y ejecute el programa de configuracion.

Consulte “Instalaciéon de BTCONF” en la pdgina 2-5 donde obtendrd
informacién al respecto.

Una vez que tenga disponible BTCONTF, siga los siguientes pasos
para configurar el médulo Bluetooth.

1. Con el cable RS232, conecte el puerto serial de su computadora
(por lo general, COM1) del receptor. Si fuese necesario, encienda
el receptor y la computadora.

2. Ejecute el programa de configuracion del médulo Bluetooth
(Figura 2-19).
Para conocer al versiéon de BTCONF asi como informacion de
derechos de autor, haga clic en el botén About (Acerca de).

BTCONF (=3

Identification l Parameters] Serial Interface]

Bluetoath Information:

About

oo
=
L |
[Shssise]

Exit

Connect

Disconnected

Figura 2-19. Bluetooth Module Configuration Main Screen
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En la lista desplegable , seleccione el puerto serial de la
computadora utilizado para comunicacién (Figura 2-20).

Haga clic en Connect para conectar la computadora y el médulo
Bluetooth.

BTCONE

COME = |l Identification | Parameters Seriallnterface]
Bluetoath Information:
COME 'v About

[Bhsansss|

Exit |

Disconnected

Figura 2-20. Seleccionar el Puerto de Comunicacion y Hacer Clic en Connect

Una vez que el receptor y la computadora se conecten a través de

BTCONEF, la pestaiia Identification (Figura 2-21) muestran la
siguiente informacion:

¢ Bluetooth name — el nombre del mddulo Bluetooth.

* Bluetooth address — la Unica direccién electrénica para el
mddulo.

¢ Firmware version — la version actual del firmware del médulo
Bluetooth.

BTCONE

Identification | Parameters | Serial Interfacs ]

Bluetoath Information:

Bluetoath name: GR3 Rowver

Bluetooth address: 0028 BEED 0074 0003
Firmnware baze: RFCOMMI.1w16.4.4
Firmweare version: ¥1.3 pl

About

Disconnect

Lk

Exit

COME, 115200

Figura 2-21. Pestafia de Identificacion de BTCONF
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El puerto COM vy la velocidad de transferencia en baudios
aparecen en la esquina inferior izquierda.

5. Haga clic en la pestafia Parameters (Figura 2-22). La pestaiia
Parameters define la informacién de identificacion y seguridad de
su médulo Bluetooth. La seccién de seguridad le permite definir
datos de seguridad y los pardmetros de acceso no autorizado para
el mddulo Bluetooth.

6. Ingrese hasta 14 caracteres para definir un nombre Gnico para el
moédulo Bluetooth, y a continuacién haga clic en Apply.

BTCONF g|§| g|
Identification : f
About Eluetooth Mame: |GF|3 Rover

Security
Blustooth PIN: |
. I~
Disconnect
I—

Exit |

l Serial Interface ]

COME, 115200

Figura 2-22. Pestafia de Parametros de BTCONF

7. Para definir los parametros de seguridads (Figura 2-23 en la
pagina 2-27), ingrese y habilite las siguientes opciones, a
continuacién haga clic en Apply:

* Bluetooth PIN — ingrese hasta 16 caracteres para especificar
el nimero de identificacidn personal apra el médulo
Bluetooth.

* Encryption — habilitela para que el médulo Bluetooth encripte
datos enviados de manera inaldmbrica. Para leer datos
encriptados, el usuario debe tener el mismo PIN utilizado en
el dispositivo que envid los datos.

* Authentication — habilitela para soliciar un PIN antes que dos
dispositivos habilitados con el Bluetooth (como por ejemplo,
el receptor y una computadora) puedan establecer un enlace
de comunicacion. Los dos dispositivos deben utilizar el
mismo PIN.
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Si no necesita los valores de seguridad, deje estos
pardmetros deshabilitados.

BTCONE

Identification Parameters l Serial Interface]

About Bluetaath M ame: |GF|3 Fover
Security

Blustaoth PIN: [ 1234567
k Encryption: v
Disconnect
Authentication: v

Exit |

COME, 115200

Figura 2-23. Parametros de Seguridad de BTCONF

8. Haga clic en la pestafia Serial Interface (Figura 2-24). Habilite
Echo para mostrar las respuestas del médulo Bluetooth y los
comandos correspondientes en el terminal de la computadora. En
caso de ser necesario, haga clic en Apply.

9. Haga clic en Disconnect y a continuacion en Exit para salir de
BTCONF.

BTCONE

Identification | Parameters
About Echa: [~

Apply

Disconnect

e

Exit |

COME, 115200

Figura 2-24. Pestafia de la Interfaz Serial de BTCONF
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Coleccion de Almanaques y
Efemérides

Cada satélite transmite un mensaje de navegacion que incluye los
pardmetros de efemérides del satélite, el almanaque y otros tipos de
informacién. Los parametros de efemérides describen el movimiento
orbital del satélite y se utilizan para proyectar su ubicacién/
trayectoria. El almanaque proporciona la érbita (curso) aproximada
para el satélite que transmite y todos los demds satélites en el mismo
sistema tinicamente.

* Los satélites GPS y GLONASS transmiten datos de efemérides
ciclicamente, con un intervalo de 30 segundos.

* Los satélites GPS transmiten datos de almanaque ciclicamente
con un intervalo de 12.5 minutos; los satélites GLONASS
transmiten datos de almanaque ciclicamente con un intervalo de
2.5 minutos.

Si el receptor posee un almanaque, usted puede reducir
considerablemente el tiempo requerido para buscar y capturar las
sefiales satelitales.

El receptor actualiza regularmente el almanaque y efemérides y
guarda las versiones mds recientes en su Memoria de Acceso
Aleatorio No Volatil (NVRAM).

1. Instale el receptor en un lugar con una visién despejada del
firmamento.
2. Encienda el receptor.

3. Espere aproximadamente 15 minutos mientras el receptor colecta
datos de almanaque y de efemérides de los satdlites.

no ha capturado de satélites, borre la NVRAM.
Consulte “Borrado de la NVRAM” en

la pagina 5-14 donde encontrard mayor informacion
al respecto.

@ Si después de transcurridos 15 minutos el receptor
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Necesitard colectar o actualizar el almanaque y efemérides en los
siguientes casos:

* Si el receptor ha estado apagado durante un tiempo prolongado.

* Si la dltima posicién conocida del receptor, guardada en la
NVRAM se diferencia de la posicién actual en varios cientos de
kilémetros.

* Después de cargar un nuevo OAF.
* Después de cargar un firmware nuevo.
* Después de borrar la NVRAM.

¢ Antes de levantar.
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Notas:
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Capitulo 3

Configuracion del GR-3

Ambos receptores, Base y Rover, deben configurarse de acuerdo con
el método de levantamiento deseado.

* En aplicaciones donde se requieren resultados de
posicionamiento en tiempo real, el receptor Base proporciona la
informacién de correcién que se necesita para calcular la
ubicacién del receptor Rover con precision.

Una estacién Base por lo general se ubica sobre un punto
conocido y colecta datos GPS/GLONASS desde los satélites. A
medida que el receptor capta datos satelitales, mide la portadora y
las fases de cédigo apra calcular y verificar su ubicacion en forma
precisa. A continuacion, el receptor transmite esta informacién
via radio (SS o GSM) al receptor Rover.

* El receptor Rover aplica informacion de correccién de la estacién
Base a su ubicacién actual para calcular uno o mds puntos en
forma precisa.

Los Rovers son receptores GPS méviles en un jalén o bipode que
comparan la informacién de la estacién Base con los datos que
registra desde los satélites y aplica algoritmos de correccién para
calcular un punto nuevo en forma precisa.

* En aplicaciones previstas para post-proceso, los receptores por lo
general registran las mediciones de fase de codigo y/o fases
portadoras por separado a partir de satélites comunes y durante el
mismo intervalo de tiempo. Estos datos se procesan después
utilizando un software de post-proceso (por ejemplo, Topcon
Tools).
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Cuando configure receptores para levantamiento RTK, utilice la
siguiente lista de verificacion para asegurarse de haber instalado los
receptores en forma adecuada.

[0 Efectie funciones de pre-levantamiento tal como se describe en el
Capitulo 2.

O Configure un receptor como estacién Base RTK y el otro receptor
como un Rover RTK. Consulte “Configuracién del Receptor” en
la pagina 3-11.

O Configure el enlace de datos de comunicacidn para transmitir y
recibir correcciones.

* Para un médem de Espectro Ensanchado, consulte
“Configuracion de un Médem de Espectro Ensanchado” en la
pégina 3-4.

* Para un médem GSM/GPRS, consulte “Configuracién de un
Radio Médem GSM” en la pagina 3-8.

O Coloque el receptor Base sobre un punto conocido para comenzar
a recolectar datos de observaciones estaticas y transmitir
correcciones. Instale el receptor Rover para comenzar a colectar
datos RTK. Consulte “Instalacion del Receptor” en la pagina 4-1
donde encontrard mas informacion al respecto.

Cuando configure receptores para levantamientos de post-
proceso, utilice la siguiente lista de verificacién para asegurarse de
haber instalado los receptores en forma adecuada.

[0 Efectie funciones de pre-levantamiento, tal como se describe en
el Capitulo 2.

O Configure un receptor como estacién Base y el otro como Rover.
Consulte “Configuracion del Receptor” en la pagina 3-11.

O Coloque el receptor Base sobre un punto conocido para comenzar
a recolectar datos de observaciones estéticas. Coloque el receptor
Rover para comenzar a colectar datos de observaciones estiticas
o cinemadticas. Consulte “Instalacion del Receptor” en la pdgina

4-1 donde encontrard mds informacién al respecto.
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Configuracion del Radio
Moédem

Modem-TPS es un utilitario de Topcon para la configuracién del
radio médem de médems que vienen integrados en los receptores
Topcon. Modem-TPS proporciona las siguientes funciones:

* Conecta una computadora a un radio médem integrado via un
puerto serial o la tecnologia inaldimbrica Bluetooth.

* Muestra informacion con respecto al radio médem instalado en el
receptor.

* Programa los valores del radio médem.

Consulte las siguientes secciones donde encontrard informacion con
respecto a la configuracién del receptor con un médem de Espectro
Ensanchado o un radio médem GSM que utilice Modem-TPS.

Tenga presente que el radio SS y el radio GSM no
funcionan en forma simultdnea. Solo es posible

@ utilizar un radio a la vez.

Al terminar de configurar el radio médem, siempre
desconéctese de Modem-TPS antes de salir para
evitar conflictos con la gestion del puerto serial.

El software de configuracién y levantamiento de Topcon, TopSURV o
Pocket-3D, pose también la capacidad de configurar receptores
Topcon. Consulte los manuales de TopSURV o Pocket-3D para
obtener informacion detallada al respecto.
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Configuracion de un Médem de
Espectro Ensanchado

Para los receptores Topcon, el radio médem integrado TPS FH915+
facilita comunicaciones de espectro ensanchado TX/RX entre una
Base y un Rover. Para configurar un radio médem SS, tenga listo lo
siguiente:

» Computadora corriendo bajo Windows® 98 o una versién
posterior

¢ Modem-TPS version 2.0 o mas reciente instalado en la
computadora

* Un cable serial (o capacidades de tecnologia inalambrica
Bluetooth)

Consulte “Configuracién de un Radio Médem GSM” para configurar
la parte GSM de la instalacién de un radio de espectro ensanchado.

1. Conecte la computadora y el receptor. Encienda el receptor.

2. Abra Modem-TPS y seleccione el puerto COM al que se
encuentra conectado el receptor (Figura 3-1). Haga clic en
Connect.

# EEE|

File Tools Help

I Connection ... ‘X‘

Part's setting

COomM =
Cancel

Disconnected

Figura 3-1. Conéctese a Modem-TPS

3. Enla pestaiia Radio Link, configure los siguientes pardmetros
(Figura 3-1 de la pagina 3-5) y haga clic en Apply (Figura 3-2 de
la pagina 3-7).
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Tabla 3-1. Parametros del Receptor para la Pestafia Radio Link

Parametros

Receptor Base Receptor Rover

Protocolo

Seleccione FH915 o FH915+ para el tipo de radio.

* Un radio médem FH915 puede configurarse como transmisor
0 receptor.

* Un radio médem FH915+ puede configurarse com
transmisor, receptor o repetidora.

Ubicacion

Seleccione el pais en que se utilizard el receptor. Si, por
ejemplo, selecciona “Australia”, el espectro de radio se dividira
en dos para garantizar su compatibilidad con el espectro
disponible. Esta caracteristica es automadtica y serd invisible al
usuario.

Modo de
operacién

Seleccione Off si el radio se encuentra apagado; seleccione
Repeater si el radio médem incluye una funcién para amplificar
la sefial.

Seleccione Transmitter. Seleccione Receiver.

Potencia de
salida

Seleccione la potencia de n/d
transmision para el radio
moédem.

Velocidad del
enlace

Para el proto-
colo FHO15+,
la velocidad
del enlace se
selecciona
automatica-
mente.

Seleccione la velocidad de transmisién de datos para el radio
enlace.

En contraposicion a la velocidad de transferencia en baudios (la
velocidad de transferencia de datos a través de una interfaz de
cable serial), la velocidad del enlace es la cantidad de datos
(medida en bits) que el radio médem puede transmitir/recibir
sobre el aire en un periodo de tiempo especifico (medida en
segundos).

* 9600 — repite el paquete de datos 3 veces; los paquetes se
codifican para reducir los efectos de interferencia. Esto
proporciona maxima seguridad para los datos, pero reduce el
throughput de datos.

* 12000 — repite el paquete de datos 5 veces; no se aplica la
codificacién.

* 17000 — repite el paquete de datos 3 veces; no se aplica la
codificacién.

* 24000 — utiliza sélo la codificacién.
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Configuracion del GR-3

Tabla 3-1. Parametros del Receptor para la Pestafia Radio Link

Parametros Receptor Base Receptor Rover
Velocidad del || « 51000 — no utiliza repeticidn ni codificacién. Esto
enlace proporciona un throughput de datos maximo, pero reduce la
confiabilidad de la comunicacion.

(Continua- Para una eficiencia médxima, el tamafo del paquete de datos

cién) transferido al radio médem en un tiempo determinado debe ser
equivalente o menor al enlace de datos. Utilice la Tabla 3-2 de la
pagina 3-6 para determinar la velocidad del enlace.

Canal Asigna un canal en el cual transmitir/recibir datos. Cada canal

utiliza una frecuencia de comunicacién tnica, y permite que

hasta cinco radio mdédems transmitan simultineamente, sin

interferencia en el lugar de la obra.

 Utiliza el mismo canal para ambos receptores en la misma
red.

* Asigna canales diferentes a otras redes.

Tabla 3-2. Comparacién entre Velocidades de Enlace y Velocidad de

Transferencia en Baudios

Tamafio del Velocidad de
transferencia . Velocidad de
paquete de . Velocidad del . .
datos (en en bauQ|os enlace(bps) transferencw_ten baudios
. (bps) serial de (bps) serial de RX
bits)
TX)
0-9600 9600; 19200 9600212000 9600; 19200; 38400; 57600
9600-12000 19200; 38400 12000%; 24000 19200; 38400; 57600

12000-17000

19200; 38400

17000?; 24000

19200; 38400; 57600

17000-24000

38400; 57600

24000

38400; 57600

24000-51000

57600

51000

57600

a. Velocidad recomendada para el enlace para este tamaiio de paquete de

datos.
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Configuracion del Radio Médem

4. En la pestafia Serial Interface, seleccione los siguientes
pardmetros de velocidad de transferencia en baudios y haga clic
en Apply (Figura 3-2).
* Baud Rate — selecciona una velocidad de transferencia en
baudios para el puerto serial del médem. Debe utilizar la

misma velocidad de transferencia tanto para el receptor como
para el médem.

* RTS/CTS — controla el flujo de datos entre el receptor y el

médem. “On” hace posible la negociacién/control del flujo de
hardware.

puerto serial supera la velocidad del enlace, habilite
la negociacién del hardware para evitar que el radio
enlace se sobrecargue de datos ya que esto
produciria la pérdida de éstos.

@ Si la velocidad de transferencia en baudios del

4 Spread Spectrum Radio Modem 915 MHz (Plus)

Ble Tools telp [z Spread|Spectrum Radio Modem 915 MHz (Plus)
Filz Tools Help
Radio Link | GEM | Serial Interface | Identific:
Radio Link | GSM  Serial Interface | Identification |
Protocol: | FH315 Plus  x
Apply

Lacation: | Morth America =

Operation mode: | Transmitter = | Baud Rate: 57600 hd

Qutput power: 1w hd RTS/CTS: oM -
Link Rate: 9600 =
Channel 4 hd

COM2, 115200 Bul
COm2, 115200 0:05:55

Figura 3-2. Aplicacion de los Parametros de Radio Enlace y de Velocidad de la
Transferencia en Baudios

5. Al terminar, haga clic en File » Disconnect (Archivo »
Desconectar).
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Configuracion de un Radio Médem
GSM

RF, mantenga una distancia de por lo menos 25cm

@ Para cumplir con los requisitos de la exposicion a la
entre el usuario y el radio médem.

Para receptores GR-3, el radio médem integrado SS de TPS
configurado con un médulo GSM proporciona comunicaciones GSM
TX/RX GSM entre una Base y un Rover, o comunicacién con una red
GPS utilizando conexiones basadas en IP. Para configurar un radio
médem GSM, tenga listo lo siguiente:

* Computadora corriendo bajo Windowss® 98 o una version
posterior

* Modem-TPS versién 2.0 o posterior

* Un cable serial (o capacidades de tecnologia inaldmbrica
Bluetooth)

¢ El namero telefénico de la estacion base

1. Conecte la computadora y el receptor. Encienda el receptor.

2. Abra Modem-TPS y seleccione el puerto COM al que se
encuentra conectado el receptor (Figura 3-3). Haga clic en
Connect.

I aEn)

File Tools Help

[id Connection ... \X\

Port's setting

COM1 hd
Cancel

Disconnected

Figura 3-3. Conexién a Modem-TPS

3. En la pestafia GSM, configure los siguientes pardmetros
(Tabla 3-3) y haga clic en Apply (Figura 3-4 de la p4gina 3-9).
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Configuracion del Radio Médem

Si algunos campos muestran “N/A”, haga clic en Refresh.

Tabla 3-3. Parametros del Receptor para la Pestafia FCS

Parametros Receptor Base Receptor Rover
Mode (Modo) || Seleccione Slave. Seleccione Master.
PIN En caso de ser necesario, ingrese un Nimero de Identificacién

Personal (PIN).

Dial (Marcar) || Dejar en blanco. Ingrese el nimero de teléfono del
médem GSM del receptor base.

Send time Ingrese un periodo de tiempo en segundos en que el médem
(Hora de GSM del receptor base/rover enviard una palabra de servicio al
envio) moédem GSM del rover/base.

» Este pardmetro se utiliza para mantener una comunicacién
confiable entre dos médems y evitar reinicializaciones
innecesarias del médem.

» Para garantizar una comunicacién segura y confiable del
moédem, este parametro debe ser mayor que el periodo para
transmitir correcciones diferenciales.

Si la base y el rover son receptores GR-3 con médems GSM
intenros, configure la Send time como cero (0).

[T

4 Spread Spectrum Radio Modem 915 MHz (Plus) - Dealer
File Tools Help

Radio Link  GSM |Sema\ Interface | Identification |

Mode: Slave s Send time: |0

Dial: | Pin: [400s

hodel [24 Spread Spectrum Radio Modem 915 MHz (Plus) - Dealer
| "GSMI0N","GSM1800" "MODEL=G20" File Tools Help

Status: |Registered, home netwark
Radio Link  GSM |Seria| Interface | Identification |

Signal quality - |85 dB Refresh Apply
— Mode: Master - Send time: |0
COMG, 115200 Dial |EEHBEEHDEBE FIN; ‘4DDE

Model
‘ "33MI00","GEM1800","MODEL=G20"

Status: |Registered, home netwark

Signal quality : |-85 dB Refresh GSM info

COME, 115200 0:02:54

Exit

Figura 3-4. Seleccion de Parametros GSM para la Base y el Rover

P/N 7010-0736-SP 3-9



Configuracion del GR-3

Para ver informacién sobre el médem GSM, haga clic en GSM
info (Figura 3-5). Haga clic en Quit para salir de la pestafia GSM.

La calidad de la sefial es una lectura de la fuerza de la senial GSM.
Mientras menor sea el nimero (mds cercano a cero), mejor serd la
calidad de la senal. La sefial minima (de corte) es-111db.

[E Spread Spectrum Radio Modem 915 MHz (Plus) - Dealer E”E‘El
Model
‘ "GSMI00","GSM1800","MODEL=G20"
Status:
Registerad, horme network
GPRS status: Operator
[GPRS coverage [MTS-RUS
S/M GEM modem Signal guality
[352219001334863 [83 0B
Quit
COMB, 115200 0:04:15

Figura 3-5. Visualizacion de Informacion de GSM

En la pestaiia Serial Interface, seleccione una velocidad de
transferencia en baudios para el puerto serial del médem. Debe
utilizar la misma velocidad de transferencia en baudios tanto para
el receptor como para el médem.

Haga clic en Apply, a continuacién haga clic en
File » Disconnect.

En caso de ser necesario, inicie PC-CDU y configure el receptor
de manera que funcione como una estacién Base RTK.
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Configuracion del Receptor

El GR-3 puede configurarse en diversos modos para colectar datos
para RTK o post-proceso.

» Una estacion Base estética colecta informacién de medicién y
guarda estos datos en su memoria interna.

¢ Una estacion Base RTK colecta informacién de medicion,
determina correcciones diferenciales, y las transmite al(los)
Rover(s) RTK.

¢ Un Rover estatico colecta datos de observacion de los mismos
satélites durant eel mismo intervalo de tiempo que la estacién
Base.

* Un Rover RTK colecta informacion de medicién y acepta
correcciones de la estacion Base RTK para calcular su posicion
relativa.

* Un Rover hace las veces de repetidora para retransmitir las
mediciones de la estacion Base RTK a otros receptores rover,
ampliando el alcance del sistema GPS.

Para configurar, gestionar archivos o darle mantenimiento al receptor,
conecte el receptor y una computadora utilizando uno de los
siguientes métodos e inicie PC-CDU:

* utilice un dispositivo externo con Bluetooth habilitado
(computadora)

¢ utilice un cable RS232

* utilice un cable USB y una computadora con el driver USB de
TPS instalado (disponible en el sitio web de TPS)

PC-CDU es un software de Unidad de Pantalla de Control para
Computadoras Personales que se utiliza para gestionar las diversas
funciones de su receptor. La gama completa de configuraciones y
funciones del software PC-CDU se encuentra fuera del alcance de
este manual. Si desea obtener mds informacién con respecto a los
procedimientos a los que se hace mencidn en esta seccién o en el
PC-CDU, consulte el Manual del Usuario de PC-CDU disponible en
el sitio web de Topcon.
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PC-CDU configura diversas partes del receptor, guardando los
valores en la memoria de éste. Estos valores se reflejardn cuando
utilice la MINTER. La gama completa de configuraciones y
funciones del software PC-CDU se encuentra fuera del alcance de
este manual.

Una vez que haya establecido una conexién entre el receptor y la
computadora, podra:

* configurar el receptor y sus componentes
* enviar comandos al receptor
* descargar archivos desde la memoria del receptor

* cargar un nuevo OAF y otros archivos de configuracién a un
receptor

Las siguientes configuraciones de la Base y el Rover se recomiendan
para la mayoria de las aplicaciones comunes. Sin embargo, podré
seleccionar los pardmetros que necesite para su lugar de trabajo en
particular.

No efectiie otros cambios sin consultar el Manual
de Referencia de PC-CDU.

1. Conecte su receptor y una computadora tal como se describe en
“Conexion del Receptor y una Computadora” en la pagina 2-21.

2. Inicie PC-CDU en su computadora. Aparece la pantalla principal
de PC-CDU (Figura 3-6).

Il

File Configuration Tools Ploks Help
GPS Satellites Geo %2 | Terget| GLONASS Satellites

4 | EL| az[calpi]re] tc] s5] tat sn | Fn | EL[ az[ca P ez 1] 55]
O
&l
el
RMS Pas:
AMS el
PDOF:

Receiver time:
Receiver date:
Clack offset:
Osc. offset:
Tracking time:

Disconnected | v

Figura 3-6. Pantalla Principal de PC-CDU
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Observe que la esquina inferior izquierda muestra el estado del
receptor como “Disconnected” (Desconectado).

3. Hagaclic en File » Connect.

4. En el cuadro de didlogo Connection Parameters, seleccione los
siguientes pardmetros (Tabla 3-4) y haga clic en Connect
(Figura 3-7).

Tabla 3-4. Parametros de Conexién

Parametros RS232 o Bluetooth UsB
Connection Seleccione Direct (Directo).
Mode (Modo
de Conexién)
Port (Puerto) Seleccione el puerto que conecta | Seleccione USB

la computadora y el receptor
(por lo general, COM1, COM2
for RS232 y COM3, COM4, etc.
para Bluetooth)

Baud Rate
(Velocidad de
Transferencia
en Baudios)

Seleccione la velocidad de
comunicacion entre el receptor y
la computadora (por lo general,
115200).

n/d

Rec ID (ID
del Receptor)

n/d

Seleccione el nimero de
identificacion del receptor.

RS232 o Bluetooth

Connection mode
|7 £ Intemet Client £ Intemet Serve
[ Port setting:
Fot: [COM1 x| Baudrate: [115200 x| [ Infiaredpo
[~ RTS/CTS handshaking

[ Program setting:
[~ Passivemode [ Manual mode only

[~ Restore the receiver's onginal baud rate on Disconnect

TCP port: Iﬁ

[ Intemnet setting:

Host name: IIu:thDsl

Fassyord: I

= DG

¥ | Logjseiver everits

Connect I

™| Display dats on server

Cancel |

1Il USB
5
I |
" Intemet Client " Intemet Server |
[ Port setting:
Faort; IUSB 'I FecID: ISF’AZKEE41KW «| [T Infrared port

~Program setting:
I Passive made [T Manual mode onlp Timeout [ms]: | 500 -

I Fiestore the receivers original baud rate on Disconnest

~Internet [ Client - Server ) setting:

Host name: Ilncalhnst TICF port: IBDDD

Fassyrd; I

[T Display dataonserver W) Log server everts I~ BHE Ieskup
Connect I Cancel I

Figura 3-7. Parametros de Conexion
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Una vez que ha establecido una conexién PC-CDU con el
receptor, los valores de comunicacién actuales, tales como
nombre del puerto, velocidad de transferencia (si corresponde), y
control de flujo (si corresponde), se muestran en la esquina
inferior izquierda de la ventana principal de PC-CDU. Asimismo,
se inicia un temporizador en la esquina inferior derecha

(Figura 3-8).

=
File Configuration Taools Plots  Help
GPS Satellites [D) Geo |><YZ | Talgetl GLONASS Satellites [0)
# [ EL[ szfcalpPi|pal Tc] s8] tat Snlfn[ EL] ez[calpi[pe] Te] 55
ot
Al
Vel
RMS Pos:
RMS Vel
FDOP:

Receiver time: 08:06:07
Receiver date: 24.09.2002
Clock offset:

Osc. offset

Tracking time: 00:00:00

comz, 115200 I 00:00:12

Figura 3-8. Conexién PC-CDU Establecida

5. Haga clic en Configuration » Receiver.

cambio en la configuracién, en caso contrario, el

% Haga clic en Apply después de hacer cualquier
receptor no registraré el cambio.

6. Haga clic en Set all parameters to defaults (Restablecer todos
los pardmetros a sus valores por defecto) (Figura 3-9).

=
Gonesod | MINTER | Pestunng | Bave | Hoven | Puts | Events | Ardvarsed|
Elarvadion mask: [dagrae] P"‘""'r,"“"‘"‘"’"""' A0 FroRTF
Trmrrwral £ bervadior Mask. 5 Mode: m Extainal: ,_
~Arinnnn “Anberea Stans (read onk] Cusrert Made: [ OnBomed: [
:: Ir-r:m: ot Chisgec Bty [T
ar ¥ 4
* Ao Ext. OC Status - [0 Mode: [rute =] &
Eamey 8. |75
~Temperahur (Crlsus dogeest 2 '
o 1 Commeode: [ || Cheees [FES
Froaver nulpul moder 1 1 Tum ondolt Siots
Ptz n - [ Sk 2
7 Skt d
Set all parameterto defaults Shay: On =] | || skt
7 [EnebleLow PomsrMode.
Heliesh Aoy
ok |_Ea | swve | Setstpe dataiks

Figura 3-9. Set All Parameters to Defaults
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7. Haga clic en la pestafia MINTER y configure los siguientes
valores (Tabla 3-5), a continuacién haga clic en Apply
(Figura 3-10).

Tabla 3-5. Parametros del Receptor para la Pestafia MINTER

Parametro Receptor Base Receptor Rover

Intervalo de Ingrese 15 segundos.

registro

Angulo de la Ingrese 15 grados.

mdscara de

elevacion

Prefijo del Ingrese una ID tnica, por ejemplo, los 3 tltimos digitos del

nombre de ndmero de serie del receptor.

archivo
(inicia/detiene la grabacion de datos por medio de la tecla de

Modo de la FUNCION)

tecla de . .

funciéne Para la grabacién de datos Para la grabacién de datos
estaticos, seleccion LED blink | RTK, seleccione Occupation
mode switch (Control del mode switch (Control del
modo de parpadeo del LED). modo de Ocupacidn).

Modo n/d Seleccione Kinematic.

dindmico de (Este valor es para

coleccién levantamientos de

inicial de datos trayectoria).

FM keymode—————
& LED blirk mode switch

D

Genessl MINTER | Pooatunrg | Bave | Hove: | Puts | Events | Ardvarse | .
Frecondng innerval: 100 fseconds] FN bty mode Estatico
Elevalion mazh fra Log e - ,5_ ldegrest] (% LED birk mode swich Occupation mode swich

File s prefic oo Iriial data coliclion dymaric made

&  fune

o Tr— ey T Rover RTK
s Comation nirde Do recunding suto-slat

& Logh  AFRM & on € tn Bl

Sustomate: i Flolalzon Mode AFHM) pasasetess

|1 oo [zeconds]

: mad
|1 5 [degrees) i+ ZF‘

File name prefix : log
Fshiesh

' Oceupation mode switch

Fecording interval :

Elevation maszk for Log file :

wopy_||

OF. I Lt Save Gualnnlnmﬂeulodefml

Figura 3-10. Configuracion de la MINTER del receptor para la Grabacion de Datos
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8. Haga clic en la pestafia Positioning y configure la Elevation mask
como 15 (Figura 3-11), a continuacién haga clic en Apply.

=
Genessl | MINTER [Fosonng | tave | Hove: | Puts | Events | Ardvarsed|

 Standakonn [+ Standaone . 5

= DGPS [Code Dileeriial] W OGF F GPs [ GLON © GRS Lo

BT Float [ =

 RIK Faomd F GPS | GLonass | wass|

punllock|usn| punliock|uss! pminck eze]| pmlnck]u

“ 1 Fl e 1
Ehey T s
T | [ 25
e L=t 1
= AN Enatled Measuremerts Used -
=R 5

0WF F WF F EF
NP F HF F IR
2EF AR F EE
o procen =] || oAs iE HNE P AR B AR
= - -
Heemen @ : Hes " E R R AR F AR
8 I 1
Altolock | Nenetoboct]  Aliause | Mo to use|

UV F 2Z2F F NF
| Relsh |

]

a9 099999
e B B B B B

Current Dafm: [t | F krelossttion

it Paraietan | ¥ Tiopo Conpeton

OF. I Lt Save Gualnnlnmﬂeulodefml

Figura 3-11. Configuracién del Posicionamiento del Receptor — Mascara de
Elevacién

9. Para el receptor Base, haga clic en la pestafia Base y defina los
siguientes pardmetros (Figura 3-12 de la p4gina 3-17), a
continuacién haga clic en Apply.

* GPS/GLO at one time (GPS/GLO a la vez)— habilitar

* Antenna position (Posicion de la antena) — ingrese los valores
de Latitud, Longitud y Altitud empleando uno de los
siguientes métodos:

— Si los conoce, ingrese los valores.

— Habilite Averaged (Promediado) e ingrese el Averaged
Span (Intervalo Promediado) en segundos, a
continuacién haga clic en Apply. Haga clic en
Tools » Reset receiver (Herramientas » Reiniciar
receptor) y espere a que se complete el intervalo (lapso)
de tiempo especificado. Revise las coordenadas de la
Base en la pestafia Base, la informacién debe
corresponder a las coordenadas ponderadas obtenidas.
Haga clic en Refresh si las cordenadas son ceros.

— Haga clic en Get from receiver.

especifican en esta pestafia se relacionan con el

@ Las coordenadas geodésicas de referencia que se
centro de fase de la antena L1.
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Contintie con el paso 11 de la pdgina 3-20 para levantamientos
RTK o el paso 12 de la pagina 3-20.

O T e e =

Generdl | MINTER | Porifioning [ 8522 || Rover | Ponts | Events | Advanced|

B s Shabor Counates | denna Phase Cerie | RITCM Setgs .
- iy Measurements Serk
= GPS/BLO al one fime aged om swontl [0 | et - B B B2

T GPS/BLO snpauniely M et [ Sy Used
o Sotellies - > GLOMASS

GPS/GL | el o e -

~Relerene Geodsts Comdnater Heskh:lcod =] T Posudorangs stk
Lac[00 o0 foonoon [w =] [wea =] [ [EMASeting: ————
Lenf000 ‘o0 *[oo0mon *[c = Staion 1D: [0 * ALl P P2
&[0 m Dt Pownsers. | (1| Motion: [Urkroom 7] GLONASS message: [5 2]

Anisnng Phace Cerbat olltats, rtre Shat 13- | oG |

Eaat:| 0 o 00002 Hsight :[0.0062 LuruID.l

= B Corligation of Flacaive Ports
et from recewerl
P | Felesh iy |

GPS/GLO |

Reference Geodetic Coordinate:

Lat [0 *[o0” '[on.oooon " [w =] [wes =]
Lonfo00 *[00" ' [on.00000 " [€ =]
AIt:I+U.DDDU M Diatum Farameters |

Figura 3-12. Configuracion de la Base

salnuumuodefunl

10. Para el receptor Rover, haga clic en la pestafia Rover y configure
los siguientes pardmetros, a continuacion haga clic en Apply
(Figura 3-13 de la pagina 3-18).

* Positioning Mode (Modo de Posicionamiento)— Para
levantamientos post-procesados, seleccione Standalone
(Auténomo); para levantamientos RTK, seleccione RTK
flotante o RTK fijo.

¢ RTK Parameters, RTK mode (Parametro RTK, Modo RTK) —
seleccione Extrapolacion para RTK flotante (cinemaético) o
Retardo para RTK fijo (estético).

— La extrapolacion es para aplicaciones RTK de latencia
baja y salida de alta frecuencia (>= 5 Hz). El Rover
extrapolard las correcciones de la medicion de la fase de
portadora de la estacion Base al calcular la posicién RTK
actual del Rover.

Se recomienda esta configuracion (extrapolacién).

— El retardo para aplicaciones RTK de alta precisién de 1
Hz. El motor RTK del Rover calcularé la posiciéon RTK
con retardo (para la época a la que corresponde el
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mensaje RTCM/CMR recién recibido) o la posicion
independiente actual (mientras espera nuevos mensajes
RTCM/CMR) desde la base).

* RTK Parameters, Dynamics (Pardmetros RTK, Dindmico) —
seleccione Static o Kinematic.

* RTK Parameters, Ambiguity fixing level (Pardmetros RTK,
Nivel de fijacién de Ambigiiedad) - (no aplicable a RTK
Flotante) seleccione Low (Bajo), Medium (Medio) o High
(Alto) para estados del indicador 95%, 99.5%, 0 99.9%,
respectivamente. El motor RTK utiliza el indicador fijo de
ambigiiedad cuando se toman decisiones con respecto a si
fijar o no ambigiiedades. Mientras mayor sea el nivel de
confianza especificada, mayor serd el tiempo de bisqueda de
ambigiiedad del entero.

i Positioning Mode
Genesal | MINTER | Postunrg | Bace | Botnt | Purs | sabverd | ™ Standalone ¢ RTK Float
Fosiioning Mode Enatie Sckiions | | ™ DGPS [Code Differential] * RTK Fized
© Standakne  ATK Float 7 Slandskons
 DGPS (Cods Dillssria) & RTK Feosd 7
TR RTK, Fasieiei:
7 M 2 e RTE mede Dymamics by faeey bevel
1 Evtrapolations| | Stalic A plowe
2 s - Hirdum
i o & s & Kirsmaic b
I s Liad PR
P W CALL 7 P 7 PALZ | o s
I~ = s Soace. [fur X |
i A
RTK mode—— [ Diynamic: Ambiguity fizing level
- (CordwadendBed || (" Eufrapolation | | ¢ Static . Low
. . & Medium
& Delay &+ Kinematic " High
OF | _ Gt | Save | Senolpacsmetecs o datouks |

Figura 3-13. Configuracion del Rover

Continte con el paso 11 para levantamientos RTK o el paso 12 de
la pagina 3-20.

11. Para levantamientos RTK, haga clic en la pestafia Ports y defina
los siguientes pardmetros de puerto para el puerto serial
(Tabla 3-6), a continuacion haga clic en Apply (Figura 3-14 de la
pagina 3-19).

Para levantamientos post-procesados, mantenga los
valores por defecto para estos parametros.

3-18 Manual del Operador del GR-3



Configuracion del Receptor

Tabla 3-6. Parametros del Receptor para la Pestafia Ports

Parametro Receptor Base Receptor Rover

Entrada n/d (Deje el valor por defecto) | Seleccione el mismo formato
de correccion diferencial que
seleciond para la Base.

Salida Seleccione el tipo y formato Seleccione “None”
de las correcciones (Ninguna).
diferenciales.

Periodo Ingrese el intervalo en que el n/d (Deje el valor por

(segundos) receptor transmitird defecto.)

correcciones diferenciales.

Velocidad de Selecione una velocidad de transferencia en bauidos para
transferencia transmitir mensajes diferenciales desde la tarjeta del receptor al
en bauidos médulo del médem

La velocidad de transferencia en baudios debe coincidir con la
velocidad del puerto serial del médem.

RTS/CTS Seleccione para habilitar la negociacién.

Bl Rucuiver Configus ation
Genesl | MINTER | Positoning| Bate | Rower Pute | Evenis | Advanced

Sosl | Paratel| Mo | USE | Ethenet | TCP |
o T r 2 Haadiale |11° =
Dtgad [t - P [5] | ol
g et [Lenmand L Dasdrate 115200 =
Oupis: [Hane =] Peiedia: | ™ RTS/ATS
eapae IPesi | Cenmend - Busdrale: [0400 =
Duget; [CMA - Period [1]: || ]  RISZIS
SeislD  Igud: | Command = Honsdioln - |115200 = \
[ Intied pggar: [Hone =] et [ ™ RTS/TS
Base ke | [y
. Input : IEommand 'l Baud rate : |334DD 'l
Serial C
Output: |CMR A Period (2] : |1.UU W RTS/CTS

/
Rover

. Input: |CMR - Baud rate : |334DD 'l
Serial C
Output : INone 'l Period [sec]:l [~ RTS/CTS

Figura 3-14. Configuracién de la Base y el Rover para Levantamientos RTK -
Puertos
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12. Haga clic en la pestafia Advanced y a continuacion en la pestafia
Multipath. Configure los siguientes pardmetros y a continuacién
haga clic en Apply (Figura 3-15).

* Code multipath reduction (Reduccién del efecto multipath
del cédigo) — habilitar

* Carrier multipath reduction (Reduccién del efecto multipath
de la portadora) — habilitar

=
Genessl | MINTER | Peastinrg | Basm | Fove | Pute | Events Advorced |

At lnkrsemeracr. Wulipath Reduchion | Loy Momagernes | Estrana Faesparrey | Fows Datia Morsagraset | Ot |

o Cexte rindiguathy et

¥ Code multipath reduction

mesicon] o]

OF. I Lt Save Gualnﬂunumhdefml

Figura 3-15. Configuracion de los Parametros de Multipath

13. Haga clic en OK para aceptar la seleccion y cerrar el cuadro de
dialogo.
Una vez que haya configurado el receptor, la configuracién serd

vélida hasta que la cambie nuevamente utilizando PC-CDU/
TopSURV/Pocket-3D o borrando la NVRAM.

Si desea obtener mds informacién con respecto a los valores
disponibles para configurar los receptores Base y Rover, consulte
el Manual de Referencia PC-CDU.

14. Continte con otras actividades de configuracion o haga clic en
File » Disconnect, a continuaci6 en File » Exit para salir de
PC-CDU. La desconexi6n antes de salir garantiza una gestion
correcta del puerto.

Desconecte el receptor de PC-CDU antes de salir
@ para eliminar posibles conflictos con la gestién de
los puertos seriales de la computadora.
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Configuracion de la MINTER

La Interfaz Minima (MINTER) consta de dos teclas (encendido/
apagado) y FUNCION) que controlan la operacién del receptor,
cuatro LEDs (STAT, REC, RX/TX y BT) que muestran el estado
operatio del receptor, y dos LEDs que muestran el estado de la bateria
(Figura 3-16).

Bateria

FUNCTION

Botén de J Boton de
Encendido FUNCION

Figura 3-16. MINTER

La MINTER efectua las siguientes funciones. Si desea obtener mas
informacion con respecto a la MINTER, consulte “Operacién de la
MINTER” en la pagina 4-8.

Enciende o apaga el receptor; lo pone en el modo Sleep.
Activa o desactiva la grabacién de datos (botén de FUNCION).
Cambia el modo de informacién del receptor.

Muestra el nimero de satélites GPS (verde) y GLONASS
(anaranjado) rastreados (LED STAT).

Muetra el estado de grabacién de datos (LED REC).

Muestra cada vez que los datos se graban en la memoria interna
(LED REC).

Muestra el estado del modo de post-proceso (estdtico o dindmico)
al ejecutar un levantameinto cinemaético de Post-Proceso con la
ayuda de la tecla de funcién (LED REC).
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* Muestra el estado (carga alta, carga intermedia o carga baja) de la
bateria (LED BATT).

* Muestra el estado de alimentacién del receptor (LED BATT).
* Muestra el estado del médem vy si éste recibe sefales (LED TX

RX).

¢ Muestra la actividad de Bluetooth (LED BT).

Utilice PC-CDU para configurar los valores de la MINTER. El
siguiente procedimiento describe los valores mds comunes; consulte
el Manual de Referencia de PC-CDU donde encontrard otras
configuraciones posibles de la MINTER.

1. Conecte su receptor y la computadora. Consulte “Conexion del
Receptor y una Computadora” en la pagina 2-21 donde
encontrard mds informacién con respecto a este procedimiento.

En la pantalla Principal de PC-CDU, haga clic en File » Connect.

3. En el cuadro de didlogo Connection Parameters (Parametros de
Conexion), habilite la negociaciéon RTS/CTS (Figura 3-17).

Consulte “Conexion del Receptor y una Computadora” en la
pagina 2-21 donde encontrara mas informacion con respecto a la
configuracion de otros pardmetros.

4. Haga clic en Connect.

[ Connection Parameters E|

Connection mad

|Vﬁ' Direct " Intemet Client

" Intemet Server |

Pt setling

Port: [com1 =] Baudsate: [115200
E [¥ RTS/CTS handshaking

=] I Infrared port

y i

Frogram selting

ﬂ- Passivemode [~

iginal baud rate on Disconnect

nusl mode only  Timeout [msk |500 B ‘

¥ RTS/CTS handshaking ==

TR port: (2000

Passord: |

I” Display data o server W Log server events

I~ BHE loskup

Cancel

Figura 3-17. Parametros de Conexi6n — Valores de la MINTER

5. Haga clic en Configuration » Receiver y a continuacioén haga
clic en la pestaiia MINTER, configure los siguientes parimetros
y haga clic en Apply (Figura 3-18). Consulte las siguientes
péginas donde encontrard descripciones de estos pardmetros.

e Intervalo de grabacion en la pagina 3-23
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* Mdscara de elevacion para el archivo de registro en la
pégina 3-23

* Prefijo de nombre de archivo en la pagina 3-24

* Anexar siempre al archivo en la pagina 3-24

* Modo de Creacion de Archivos en la pagina 3-24

* Modo Automdtico de Rotacion de Archivos (AFRM) en la
pégina 3-23

* Modo de la tecla de Funcion en la pagina 3-26

* Modo dindmico de coleccion inicial de datos en la
pagina 3-26

* [nicio automdtico del registro de datos en la pagina 3-27

Receiver Configuration x

General MINTER | Fosiforing| Base | Fover | Fats | Events | Advanced |

Recarding interval - 100 [seconds) FN key mode
Elevation mask for Log fle |—5 [dearees) [F LED blink made switch ¢ Oceupation mode switch

File name prefis e | Initieldata collection dynanic mock
Alwaps append to the file : [“' Static r :‘F‘

~Files Creation made [~Data recording auto-star
& Logfle € AFRM & off £ On  Blways

‘Automatic File Rotation Mode (4FRM) parameters— ‘

see) 3600 Fis latal ¢
— l—

‘ I Aulomalicall remoye ofd s |

Refiesh | Appy |

Ext | Save | Setall parameters to defauls
I

Figura 3-18. Configuracion del Receptor — Pestafia MINTER

Parametro de Intervalo de Grabacion Este parametro especifica la
velocidad de registro del archivo de registro cuando el botén de
FUNCION (presionado de 1 a 5 segundos) activa el registro de datos.
Este valor se utiliza tanto para registrar un archivo de registro tinico
como para registrar datos del receptor en el modo AFRM. Los valores
son 1-86400 segundos. El valor por defecto es un segundo.

Parametro Mascara de Elevacion para Archivo de Registro Este
pardmetro especifica el 4ngulo de elevacién minimo para los satélites
cuyos datos quedarén registrados en los archivos del receptor al
presionar la tecla de FUNCION. El valor por defecto es cinco grados.

P/N 7010-0736-SP 3-23



Configuracion del GR-3

Parametro de Prefijo de Nombre de Archivo Este pardmetro
especifica qué tipo de prefijo se afiadird a los nombres de los archivos
del receptor creados al presionar la tecla de FUNCION. El prefijo
puede tener hasta 20 caracteres de longitud. El valor por defecto para
el Prefijo de Nombre es “log”.

Los nombres del archivo de registro presentan la siguiente estructura:
<prefijo><mes><dia><letra alfabética secuencial>

El nombre de archivo depende tanto del momento en que se cred el
archivo (mes y dia) como de sufijos adicionales de letras para evitar
confusion entre los archivos que se creen en el mismo dia.

Parametro Anexar Siempre al Archivo Si desea que los datos
nuevos del receptor se anexen a un archivo de registro existente,
ingrese el nombre de archivo deseado en este pardmetro. El valor
puede tener hasta 20 caracteres de longitud.

Parametro Modo de Creacion de Archivos Este pardmetro tiene
los siguientes modos de operacién:

* Log file (Archivo de registro) — Si se ha seleccionado el botén de
seleccién de archivos de registro, si se presione el botén de
FUNCION se cierra el archivo de registro actual. Si el registro de
datos se encuentra desactivado, si presiona el botén de
FUNCION se abre un nuevo archivo de registro.

* AFRM - Si se ha seleccionado el botén de AFRM, al presionar el
botén de FUNCION, este modo quedaré habilitado. Si AFRM se
encuentra habilitado, al presionar el botén FUNCION se
deshabilita este modo.

Pardmetros del Modo de Rotacion Automatica de Archivos
(AFMR) Los receptores TPS pueden rotar autométicamente archivos
de registro. Durante un evento de “rotacion de archivos”, el receptor
cierra el archivo en uso y abre un nuevo archivo de acuerdo con el
cronograma definido por el usuario. Los parametros de Periodo y
Fase se especifican en este cronograma. La rotacién de archivos
comienza cuando el Periodo del médulo de tiempo del receptor es
igual a Fase. M4s especificamente, un archivo de registro nuevo se
abre inmediatamente antes de la época programada haciendo que los
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datos identificados con esta época se registren en el archivo de
registro nuevo.

Al abrir un archivo de registro nuevo, el receptor habilita un grupo de
mensajes por defecto generados con el periodo de salida por defecto.
Tanto el grupo de mensajes por defecto como el periodo de salida por
defecto son programables.

* Period — especifica la duracién de cada archivo de registro creado
en el modo AFRM. Los valores fluctian entre 60 y 86400
segundos; el valor por defecto es 3600 segundos.

» Phase — especifica la “fase” ( cambio constante de tiempo) de
creacion de multiples archivos de registro en el modo AFRM. Los
valores fluctian entre 0 y 86400 segundos; el valor por defecto es
cero segundos.

* Files (total) — contador que especifica cuantos archivos de
registro multiple deben ser creados en AFRM hasta que este
modo se desactive automdticamente. Este contador va
disminuyendo con cada rotacién de archivo hasta que su valor
llegue a cero, entonces la rotacion de archivos se detiene
automdaticamente. El contador se inicia con AFRM.

Tenga presente que un archivo de registro se abre inmediatamente
después de activar AFRM. Este archivo de inicio no se considera
un evento de rotacion de archivos; el contador AFRM no
disminuira.

Los valores fluctian entre 0 y [231-1]; el valor por defectoes 0
(cero). Cero significa que es posible crear un nimero ilimitado de
archivos de registro.

La memoria del receptor tiene capacidad para hasta
512 archivos.

* Files (remain) — especifica el nimero de archivos que el receptor

aun puede crear en AFRM. Los valores fluctian entre 0 y [231—1];
el valor por defecto es cero.

* Automatically remove old files (eliminar automaticamente
archivos antiguos) — si no existe memoria libre para registrar
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datos, automdticamente se borrard el primer archivo de registro.
Si se habilita este pardmetro, su receptor eliminard el archivo con
la hora/fecha de creaciéon mds antigua. AFRM debe estar
habilitado para utilizar la caracteristica Primero en Entrar,
Primero en Salir (FIFO, por sus siglas en inglés). El valor por
defecto es Off (desactivado).

Parametro del Modo de la Tecla de Funcion Utilice estos dos
botones de seleccidn para programar como reaccionard el receptor al
presionar la tecla de FUNCION.

* Control del modo de parpadeo del LED — al presionar el botén de
FUNCION alternaré entre los modos de informacién normal/
extendida de la MINTER e iniciard/detendrd la grabacién de
datos del levantamiento Estatico.

— Si presiona el botén de FUNCION durante menos de 1
segundo: cambia el modo de informacién (Modos Normal o
Informacién Extendida).

— Si presiona el botén de FUNCION de 1 a5 segundos: inicia/
detiene la grabacion (Modo de post-proceso estdtico).

 Control del modo de ocupacién — al presionar el botén de
FUNCION (menos de un segundo) se insertara en el archivo de
registro correspondiente un mensaje indicando que el tipo de
levantamiento ha cambiado de estatico a cinematico, o viceversa.
Si el LED REC parpadea de color verde, el modo actual es
dinamico, si parpadea de color anaranjado, el modo actual es
estatico. Si desea obtener méas informacién al respecto, consulte
la Tabla 1-2 de la pagina 1-15 y consulte el Manual de Referencia
de PC-CDU.

Parametro del Modo Dinamico de Coleccién Inicial de Datos

Estos botones de seleccion especifican el descriptor de tipo de
ocupacion de inicio insertado al comienzo de los archivos registrados
del receptor. Seleccione Static o Kinematic para especificar que el
archivo de registro correspondiente se iniciard con una ocupacién
estitica (PARAR) o cinemética (SEGUIR, Trayectoria),
respectivamente.
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Parametro de Inicio Automatico de Registro de Datos Estos
botones de seleccidn le permiten programar el comportamiento de su
receptor en caso ocurriese un corte de energia.

La Tabla 3-7 describe los diferentes escenarios disponibles y los
resultados después de restaurar la energia en el receptor. “Specified
file” hace referencia al nombre de archivo ingresado en el campo

Always append to file (Anexar siempre a archivo).

Tabla 3-7. Comportamiento del Parametro de Grabacién de Datos

registrados en
el archivo por

reanudara al
restablecerse la

al restablecerse la
energiay los datos

Antes del Resultados de los Botones de Seleccion Habilitados
corte de
energia Apagado Encendido Siempre
Datos del El registro de El receptor El receptor reanudard
receptor datos no se reanudarg el el registro de datos en
registradosen | reanurdard al registro de datos el mismo archivo al
un archivo restablecerse la en el mismo restablecerse la
especifico. energia. archivo al energia.
restablecerse la
energia.
Datos del El registro de Se abrira un nuevo | Se abrird un nuevo
receptor datos no se archivoderegistro | archivo de registro al

restablecerse la
energia y los datos se

receptor no se
ha iniciado.

registro de datos
al restablecerse la
energia.

registro de datos
al restablecerse la
energia.

defecto. energia. se registrardn en registrardn en este
este archivo. archivo.

Archivo No se abrird No se abrird Se abrird un archivo

especificado, ningun archivo ningun archivo de registro con este

el registro de con este nombre. | con este nombre. nombre y el registro

datos del No se iniciard el N ose iniciard el de datos empezard tan

pronto como se
restablezca la energia.
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Tabla 3-7. Comportamiento del Parametro de Grabaci6n d

e Datos (Continuacion)

Antes del Resultados de los Botones de Seleccion Habilitados
corte de
energia Apagado Encendido Siempre

No se No se iniciard el No se iniciard el Se abrird un archivo
especifica registro de datos registro de datos de registro con un
ningin alrestablecersela | al restablecerse la | nombre por defecto y
archivo, el energia. energia. se iniciard el registro
registro de de datos tan pronto
datos del como se restablezca
receptor se la energfa.
encuentra
apagado.

Asimismo, si Always se encuentra habilitado, el receptor

automaticamente comenzard a registrar datos (en

un archivo recién

creado o en un archivo existente) en los tres casos siguientes:

* Después de encender el receptor con el botén

de encendido.

* Después de reiniciar el receptor (con PC-CDU).

* Después de sacar el receptor del Modo Sleep

[Ed Receiver Configuration

General  MINTER | Positoning | Base | Fiaver | Pants | Events | Advanced |

Recording interval 100 [seconds) FN key mods
Elevaion mack for Lo e [5 [cegress] ’7(-‘ LED biink mode switch ¢ Docupation made spitch
File name prefis: g Iriial data collection dyramic mod
Aluays append to the file ’7“- iatic £ Kinemtic
Files Creation mods Data recording autosta
[F Logfle O AFAM ‘ ’7(-‘ off € on C Blways

Automatic Fils Rotation Mads [5FRM) parameters———

Pesind [sec] [ 3600 Files [totaf ] [0

Phase [sec]; [0 Files [remain] o0

™| Automaticallyremove ofd files

Riefiesh |

Aol |

[ok | s Save | Set all parameters ta defaults |

Figura 3-19. Pestafia MINTER
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Capitulo 4

Instalacion del
Receptor GR-3 v
Levantamiento

Después de configurar los receptores para el levantamiento, es
necesario instalar el receptor y medir la altura con el receptor para
que poder iniciar el levantamiento. La MINTER proporciona acceso
répido para registrar datos, modificar los modos del receptor y
consultar el registro general de datos y la informacidn satelital
durante un levantamiento.

Instalacion del Receptor

Un sistema de levantamiento GPS tipico consta de una estacion Base
instalada en un punto conocido y un receptor Rover que se emplea
como colector mévil de datos. Después de instalar los receptores Base
y Rover, debe medirse la altura de la antena.

Antes de colectar datos, asegirese de que los receptores Base y Rover
contengan datos de almanaques y datos de efemérides existentes
(consulte “Coleccion de Almanaques y Efemérides” en

la pagina 2-28).
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Paso 1: Instalacion de los
Receptores

La estacion Base debe instalarse, registrar y transmitir datos antes de
la instalacion del receptor Rover. La instalacion del receptor para
levantamientos post-proceso o RTK es la misma.
[J Instale la estacién Base y sus Componentes.
Consulte “Para instalar el receptor Base” en la pagina 4-2 donde
encontrard mas informacién al respecto.
O Instale el receptor Rover.
Consulte “Para instalar el receptor Rover” en la pdgina 4-3 donde

encontrard mas informacién al respecto.

Para instalar el receptor Base (Figura 4-1 en la pagina 4-3):

1. Instale un tripode sobre un punto de control conocido.

2. Asegure la base nivelante (tribrach) universal al tripode. Coloque
el adaptador tribrach (universal o de precision) en el tribrach y
ajuste los tornillos.

3. Inserte el conector en L (espaciador horizontal) en el adaptador
tribrach de precision.

4. Acople el receptor GR-3 al adaptador tribrach. Acople la antena
deseada al conector de la antena del médem.

5. Nivele cuidadosamente el tripode y ajuste los tornillos.

6. Acople cualquier otro accesorio segun se requiera (por ejemplo,
una fuente de alimentacién de respaldo).
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Receptor GR-3

Espaciador Horizontal

Adaptador para Tribrach (Precision)

Tribrach Universal

Figura 4-1. Instalacién de un Tripode y un Receptor sobre un Punto de Control
Para instalar el receptor Rover (Figura 4-2 en la pagina 4-4):

1. Silo requiere, acople el dispositivo de desconexién rdpida al
bipode/jalén.

Utilice un bipode durante los levantamientos para
@ garantizar que la antena/receptor permanezca

estable durante el registro de datos.

2. Acople el receptor GR-3 al dispositivo de desconexion rapida.
Asegtirese de que el receptor calce en su lugar.

3. Acople la antena deseada al conector de la antena del médem.
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™~ Receptor GR-3

o~ Dispositivo de desconexién réapida

T~ Tornillo de 5/8

D— Seguro

T

Figura 4-2. Conexién del Receptor GR-3 al Bipode

Paso 2: Medicion de la Altura de la
Antena

La ubicacion de la antena en relacién con el punto que se medir4 es
sumamente importante tanto para levantamientos en los que la
elevacion de puntos es importante como en levantamientos de
ubicacion horizontal. Los levantamientos horizontales son
frecuentemente mayores en cuanto a area y pueden adecuarse con
comodidad a una superficie nivelada, por lo que el ajuste de la antena
debe ser tridimensional para luego proyectarse en un plano
bidimensional.
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El receptor calcula las coordenadas del centro de fase de la antena.
Para determinar las coordenadas del marcador de estacion, el usuario
debe especificar lo siguiente:

* Altura medida de la antena por encima del marcador de estacion
* Método utilizado para medir la altura de la antena
* Modelo de la antena utilizada

Las antenas efectian dos tipos de mediciones:

* Vertical — medida desde el marcador hasta el punto de referencia
de la antena (ARP) que se ubica en el extremo inferior del
receptor en la base de las roscas de montaje.

¢ Inclinada — medida desde el marcador hasta el borde inferior de la
marca de medicién de altura inclinada (SHMM) que se ubica en
los paneles posteriores del receptor.

El punto medido al efectuar un levantamiento con un GPS/
GLONASS se denomina Centro de Fase de la antena. Es similar al
punto medido por el distanciémetro en un prisma. El usuario debe
ingresar la desviacion del prisma para compensar este punto que no se
encuentra en una superficie fisica del prisma. Para una antena GPS/
GLONASS, se ingresa la desviacion de acuerdo con el tipo de
medicién que se efectte.

* Para la medicién vertical, simplemente se aflade la desviacion a la
altura vertical medida para producir una altura vertical “correcta”.

* En el caso de la altura inclinada, primero es necesario calcular la
altura vertical utilizando el radio de la antena y después se afade
la desviacion.

Los desplazamientos son diferentes debido a la diferencia en la
ubicacion entre el punto de medicién inclinado y el punto de
medicién vertical.

1. Mida la altura de la antena sobre el punto de control o punta del
baston, ya sea altura incinada o altura vertical (Figura 4-3 en la
pégina 4-6).

2. Registre la altura de la antena, el nombre del punto y la hora de
inicio en las notas de campo.
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A =ARP a borde =78.3
B = ARP a esquina = 96.7

------- ‘--‘----------J----L-

Altura Inclinada hasta
la Base Esquinada del
Tope Gris

Marcador de Estacion
o Punta del Jalén RTK

Figura 4-3. Mediciones de Desplaz
* Desplazamiento vertical SHMM

¢ Radio SHMM a ARP =78.3mm

La Tabla 4-1 presenta los valores de
receptores.

Altura Vertical

aARP

Al medir la altura de la antena
del Rover, incluya la altura del
dispositivo de Desconexion Rapida.

amiento de la Antena
a ARPt = 168mm

al lado; 95.8mm a la esquina

desplazamiento para los

Tabla 4-1. Valores de Desplazamiento para el Receptor GR-3

ARP a Centro de Fase L1

ARP a Centro de Fase L2

Hacia arriba 228.8mm

216.3mm

4-6
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Instalacién del Receptor

Paso 3: Coleccion de Datos

Consulte las siguientes secciones de este capitulo para obtener més
informacién con respecto a la coleccién de datos.

1.

Encienda el receptor. La luz (LED) STAT parapadeard de color
rojo al principio.

Una vez que el receptor haya capatado uno o més satélites, la luz
STAT comienza a parpadear de color verde buscando satélites
GPS, y de color anaranjado buscando satélites GLONASS. Un
parpadeo corto de color rojo indica que el receptor no ha
calculado una posicién. Cuatro o més atélites ofrecen un
posicionamiento éptimo.

Una vez que desaparezca el parpadeo corto de color rojo, el
receptor tiene una posicion y puede iniciarse el levantamiento;
espere a que aparezcan las luces verde y anaranjada antes de
comenzar a colectar datos. De esta manera, se asegura que la
fecha y hora del receptor sean correctas y de que éste haya
capatado suficientes satélites, garantizando asi datos de buena
calidad.

El proceso de capturar satélites normalmente demora menos de
un minuto. En un drea nueva, con follaje espeso, o después de
reiniciar el receptor, la captura podria demorar varios minutos.

Para comenzar a colectar datos, presione y mantenga presionada
la tecla de FUNCION (durante més de un segundo y menos de
cinco segundos).

Deje de presionar la tecla de FUNCION cuando el LED REC
(Grabacion) esté verde. Esto indica que un archivo se encuentra
abierto y que se ha iniciado la coleccién de datos. EI LED REC
parpadea cada vez que se guardan datos en la memoria interna.

Utilice la PC-CDU para configurar el registro de
i datos. Consulte “Configuracién de la MINTER” en la
= pagina 3-21 o el Manual de Referencia de PC-CDU
para obtener mds informacion al respecto.
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Instalacion del Receptor GR-3 y Levantamiento

6. Al terminar, presione y mantenga presionada la tecla de
FUNCION hasta que se apague la luz del LED REC.

7. Para apagar el receptor, presione y mantenga presionada la tecla
de encendido hasta que se apaguen todas las luces, después
suéltela.

Operacion de la MINTER

La MINTER es la interfaz minima del receptor que se utiliza para
mostrar y controlar la entrada y salida de datos (Figura 4-4).

REC RX TX
STAT -\ -\ /_ /— BT

-
N o @ e» > @)

Bateria

i\ N\
\\@/» (FuncTioN)

Botén de _j Botén de -

Encendido FUNCION | |
4 ﬁgg

Figura 4-4. MINTER del GR-3

La MINTER efectia numerosas funciones, entre las que se incluyen:
* Enciende o apaga el receptor.
* Activa o desactiva la grabacién de datos (tecla de FUNCIC)N).
* Cambia el modo de informacién del receptor.

* Muestra el niimero de satélites GPS (verde) y GLONASS
(anaranjado) que se estdn rastredndose (LED STAT).

* Muestra el estado de grabacién de datos y cada vez que se graban
datos en la memoria interna (LED REC).

* Muestra el estado del modo de post-proceso (estatico o dindmico)
durante un levantamiento cinemadtico post-procesado (LED REC).
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Operacion de la MINTER

* Muestra el estado (carga alta, carga intermedia o carga baja) de la
bateria (LED BATT).

* Muestra el estado de alimentacién del receptor (LED BATT).
* Muestra el estado del médem vy si recibe senales (LED RX TX).
¢ Muestra la actividad de Bluetooth (LED BT).

Consulte “MINTER” en la pagina 1-12 donde encontrard una
descripcién completa de la MINTER.

Para encender/apagar el receptor, presione el botén de encendido
(Figura 4-5).

* Al encender, presione el botén de encendido hasta que los LEDs
de la MINTER parpadeen brevemente.

* Al apagar, presione el boton de encendido hasta que se apaguen
los LEDs, a continuacidn deje de presionar el boton.

Presione el botén de
encendido durante
aproximadamente 1
segundo para encender/
apagar el receptor

0] 0]

FUNCTION

Boton de
Encendido

- Y

=)

Figura 4-5. Funciones del Bot6n de Encendido

Para iniciar/detener el registro de datos, presione el boton de
FUNCION durante 1-5 segundos (Figura 4-6).

* Durante la grabaciéon de datos, el LED REC estd verde. Utilice
PC-CDU para definir el intervalo del tiempo de grabacién.
Consulte “Pardmetro de Intervalo de Grabacién” en
la pagina 3-23 para encontrar mds informacién al respecto.
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Instalacion del Receptor GR-3 y Levantamiento

* El LED REC parpadea de color verde cada vez que se transfieren
datos a la memoria SD/MMC.

» Si el LED REC estd rojo, esto significa que al receptor ya no le
queda memoria disponible, tiene un problema de hardware, no
tiene una tarjeta SD/MMC, o contiene un OAF incorrecto
(consulte “Archivo de Autorizacion de Opciones (OAF)” en la
pagina 1-26 donde encontrard mas informacion al respecto).

Utilice PC-CDU para habilitar el modo de la tecla de FUNCION
deseado en el receptor, ya sea el “LED blink mode switch” (Cambio
del Modo de Parpadeo del LED) para levantamientos estéticos u
“Occupation mode switch” (Cambio del modo de ocupacioén) para
levantamientos cinemdticos. Consulte “Pardmetro del Modo de la
Tecla de Funcién” en la pagina 3-26 donde encontrard mas
informacion al respecto.

Cada vez que active o desactive la grabacion de datos, se abrird un
nuevo archivo o se anexaran datos a un archivo particular. Consulte
“Pardmetro Anexar Siempre al Archivo” en la pagina 3-24 y
“Pardmetro Modo de Creacion de Archivos” en la pagina 3-24 donde
encontrard mas informacién con respecto a la configuracion de estas
funciones.

Presione el botén de
FUNCIONdela5
segundos para iniciar/
detener el registro de
datos

/

0] 0]

FUNCTION

Botén de o
FUNCION \ \

(T = )

Figura 4-6. Funciones del Botén FUNCTION
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Levantamiento Estatico para Estaciones Base

Para alternar entre modos de post-proceso, presione el botén de
FUNCION durante menos de 1 segundo cuando se haya habilitado el
“Cambio del modo de ocupacion” utilizando PC-CDU.

Para cambiar el modo de informacion del receptor, presione el
botén de FUNCION durante menos de 1 segundo cuando se haya
habilitado el “Cambio del modo de parpadeo del LED” utilizando
PC-CDU.

Para cambiar la velocidad de transferencia en baudio§ del
puerto serial del receptor, presione el botén de FUNCION de 5 a 8

segundos. Esto resulta util si la colectora de datos no soporta la
velocidad configurada en el puerto del receptor.

Aproximadamente cinco segundos después, el LED REC se vuelve
rojo. Suelte el boton de FUNCION durante los siguientes tres
segundos.

Levantamiento Estatico para
Estaciones Base

El levantamiento estético es el modo de levantamiento clésico, ideal
para todas las lineas de base (cortas, medianas y largas). Al menos
dos antenas de receptores perpendiculares a las marcas de
levantamiento, colectan simultineamente datos brutos en cada uno de
los extremos de una linea de base durante cierto lapso de tiempo.
Estos dos receptores rastrean cuatro o m4s satélites comunes, a una
velocidad comin de registro de datos (5-30 segundos) y con los
mismos dngulos de error de elevacion. La duracidn de las sesiones de
observacion puede oscilar entre algunos minutos y varias horas. La
duracién 6ptima de la sesién de observacion depende de la
experiencia del topdgrafo asi como de los siguientes factores:

* La longitud de la linea de base medida
¢ El nimero de satélites visibles
* La geometria satelital (DOP)

¢ La ubicacién de la antena
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Instalacion del Receptor GR-3 y Levantamiento

* El nivel de actividad ionosférica
* Los tipos de receptores utilizados
* Los requerimientos de precisién

* Lanecesidad de despegar las ambigiiedades de la fase de
portadora

Por lo general, los receptores de una frecuencia se utilizan para lineas
de base de menos de 15 kilémetros (9.32 millas) de longitud. Para
lineas de 15 kildmetros o mas, utilice receptores de doble frecuencia.

Los receptores de doble frecuencia ofrecen dos ventajas importantes.
En primer lugar, los receptores de doble frecuencia pueden estimar y
eliminar casi por completo el efecto ionosférico de las mediciones de
codigo y de fase de portadora, ofreciendo mayor precisiéon que los
receptores de una frecuencia en lineas de base largas o durante
tormentas ionosféricas. En segundo lugar, los receptores de doble
frecuencia requieren un menor tiempo de observacion para alcanzar la
precision deseada..

Después de completar el levantamiento, los datos colectados por los
receptores pueden descargarse a una computadora y procesarse con
un software de post-proceso (Topcon Tools, por ejemplo).

Levantamiento Cinematico
(Stop & Go, Parar y Seguir)
para Estaciones Rover

En un levantamiento cinemético (parar y seguir), se instala el receptor
en un punto conocido como un monumento topografico, o un punto
desconocido. El receptor rastrea continuamente satélites y registra
datos brutos en su memoria. El receptor del rover se instala en un
punto descnocido y colecta datos en el modo estatico durante 2 a 10
minutos. Al terminar, asigna al Rover el estado cinemadtico y pasa al
siguiente punto de levantamiento. En este punto, y en cada punto
posterior, el receptor cambia al modo estatico para colectar datos. De
esta manera, mientras se encuentra en movimiento, el Rover se
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Levantamiento Cinematico (Stop & Go, Parar y Seguir) para Estaciones Rover

encuentra en el modo cinemético, y mientras colecta datos, el Rover
se encuentra en el modo estatico.

1.

Coloque el Rover sobre un punto desconocido y presione la tecla
de encendido. Espere de dos a diez minutos para que el Rover
colecte datos estaticos. El LED REC estara anaranjado.

Revise la luz del LED STAT para determinar si se han rastreado
satélites..

Al terminar, presione el botén de FUNCION durante menos de 1
segundo para indicarle al Rover que pase al modo cinemético.

Recuerde, si el LED REC parpadea de color verde,
a esto significa que el modo actual es dindmico, si

RECOMENDACION

S parpadea de color anarajando, significa que el modo
actual es estatico.

Mueva el Rover a la ubicacién siguiente (punto de
levantamiento), y presione el botén de FUNCION durante menos
de un segundo para colectar datos en modo estético de dos a diez
minutos.

Repita los pasos cinco y seis hasta que todos los puntos hayan
sido levantados. El tiempo de ocupacién para los puntos depende
de los mismos factores de los que depende el método de
levantamiento estatico.

Al terminar, presione el bot6n de FUNCION durante uno a cinco
segundos para dejar de registrar datos. Apague el Rover en caso
de ser necesario.

Este método de levantamiento GPS le permite al operador reducir el
tiempo de ocupacién del punto, permitiendo a las brigadas de trabajo
en campo levantar muchos mds puntos en comparacién con los demés
métodos disponibles.
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Instalacion del Receptor GR-3 y Levantamiento

Levantamiento Cinematico en
Tiempo Real

Con el levantamiento RTK, al igual que con el levantamiento
cinemadtico descrito anteriormente, un receptor funciona como
estacion de referencia y efectia observaciones con su antena acoplada
a un tripode estacionario o a algin otro dispositivo. El otro receptor
funciona como un Rover y efectiia observaciones (valiéndose de una
antena) acoplado a un bastén mévil y trasladado a los puntos de
observacion.

A diferencia de los levantamientos cinematicos post-procesados, los
levantamientos RTK emplean un enlace de comunicacion entre la
Base y el Rover. Con un radioenlace médem, el receptor Base
transmite sus datos de medicién y ubicacidn al receptor Rover. El
Rover, basdndose en los datos transmitidos y en sus propios datos de
observacion, efectda un andlisis inmediato de linea de base y exporta
los resultados. Para levantamientos RTK, consulte “Configuracion del
Radio Médem” en la pagina 3-3 y “Configuracion del Receptor” en la
pagina 3-11.

Si utiliza PC-CDU para monitorear un receptor Rover RTK, habilite
el campo LQ en la pantalla principal (Figura 4-7 en la pagina 4-15)
para asegurarse que el receptor obtenga correcciones diferenciales.
Por lo general, el receptor comenzar a enviar las coordenadas del
centro de fase de la antena junto con el tipo de solucién en un lapso de
10-30 segundos. Sin embargo, la sincronizacion de radios de espectro
ensanchado y teléfonos GSM podria demorar hasta 60 segundos.

Las coordenadas geodésicas que se despliegan en la pestafia Geo
siempre se calculan en WGS84 y tienen cuatro tipos de solucién.

» Standalone (Auténoma) — donde el receptor calcula las
coordenadas 3D en el modo auténomo sin utilizar correcciones
diferenciales.

* Code differential (Diferencial de c6digo) — donde el receptor
Rover calcula la coordenada relativa actual en el modo diferencial
utilizando sélo pseudorangos.
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Levantamiento Cinematico en Tiempo Real

* RTK float (RTK flotante) — donde el receptor Rover calcula las
coordenadas relativas actuales en el modo diferencial utilizando
tanto pseudorangos como fases; sin embargo, con una solucién
flotante, la ambigiiedad de fase no es un nimero entero fijo y en
su lugar se utiliza el estimado “flotante”.

* RTK fixed (RTK fijo)- donde el receptor Rover calcula las
coordenadas relativas actuales, con fijacién de ambigiiedad, en
modo diferencial.

El campo LQ refleja el estado de los mensajes diferenciales recibidos
y contiene la siguiente informacion:

* Calidad del enlace de datos expresada en términos porcentuales

* Tiempo (en segundos) transcurrido desde el dltimo mensaje
recibido

* Numero total de mensajes correctos recibidos (dependiendo del
tipo de mensaje recibido)

* Numero total de mensajes corruptos recibidos (dependiendo del
tipo de mensaje recibido)

Si por algtin motivo, el receptor no esta recibiendo correcciones
diferenciales, o si no se ha configurado ninguno de los puertos para
recibir correcciones diferenciales, el campo LQ estard vacio o
mostrard 100%(999,0000,0000).

[EPC-DU to GR3 ID:RBPTI30GRGW (rover) =10 x|

Eile Configuration Tools Plots Help
GPS Satellites [9) Geo IXYZ |Target| GLOMASS Satellites [6)

w [ EL] ez[calpi[pa[ 7o os[ Lat 55 43187161°N [ sn[fn| EL] az[calpi[pra] 1c] s5]
03 e b2 42 o7 37 & s AT SIRTEVE T or Cea ame an @147 4 g
7o 1B M1 1818 4 a0 ph preseel 02 01 18+ 334 38 33 41 4 55¢
08 59+ 242 51 42 42 B S+ peepelGniEsm 08 05 38- 206 41 43 45 4
10 45c 283 B0 I I B S5+ pucuer n3iidme |18 10 24~ 28 34 3 3 4 55
13 a7 122 46 3 34 B S5« ppop 17238 19 03 29+ B0 41 43 43 4 55«
19 13+ 94 44 4 24 5 E 20 11 12+ 112 36 W I 4 T

B

5

4

a7 e a2 51 M M N | neg i ESA]
2 17 188 43 %5 25 N

2 9+ 293 42 A 20 30-

Receiver time: 14:17.05

Receiver date: 08.08. 2008
LG: 1003 (000,0363,0000)
Osc. offset:  -0.8633 ppm
Tracking time: 00:06:17

COM1, 115200, HS | 00:02:59

Figura 4-7. Pantalla Principal de PC-CDU
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Notas:
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Capitulo 5

Mantenimiento del
Receptor y de los
Archivos

Si post-procesa los datos después de completar un levantamiento, los
datos de la memoria del receptor necesitardn descargarse a una
computadora. La descarga y eliminacién de archivos preparardn
también la memoria del receptor para el siguiente levantamiento. En
ocasiones, podria ser necesario borrar la NVRAM del receptor para
eliminar problemas de comunicacién o rastreo.

A medida que se amplien las expectativas del proyecto, el OAF del
receptor podria requerir actualizarse para ofrecer mayores
operaciones y funcionalidad. Las diversas tarjetas que se encuentran
dentro del receptor (GPS, alimentacién, médem y Bluetooth)
requieren firmware para operar y proporcionar las funciones
adecuadas. A medida que TPS saca actualizaciones de firmware, la
carga de éstas en el receptor garantizard que éste funcione a su
maximo potencial.
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Mantenimiento del Receptor y de los Archivos

Descarga de Archivos a una
Computadora

Después de completar un levantamiento, descargue los archivos de
datos a una computadora para guardarlos, post-procesarlos o tenerlos
como backup. Ademads, la memoria del receptor guarda un nimero
definido de archivos e informacién, por lo que la descarga de archivos
evita que éstos se pierdan. PC-CDU y Topcon Link proporcionan
gestores de archivos para descargar archivos del receptor a su
computadora, y para eliminar archivos del receptor. PC-CDU Lite y
Topcon Link son utilitarios gratuitos que puede solicitar a su
Distribuidor de Topcon o descargar del sitio web de Topcon
(www.topconpositioning.com).

Utilice Topcon Tools para descargar archivos de la
tarjeta SD. Consulte el Manual de Referencia de
S Topcon Tools donde encontrard mas informacion al
respecto.

Descarga de Archivos a través de
Topcon Link

Topcon Link proporciona dos opciones para descargar archivos desde
un receptor: via Windows® Explorer o via la interfaz de Topcon Link.

Antes de descargar archivos, debe conectar su receptor y
computadora (consulte “Conexién del Receptor y una Computadora”
en la pagina 2-21 donde encontrard informacién con respecto a este
procedimiento).

...Con Windows Explorer

1. Conecte su receptor y la computadora. Consulte “Conexién del
Receptor y una Computadora” en la pagina 2-21 para obtener mas
informacién con respecto a este procedimiento.

2. Abra Windows Explorer y haga clic en la carpeta Topcon
Receiver. El panel derecho de la ventana muestra el inicio
automatico de la bisqueda de receptores de Topcon conectados a
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Descarga de Archivos a una Computadora

cualquiera de los puertos de la computadora (COM y USB)
(Figura 5-1).

3. Al terminar, se mostrardn todos los receptores conectados a los
puertos de la computadora (Figura 5-1).

% Topcon Receivers (=13
Fle Edt Wew Favortes Tooks Help r
Q-0 & ) search ([ poiders
Address | ) Topeon Recsivers v B
Folders = %
) Topcon Receivers ~
H & i
[ & Topcon Total Stations NP
& My Metwork Places
# Recyrls Bin Stop "*'
E¥ My Bluetoath Places =
- — T T
address | &) Topcon Receivers v B
Folders B & ;-_. ;‘.
ER-4] 1o ers -
¥ Searchfor  HEGD HIPER.
= i comnect...

2 Topeon Total Stations
& My Hetwork Places -
-

Figura 5-1. Buscando y Encontrando Receptores Topcon en Windows Explorer

4. Para dejar de buscar receptores al encontrar el receptor deseado,
haga clic en Stop (Detener). Se mostrardn uinicamente los
receptores descubiertos.

| ] Topcon Receivers

File Edit  View Favorites Tools  Help o
n @) - =
e Back = () ,‘_ﬁ: - Sk | [ Folders Favortes Tools  Help a
Adtress | @) Topean Receivers v|EY e 5 /._'l Search [ Folders
& -

Folders i

4 Topcon Digital Levels - 2 sceivers ¥ B

&) Topeon Receivers = a‘ -

£ Topcon Tokal Stations There are 1 new receivei(s] found ital Lovels = <

& My Hetwork Places ~ | Searchfor HIPER,
& Recycle Bin &Q connet...
My Bluetaoth Places 2l Stations
©3 My Network. Places E
I # Recyrls Bin v

<

Figura 5-2. Desglose de Busqueda de Receptores

5. Para actualizar informacién acerca de los receptores conectados
al puerto de la computaodra, haga clic en Search for connected
receivers (Buscar receptores deseados).

6. Para ver informacion acerca del receptor (Figura 5-3), haga clic
derecho en el receptor deseado y seleccione la opcién Properties
(Propiedades).
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Mantenimiento del Receptor y de los Archivos

7. Para ver el archivo de datos brutos colectados, haga clic en el
receptor deseado.

Folders

Properties E|
% Topcon Receivers (=13 Receber propertes |
Fle Edt Wew Favortes Tooks Help r
Q- @ - (T O search |[[2 Folcs Receiver:
Address | #) Topon Recsivers v He Model: HE_GD.
= a‘ & : 2223336BEEE
) Topcon Receivers ~
2 Port: com
& HIPER Search for
& Topon Tatal Stations connect... Trensfer options fl...
& vy Metwork Places -
2 Recycle Bin v
— oK Cancel | ‘

Figura 5-3. Propiedades del Receptor

Para importar el(los) archivo(s) del receptor a una carpeta,

seleccidnelo(s) y cépielo(s) a la carpeta empleando el método
arrastrar y soltar (Figura 5-4).

File Edt Wiew Faworites Tooks  Help

Qe - © - T O seanh ‘|p Foders |
Address | &2 HIPER

Folders

) TL_Data
() Topron Link Daka

<

@ Topcon Tools Data i ];
| [

AR

@wm.tps log0101c.tps  logD101e.tp

0 0TE ks

Downloading file logl e tps
Downloaded 4096 bytes of 5227

Tiansfer rate is 4096 bytes/sec

Cancel

Figura 5-4. Inicio de la Importacién de Archivos desde el Receptor de TPS/
Importacién en Progreso

...Con Topcon Link

1.

Conecte su receptor y la computadora. Consulte “Conexidn del

Receptor y una Computadora” en la pagina 2-21 para obtener
informacién con respecto a este procedimiento.

Para iniciar Topcon Link, haga clic en el botén Import from

Device (Importar desde Dispositivo) en la Barra de Herramientas.

En el panel izquierdo del cuadro de didlogo Import from Device

(Importar desde Dispositivo), haga doble clic en Topcon
Receivers (Figura 5-5 de la pagina 5-5).
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kA Import from Device " El
Lok i i My Computer - JJ Laok in: I3 Fiaw data - ﬂ@
Mabile Device [ From _Net
‘opcon Digital Levels & lag0101b.tps
s & logD101c.tps
& Topcon Total Stations & log0101e tps
& log0314a.tps

Figura 5-5. Importar desde la Ventana de Dispositivos

4. El programa busca automaticamente receptores de Topcon
conectados a los puertos de la computadora (COM y USB). Al
terminar, se mostraran todos los receptores conectados a los
puertos de la computadora (Figura 5-6).

= Import from Device =~ Import from Device

Lookin &) Topoon Recsivers. _+| | 8] 21 Lockin  [#)Topoon Rscowers v | 4= (1] &
%k Search For connected receivers
< HE_GD
< HIFER

g 1
Searching... I
Stop

Figura 5-6. Busqueda de Receptores Topcon

5. Para ver informacién acerca del receptor, haga clic derecho en el
receptor deseado y seleccione la opcién Properties (Figura 5-7).

H Import from Device 5 - &‘
roperties %]
Look i |&) Topcon Receive | 4 = =)
ceiver properties
[@search for connected recevers

<7 HE_GD
|

Select

Receiver:
TransFer opiions File. k I

Model: HE_GD
ID: 22233386668
Port: COM1L

Ok Cancel | ‘

Figura 5-7. Propiedades del Receptor
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Mantenimiento del Receptor y de los Archivos

6. En el panel derecho de la ventana Import From Device (Importar

desde Dispositivo), examine y seleccione, o cree, una carpeta para
guardar los archivos (Figura 5-8).

Para ver el archivo de datos brutos colectados, haga doble clic (o
clic en Select en el menu emergente) en el receptor deseado. Para
importar el(los) archivo(s) del receptor a la computadora y
guardarlo(s) en la carpeta seleccionada, sombree el(los)
archivo(s) deseado(s) y haga clic en las flechas dobles

(Figura 5-8).

Se muestra el progreso de la importacion (Figura 5-8).

= Import from Device

Laok i |<2 HIPER - JJ Look i |CJRaw data - J@
&7 1.tps |#]logzona113 S
[ lago101a.tps [#logz04113 & log0101b. tps

B log0225a.kps ﬁ, log010ic.tps
5

N ﬁ,lungDlE‘tps
ﬁ, log0314a.tps

e

B logD304a.tps

|#7 lagnanahtps

B log20041117_51538.tps
[#] lngznns1117_S1710.t0s

E lng20041130_2942.kps Downloading file logl30db.ips

< > Daownloaded 137216 butes of 12003568

Bife Transfer rate is 8071 bytes/sec

|

Figura 5-8. Seleccién del Archivo de Datos Brutos y Visualizacién del Progreso

de la Importacién

Descarga de Archivos a través de
PC-CDU

1.

Conecte su receptor y la computadora. Consulte “Conexién del
Receptor y una Computadora” en la pagina 2-21 para obtener
informacién con respecto a este procedimiento.

Abra PC-CDU. En el cuadro de didlogo Connection Parameters,
habilite RTS/CTS handshaking (negociacion RTS/CTS) y haga
clic en Connect (Figura 5-9).
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Descarga de Archivos a una Computadora

[d Connection Parameters
Connection mode
((-* Direct  Intermet Client © Inteet Server ‘
[ Part setting
Pot: [COM1 > Baudrate: [115200 ] T nfsred pon
]

[ RTS/CTS handshaking

F i

Proaram selting
I™ Fassivemode [~ flanualmode only  Timeout [msf [S00 =

joriginal baud rate on Disconnect

¥ RTS/CTS handshaking o
. I

Passwor: |

™| Display data onjserver. W | Log server everts ™ DNS lookup

Cancel
Figura 5-9. Parametros de Conexién — Negociacion RTS/CTS

3. Haga clic en File » File Manager (Archivo » Administrador de
Archivos), a continuacién haga clic en la pestaiia Download path
(Ruta de descarga) en el cuadro de didlogo File Manager
(Administrador de archivos) (Figura 5-10).

i
Download files 1 Current log file l annln% palhw
Tatal memory: 47348704 bytes Free memony: 47164824 butes

Mame J Size Datﬂ T\maJ

log523a 7196 23032002 B:45%52

log0323h FEVIR Z23.09.2002 26163
log0324a BBET  24.09.2002 G:6261
log0324b 4701 24.09.2002 6259
log0324c 4333 24.09.2002 G5344
lng524d 5190 24.09.2002 35355
log0324s 4676 24.09.2002 36408
logOa24f 4162 24.09.2002 26416

Save to: EATESTINGADATA

‘ I~ Esxclusive mode
Using ICurrent port [COM2) j Block size: |51 2 bptes j
Downloadl Delete | Refresh I Exit |

[

Figura 5-10. Encontrar Archivos para Descargar

4. Busque o cree (con el botén Create) la carpeta en que descargara
y guardard archivos.

5. Haga clic en la pestafia Download files (Descargar archivos) y
seleccione el(los) archivo(s) para descargar (Figura 5-11 de la
pagina 5-8).

Para seleccionar multiples archivos, presione la tecla maytsculas
mientras hace clic en archivos no secuenciales; o presione la tecla
Ctrl y haga clic en archivos individuales.
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x|

Download files | Current log h\el Dawnload pathl

Total memony: 47348784 bytes

Free memony: 47164824 bytes

il
Ing0324c 4933
I

log0324f 4182

Save ta: EATESTINGADATA

g
24.03 2002 35344

24.03.2002

Using: | Curent port (COM2] =} Block size: |512 bytes v

Qﬂwnlnadl Delete | Eelleshl Exit |

[ Exclusive mode

[

Figura 5-11. Descarga de Archivos

6. Haga clic en el botén Download. Durante la descarga, los
indicadores de estado se muestran junto a cada archivo

(Figura 5-12).

* Indicador azul — archivo en cola esperando ser descargado.

* Indicador rojo — el archivo esta descargandose.

* Indicador verde — el archivo se descargé con éxito.

zl
Download files | Curent lag fi\el Download pathl
Total memary: 47346784 bytes Free memory: 47164824 bytes
MName | Size I Date | Time I
® logl323a 75196 23.09.2002 8:49:52
® logl3z3b 7E795  23.03.2002 8:51:63
@ logl324a BEET  24.09.2002 9:62:61
® logl324b 4701 24.03.2002 9:52:59
log0324c: 4933 24.03.2002 9:53:44
log0324d 5150 24.09.2002 9:53:55
log0924e 4676 24.09.2002 9:54:06
log0324f 4162 24.09.2002 9:54:16
Save to: EATESTINGADATA
| Blocks: 28 [ | Exclusive mode
Using: | Curent port [COM2] =) Block size: [512 byles |~
Stop I Delete | Befiesh | Exit |
19% |Download\ng log0923a...

Figura 5-12. Descarga de Archivos — Indicadores de Estado

Manager.

Al terminar, haga clic en Exit en el cuadro de didlogo File

8. Continde con otras operaciones. O haga clic en File » Disconnect
(Archivo » Desconectar), y a continuacion en File » Exit
(Archivo » Salir) para salir de PC-CDU.
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Eliminacion de Archivos de la
Tarjeta SD del Receptor

Siga los siguientes pasos para eliminar archivos de su receptor.

1.

Conecte su receptor y la computadora. Consulte “Conexion del
Receptor y una Computadora” en la pagina 2-21 para obtener
informacién con respecto a este procedimiento.

En el cuadro de didlogo Connection Parameters, habilite RTS/
CTS handshaking (Figura 5-13).

[d Connection Parameters

"Cunmectiun mode ‘

% Direct " Internet Clisnt " Internet Server

[ Port setfing:

Pot: [COM1 > Baudrate: [115200 ] T nfsred pon
]
¥ RTS/CTS handshaking

Program seiting /
I~ Passivemode [~ fhanual mode onlp  Timeout[msk [500 =

joriginal baud rate on Disconnect

¥ RTS/CTS handshaking fees

TR e '—r\r\r\r\ ‘

= " Displayldata on seerin, R Lodse Eneehte EFONE look

Figura 5-13. Pardmetros de Conexién — Negociacion RTS/CTS

Haga clic en File » File Manager y seleccione el(los) archivo(s)
que borrard en la pestafia Download files (Figura 5-14 de la
pagina 5-10).

Para seleccionar varios archivos, mantenga presiona la tecla
mayusculas y después haga clic en los archivos deseados para
seleccionar varios archivos no secuenciales a la vez; o mantenga
presionada la tecla Ctrl y haga clic en archivos individuales.

Haga clic en Delete (Figura 5-14 de la pagina 5-10).

Haga clic en Yes en el cuadro de didlogo para confirmar la
eliminacién de archivos. PC-CDU elimina los archivos
seleccionados.

Haga clic en Exit en la pantalla del Administrador de Archivos.

Contintie con otras operaciones. O haga clic en File » Disconnect
(Archivo » Desconectar), y a continuacién en File » Exit
(Archivo » Salir) para salir de PC-CDU.
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x

Daownload files | Current log Fi\el Diowwriload Dathl

Tatal memory: 47348784 bytes Free memarny: 47164824 bytes

?D1 24.09.2002 35259
4

Save to: EATESTIMGADATA

| I~ Exclusive mode

Using: | Current port [COR 2] 'l Block size: |512 bytes h

ann\nadl DE'E_IE|¥| Eefiesh I Exit |
s

1

Figura 5-14. Eliminacién de Archivos

Gestion de la Memoria del
Receptor

Al usar el receptor en aplicaciones estaticas o dinamicas, es posible
que necesite conocer el nivel de memoria ocupado por el archivo de
registro del receptor. Este tamafio especifico de memoria depende del
tipo de datos que estén grabandose. Utilice las siguientes férmulas
para calcular el tamafio aproximado de los archivos de registro del
receptor. Estas ecuaciones se basan en la serie de mensajes por
defecto.

* SS - el tamafio estimado de una época de datos brutos en el
archivo de registro del receptor (expresado en bytes).

* N — el nimero de satélites observados por época.

Al grabar datos inicamente en L1:
SS =183 + 22*N

Al grabar datos en L1 y L2:
SS =230 + 44*N
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Gestion de las Opciones del
Receptor

El Archivo de Autorizacién de Opciones habilita ciertas funciones,
caracteristicas y opciones en el receptor, tales como las siguientes:

* el tipo de senal (L1, L1/L2, etc.) que procesard el receptor
* la cantidad de datos que el receptor guardard en la memoria
* la velocidad con la que se transmitirdn o recibirdn los datos

Si desea acceder a la lista completa de opciones y detalles
disponibles, sirvase ponerse en contacto con su distribuidor de TPS.

Verificacion del OAF del Receptor

Utilice PC-CDU para ver el estado de las opciones del receptor.

1. Conecte su receptor y la computadora. Consulte “Conexién del
Receptor y una Computadora” en la pagina 2-21 para obtener mas
informacién con respecto a este procedimiento.

2. Haga clic en Tools » Receiver Options (Herramientas »
Opciones del Receptor). El cuadro de didlogo Options Manager
(Figura 5-15 de la pagina 5-12) contiene la siguiente
informacion:

* Option name (Nombre de la opcién) — un nombre/descripcion
de la opcién
* Current (Actual) — el estado actual de la opcidén

* Purchased (Adquirida)— si la opcidn ha sido adquirida o no

Leased (Alquilada)- si la opcidn ha sido alquilada o no

» Expiration date (Fecha de expiracién) — la fecha en que se
deshabilitard la opcién, de ser aplicable
Debido a que las opciones pueden ser adquiridas y alquiladas, el
estado “Actual” de la opcidén muestra el valor efectivo en ese
momento. Los valores de opcidn pueden ser uno de los
siguientes:

e -1 0 “-----" —la version del firmware no soporta esta opcién
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* 0 —la opcién del receptor se encuentra deshabilitada

* positive integer (entero positivo) — la opcidn se encuentra
habilitada

* yes or no (si 0 no) — la opcién se encuentra habilitada o
deshabilitada

3. Al terminar, haga clic en Exit en el cuadro de didlogo Option
Manager, a continuacién haga clic en File » Disconnect para
desconectarse de PC-CDU (y evitar conflictos con la gestién del
puerto serial).

ﬁ, Option Manager - IEI Iil

Option name Current | Purchased |  Leased | Exp. date ||
Toals GPS yes yes no
L GLOMASS yes yes no
Initialize file system ] Ves Ves o
Clear NVRAM (] ves ves ho
Reset receiver Cinderella yes yes no
Position update rate [Hz] 20 20 1]
= options Fiaw data update rate [Hz] 20 20 1]
Code differential Baze yes yes no
Code differential Rover yes yes no
RTK Base yes yes no
RTK Rover [Hz] 20 20 1]
bemory [Mb] TE TE 1]
Co-0p Tracking yes yes no
1-PPS Timing Signal 2 2 o
Ewent barkers 2 2 ]
In-Band Int. Rejection 1 1 1]
Multipath Reduction yes yes no
Frequency [nput yes yes no
Freq. Lock and Output yes yes no
Serial Port A [Kbps] 460 460 1]
Serial Port B [Kbpsg] 460 460 1]
Serial Port C [Kbps] 460 460 1]
Serial Port D [Kbps] 460 460 1]
Infrared Part ho ho ho
Parallel Port e ho ho
Sp.Sp. Freq. Hop. no no
Sp.Sp. Direct no no
Falk yes no
[ratumsz support yes no
Magnetic azimuth yes no

Geoid height yes no —
‘Wway Point Mavigation yes no

WAKS yes yes 8/1/2001

OMMISTAR yes no
RTCH Dutput 2 1]
RTCHM Input 2 1]
ChA Dutput 1 1]
CA Input 2 1]
JPS Output 1] 1]

JPS Input 0 0 LI

Fiefrezh | Load | Stop | Exit |
| y

Figura 5-15. Visualizacioén del Gestor de Opciones

5-12 Manual del Operador del GR-3
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Carga de un OAF

Los distribuidores de Topcon Positioning System ofrecen a sus
clientes los archivos OAF. Si tuviese alguna pregunta en relacién con
los OAFs, envie un mensaje a TPS a options @topconps.com e
incluya el ndmero de ID del receptor (puede ubicar la ID en la parte
inferior del receptor).

1. Para cargar un OAF nuevo, siga los pasos uno y dos de
“Verificacion del OAF del Receptor” en la pagina 5-11.

2. Haga clic en Load (Cargar) en la parte inferior del cuadro de
didlogo Option Manager (consulte la Figura 5-15 en
la pagina 5-12).

3. Vaya ala ubicacién del nuevo Archivo Autorizado de Opciones.
Los OAFs tienen extensiones .jpo o .tpo y son tinicos para cada
receptor (Figura 5-16).

Laok in: | = Local Disk [C:) S« @ o B

| winpows &= uoaf _6_3_turbo.tpo
= apGLOMMzZDYE tpo

[ aPrsowmUTE bpo

=] sqcsHPgvIG-1.tpo

BOCSHPQYIGW bpo

PEYABDIIERK, tpo

|

<

Fiename:  [PaYAADAJGRK tpo
Files of type: |Dpti0ns files [ *tpo; “jpo ] j Cancel

Figura 5-16. Carga de un OAF

4. Seleccione el archivo adecuado y haga clic en Open (Figura 5-
16). La nueva opcién del receptor se carga en el receptor y se
actualiza la tabla Option Manager.

5. Al terminar, haga clic en Exit en el cuadro de didlogo Option
Manager, a continuacién haga clic en File » Disconnect para
evitar conflictos con la gestién del puerto serial.
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Borrado de la NVRAM

La Memoria de Acceso Aleatorio No Volatil (NVRAM) del receptor
conserva los datos que se requieren para rastrear satélites, tales como
efemérides de datos y posicién del receptor. La NVRAM también
conserva las configuraciones actuales del receptor, tales como
informacién de la antena activa, mascaras de elevacion e intervalo de
registro, e informacion sobre el sistema de archivos internos del
receptor.

Si bien cuando borrar la NVRAM no constituye una operacién comun
(ni tampoco se recomienda, por lo general), a veces al borrar la
NVRAM se elimnan problemas de comunicacion o rastreo. Borrar la
NVRAM en su receptor es equivalente a un “arranque suave” en su
computadora.

Después de borrar la NVRAM, su receptor requerird algo de tiempo
para colectar nuevos efemérides y almanaques (aproximadamente 15
minutos).

Al borrar la NVRAM de su receptor no eliminard ningtn archivo que
se encuentre guardado en la memoria de su receptor. Sin embargo, su
receptor volvera a tener los valores establecidos en fabrica.

Ademas, la NVRAM conserva la informacion sobre el sistema de
archivos del receptor. Tenga presente que después de borrar la
NVRAM, el LED de Estado del receptor parpadeara de color
anaranjado durante algunos segundos indicando que el receptor esta
analizando y verificando el sistema de archivos.

Usar la MINTER para borrar la
NVRAM

1. Presione la tecla de encendido para apagar el receptor.
Presione y mantenga presionada la tecla de FUNCION.

3. Presione y mantenga presionada la tecla de encendido durante
aproximadamente un segundo. Suelte la tecla de encendido y
siga presionando la tecla de FUNCION.

4. Espere hasta que los LEDs STAT y REC estén de color verde
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Borrado de la NVRAM

5. Espere hasta que los LEDs STAT y REC parpadeen de color
anaranjado.

6. Suelte la tecla de FUNCION mientras los LEDs STAT y REC
parpadean de color anaranjado.

Usar el PC-CDU para Borrar la
NVRAM

1. Conecte su receptor y la computadora. Consulte “Conexién del
Receptor y una Computadora” en la pagina 2-21 para obtener
informacién con respecto a este procedimiento.

2. Haga clic en Tools » Clear NVRAM (Figura 5-17).

Initialize file system

Reset receiver [ g

Receiver options

Figura 5-17. Borrrado de la NVRAM con PC-CDU

Mientras se borra la NVRAM, el LED REC parpadea de color verde y
rojo y el LED STAT parpadea de color rojo. El receptor se
desconectara automdticamente al terminar de grabar datos.
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Cambio de Modos del Receptor

El receptor presenta tres modos, dos modos de informacién y un
modo de alimentacion:
¢ Normal Mode (Modo Normal) — el modo de levantamiento
estandar.
¢ Extended Information Mode (Modo de Informacién Extendida)—
se utiliza para fines de prueba durante la operaciéon normal.
* Sleep Mode (Modo de espera) — se utiliza para detener la
grabacion de datos, pero mantiene el receptor encendido en
“standby”.

Ingreso al Modo de Informacion
Extendida

El Modo de Informacién Extendida (EIM) se utiliza para probar el
receptor. En este modo, el receptor continda funcionando de manera
habitual, pero el LED STAT indica la siguiente informacién
“extendida” por medio de un delimitador.

El Delimitador es un doble parpadeo facilmente distinguible que
muestra el estado general de las pruebas realizadas en EIM. El color
del LED STAT para el delimitador se calcula a partir de los colores de
otros parpadeos del LED, y cuando las pruebas terminen, serd uno de
los siguientes:
* Anaranjado — al menos un parpadeo es de color anaranjado.
* Rojo - sin parpadeos de color anaranjado y al menos un parpadeo
de color rojo.
* Verde — todos los demads casos.
El doble parpadeo del delimitador es seguido por seis parpadeos del
LED que corresponden a seis pruebas del receptor, donde cada
parpadeo indica la siguiente informacion:
Parpadeo 1. Datos suficientes para el calculo de posicion.
Parpadeo 2. Las relaciones S/N GPS son buenas (Tabla 5-1).

Parpadeo 3. Las relaciones S/N GLONASS son buenas
(Tabla 5-1).
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Parpadeo 4. El desplazamiento de frecuencia del oscilador es de
menos de tres ppm (partes por millén).

Parpadeo 5. La Varianza Allan del Oscilador es de mas de 2.7e-
10 (actualmente, siempre es anaranjado).

Parpadeo 6. El tiempo de rastreo continuo es de més de 15
minutos.

Tabla 5-1. Relaciones “Buenas” Sefial a Ruido (S/N)

CA/L1

P/L1

P/L2

GPS

51

39

39

GLONASS

51

49

40

El color del parpadeo indica que la informacion para la prueba no esta
disponible (anaranjado), el receptor pasé la prueba (verde) o el
receptor fall6 la prueba (rojo).

1.

P/N 7010-0736-SP

Para cambiar a EIM, presione y suelte rdpidamente (dentro de un
segundo) la tecla de FUNCION en la MINTER.

Espere hasta que el delimitador parpadee dos veces. Con un
receptor, antena y condiciones de observacion buenos, todos los
parpadeos deben ser de color verde antes de haber transcurrido 15
minutos de haberse encendido el receptor.

* Verde — ok
* Anaranjado — esperar
* Rojo — algunas pruebas fallaron

Para volver al modo normal, presione la tecla de FUNCION.
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Modo Sleep (en Espera)

En el modo sleep, la tarjeta de alimentacién y el médulo Bluetooth
contindan consumiendo energia de las baterfas, haciendo que, a la
larga, las baterias se descarguen. El modo sleep es el estado
“apagado” normal del receptor.

1. Encienda su receptor.

2. Presione la tecla de encendido del receptor durante mds de cuatro
y menos de ocho segundos. El LED STAT estard de color
anaranjado. El receptor ingresa al Modo Sleep.

3. Cualquier actividad en el puerto RS232 haré que el receptor se
encienda.

Si preciona la tecla de encendido mds de 14

@ segundos, no ocurrird cambio alguno. De esta
manera se protege el receptor en caso de que se
trabe la tecla.

Carga de un Firmware Nuevo

Los receptores Base y Rover deben cargarse con la misma version de
firmware. Utilice la versién de firmware mas reciente (puede
descargarla del sitio web de TPS), asi se asegurara de que su receptor
tenga acceso a las actualizacién mds recientes.

El receptor GR-3 debe cargarse con un firmware
version 3.0 o posterior.

/\ No intente cargar un firmware anterior a la version
PRECAUCION, 3.0
L — b
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Carga de un Firmware Nuevo

La tarjeta del receptor y la tarjeta de alimentacién deben cargarse con
el mismo firmware. El fimware del médulo Bluetooth es
independiente de la tarjeta del receptor y de la tarjeta de alimentacién
y tiene un paquete de firmware diferente.

El receptor FLoader es un utilitario basado en Windows® que se
utiliza para cargar el fimware en la tarjeta del receptor y en la tarjeta
de alimentacién. Usted puede descargar FLoader a su computadora
desde el sitio web de TPS. Si desea obtener més informacion al
respecto, consulte el Manual del Usuario del FLoader, disponible
también en el sitio web de TPS. Consulte “Instalacién de FLoader” en
la pagina 2-6 para instalar FLoader en la computadora.

1. Descargue el paquete de firmware nuevo a su computadora.

2. Conecte su receptor y la computadora. Consulte “Conexion del
Receptor y una Computadora” en la pagina 2-21 para obtener mas
informacién con respecto a este procedimiento.

3. Inicie FLoader.

4. Enla pestafia Connection, seleccione el puerto COM en su
computadora que se conecte con su receptor y seleccione su
velocidad (por lo general, 115200) (Figura 5-18 en
la pagina 5-19).

5. Consulte “Carga del Firmware del Receptor y de la Tarjeta de
Alimentacién” en la pagina 5-20 para cargar el firmware
adecuado.

TPS Firmware Loader: Device = Receiver i =l

File Options Help

Cannection | Device | Program |

Connection Type: Serial Cable

Connection Setting:

PLC Part: IEDM‘I 'l ‘wiord Length: IS 'l
Baud rate: |1152DD 'l Parity: INone 'l
Handzhaking: INone 'l Stop Bits: I‘I 'l

|25 il 200z [16:08.11

Figura 5-18. Pantalla Principal de FLoader
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Carga del Firmware del Receptor y
de la Tarjeta de Alimentacion

El firmware del receptor y de la tarjeta de alimentacion se incluye
como un archivo comprimido que usted descarga y descomprime.
Este archivo contiene los siguientes tres archivos:

* ramimage.ldr — el archivo RAM de la tarjeta del receptor
* main.ldp — el archivo Flash de la tarjeta del Receptor

* powbrd.ldr — el archivo RAM de la tarjeta de alimentacién

Usted debe cargar los tres archivos al cargar su
@ firmware nuevo. Estos archivos deben venir en el

mismo paquete del firmware.

1. En FLoader, haga clic en la pestafia Device (Dispositivo) y defina
el Device Type (Tipo de Dispositivo) como ‘“Receiver”
(Receptor). A continuacién, haga clic en Get from Device para
obtener informacién acerca del dispositivo (Figura 5-19).

TPS Firmware Loader: Device = Heceiver

File Options Help

Connection  Device IProgramI

Device Type: lm
Device Information

tdadel:

1D:

Firmware

Hardware:

FAM Size, KB:

Save to file Cancel I

\ [31 Mar 2003 [17:53.44

Figura 5-19. Configurar el Tipo de Dispositivo

2. Hagaclic en la pestafia Program y configure el Capture Method
(Método de Captura) como “Soft Break Capture” (recomendado)
(Figura 5-20).
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Carga de un Firmware Nuevo

H TPS Firmware Loader: Device = Receiver
File Options Help
Conneclion} Device Program ]
Capture Method: | Soft Break Capture -
Firmware
& BAM File: |E:\FLoadeLF\rmwara\GH3737U\ram|mage.\dr ﬂ Browse R
& Flash fle: | C:\FLoader_FirwarshGR3_3_Thmain dp | BrowseE
LCancel ‘
Ready 08 Jun 2006 |15:57.38

Figura 5-20. Valores de la Pestafia Program

Busque y seleccione el archivo RAM de la tarjeta del receptor y
archivo Flash (Figura 5-20).

Haga clic en Load y espere a que el 100% de los archivos se
cargue en el receptor.

mensaje de error en el margen inferior del cuadro de

@ Si selecciond un archivo incorrecto, aparecerd un
didlogo. Seleccione el archivo correcto.

Haga clic en la pestafia Device y configure el Device Type como
“Receiver’s Power Board” (Tarjeta de Alimentacion del
Receptor). A continuacion haga clic en Get from Device para
obtener informacién con respecto al dispositivo (Figura 5-21).

ETPS Firmware Loader: Device = Receiver's Power Board 0]l

File Optionz Help

Connection  Device IProgramI

Device Type: Receiver's Power Board 'l

Device Information

Firmware
Hardware:

Save tofile Cancel I

[Ready |31 Mar 2003 [17:55.40

Figura 5-21. Configuracion del Tipo de Dispositivo
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Mantenimiento del Receptor y de los Archivos

6.

10.

Haga clic en la pestafia Program y configure el Capture Method
como “Soft Break Capture” (recomendado) (Figura 5-22).

A TS Firmware Loader: Device - Receiver's Power, Board g\i\g|
File Options Help

Ennneclinn} Device Frogram ]

Capture Method: | Soft Break Capturs -

Firmwvare

@ RAM file: |C:\FLoader_FirmwarenGR3_3_04powbrd.dr j Browse B

N N Cancel ‘

08 Jun 2006 |15:53.51

Figura 5-22. Valores de la Pestafia Program

Busque y seleccione el archivo RAM de la tarjeta de alimentacion
(Figura 5-22).

Haga clic en Load y espere hasta que el 100% del archivo de la
tarjeta de alimentacion se cargue en su receptor.

Si selecciond un archivo incorrecto, aparecerd un
@ mensaje de error en el margen inferior del cuadro de

didlogo. Seleccione el archivo correcto.

Haga clic en File » Exit.

Borre la NVRAM (consulte “Borrado de la NVRAM” en la
pagina 5-14) y actualice el almanaque (consulte “Coleccion de
Almanaques y Efemérides” en la pagina 2-28) después de cargar
el firmware nuevo.
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Capitulo 6

Deteccion y Solucion de
Fallas

Este capitulo lo ayudard a detectar y solucionar algunos problemas
comunes que pudieran presentarse al operar su receptor.

m No intente reparar el equipo usted mismo. Si lo
1 hace, invalidard su garantia y podria danar el
hardware.

ADVERTENCIA)

iLea Esta Informacion Primero!

Antes de ponerse en contacto con el servicio de soporte técnico de
Topcon:

» Revise todas las conexiones externas del receptor con mucho
cuidado para asegurarse de que las conexiones sean seguras y
correctas. Verifique si los cables estdn gastados o presentan
defectos.

» Revise todas las fuentes de alimentacién para descartar la
presencia de baterias descargadas o baterias/cables conectados en
forma incorrecta.

* Revise que el sofware mds actualizado se haya descargado a la
computadora y que el firmware mds actualizado se haya cargado
en el receptor. Visite el sitio web de TPS para acceder a las
ultimas actualizaciones.

* Si se conecta via Bluetooth, verifique que el puerto utilizado para
la conexioén se encuentre en el modo Command. Consulte la
pagina 6-11 donde encontrard mas informacion al respecto.
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Deteccion y Solucion de Fallas

A continuacion, pruebe lo siguiente:

* Reinicie el receptor utilizando PC-CDU (Tools » Reset receiver)
(Herramientas » Reiniciar receptor).

» Restablezca las configuraciones por defecto utilizando PC-CDU
(Configuration » Receiver, a continuacién haga clic en Set all
parameters to defaults (Restablecer todos los pardmetros a sus
valores por defecto).

¢ Borre la NVRAM (consulte “Borrado de la NVRAM” en la
pégina 5-14).

* Inicialice el sistema de archivos (haga clic en Tools » Initialize
file system (Herramientas » Inicializar sistema de archivos). De
esta manera, borrara todos los archivos que se encuentran dentro
del receptor.

Si el problema persiste, por favor consulte las siguientes secciones
para encontrar otras soluciones.

Lista Rapida para la Deteccion
y Solucion de Problemas

Para problemas de alimentacién relacionados con el receptor:
Si “El receptor no enciende.” consulte la pagina 6-4.

Si “El receptor no puede establecer una conexién con una
computadora o con un controlador externo.” consulte
la pagina 6-5.

Para problemas relacionados con el receptor:

Si “El receptor no captura los satélites durante un tiempo
prolongado.” consulte la pagina 6-6.

Si “El receptor captura muy pocos satélites.” consulte

la pagina 6-60.

Si “El receptor no puede obtener el Cédigo Diferencial y/o las
soluciones RTK.” consulte la pagina 6-7.

Si “El receptor no inicia el registro de datos.” consulte la
pagina 6-10.
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Lista Rapida para la Deteccion y Solucion de Problemas

Para problemas de conexién relacionados con Bluetooth:
Si “Mensaje de error de BTCONF: Can’t find receiver (No es
posible encontrar el receptor).” consulte la pagina 6-11.
Si “Mensaje de Error de BTCONF: Can’t find Bluetooth (No es
posible encontrar el Bluetooth) .” consulte la pagina 6-12.

Si “Mensaje de error de BTCONF: Open COM# port failed:
Access is denied (No es posible abrir el Puerto COM#: Acceso
denegado).” consulte la pagina 6-13.

Si “Después de buscar dispositivos disponibles, no encuentra
ninguno.” consulte la pagina 6-13.

Si “Puede ver el icono del médulo Bluetooth del receptor en la
pantalla de la computadora, pero no puede conectarse a éste.”
consulte la pagina 6-14.

Para problemas relacionados con el médem:
Si “Modem-TPS no puede conectarse al receptor.” consulte la
pagina 6-15.
Si “Patrén de Parpadeo del LED TX TRX en Condiciones de
Error” consulte la pagina 6-16.
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Deteccion y Solucion de Fallas

Problemas de Alimentacion

Todos los receptores se preconfiguran en fabrica como “Auto Mode”
(Modo Automdtico) para ambas baterias. Para revisar estos valores,
siga el siguiente procedimiento:

1.

Conecte su receptor y la computadora y ejecute el PC-CDU
(consulte “Conexién del Receptor y una Computadora” en la
pagina 2-21).

Una vez conectados, haga clic en Configuration » Receiver.

En la pestafia General, revise los campos Power y Charger. Estos
campos deben configurarse como “Auto”. Si no estuviesen
configurados asi, caimbielos a Auto y haga clic en Apply.

, Al borrar la NVRAM el receptor regresard al modo
P - de alimentacién Auto (consulte “Borrado de la
S NVRAM?” en la pagina 5-14).

El receptor no enciende.

= Las baterfas acoplables pueden haberse acoplado en forma
incorrecta.

* Verifique que las baterias se hayan acoplado en forma
correcta.

* Verifique que los contactos de la bateria que se encuentran en
la parte superior de la bateria acoplable se encuentren limpios
y libres de polvo.
= Las baterfas podrian haberse descargado.

* Conecte/acople una bateria totalmente cargada y reintente.
Consulte “Alimentacion del Receptor” en la pdgina 2-15.

» Cargue las baterias durante la noche. Consulte “Alimentacién
del Receptor” en la pagina 2-15.

= Si utiliza una fuente de alimentacién externa, el cable podria
estar desconectado o dafiado.

Verifique que el cable esté conectado correctamente y que no
presente dafios.
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Problemas del Receptor

= Es posible que el cargador o las baterfas del receptor estén
defectuosos.

Si, después de cambiar las baterias o conectar una fuente de
alimentacion externa, el receptor no se enciende, péngase en
contacto con el Servicio de Soporte al Cliente de TPS para
solicitar mds informacién.

Problemas del Receptor

Los siguientes son algunos de los problemas mds comunes que puede
presentar el receptor.

El receptor no puede establecer una conexién con una
computadora o con un controlador externo.

Problemas especificos relacionados con los cables:

= El cable no estd enchufado correctamente.

* Verifique el conector del cable se encuentre conectado al
puerto correcto del receptor.

* Desenchufe el cable, luego vuelva a conectarlo
correctamente al receptor.

* Consulte “Receptor GR-3” en la pagina 1-11y
“Especificaciones de los Conectores” en la pagina A-13
donde encontrard informacién acerca de los conectores del
receptor.

= El cable estd dafiado.

Utilice un cable en buen estado. Péngase en contacto con su
Distribuidor para cambiar el cable.

Problemas genéricos:

= El puerto del receptor que se utiliza para la conexién no se
encuentra en el modo Command.

1. Conecte su receptor y una computadora utilizando un
puerto libre (consulte “Conexidn del Receptor y una
Computadora” en la pagina 2-21) e inicie PC-CDU.

P/N 7010-0736-SP 6-5



Deteccion y Solucion de Fallas

Haga clic en Configuration » Receiver » Ports.

3. Cambie la Input (Entrada) para el puerto utilizado para la
conexioén a “Command”.

El receptor no captura los satélites durante un tiempo
prolongado.

= El receptor guarda un almanaque antiguo.

Actualice el almanaque. Consulte “Coleccién de Almanaques
y Efemérides” en la pdgina 2-28 para obtener més
informacién al respecto.

= Las opciones correspondientes del receptor podrian encontrarse
deshabilitadas o haber expirado (L1/L2, GPS/GLONASS deben
estar en el modo de captura de satélites).

* Consulte “Gestién de las Opciones del Receptor” en la
pagina 5-11 donde encontrard informacién detallada acerca
de como habilitar opciones actuales.

* Ordene un OAF nuevo con las opciones deseadas activadas
para habilitar o ampliar la validez de las opciones
correspondientes del receptor. Péngase en contacto con su
distribuidor o visite el sitio web de TPS donde encontrara
mads informacién al respecto

* Consulte el Manual de Referencia de PC-CDU donde
encontrard una descripcion detallada de las opciones.

El receptor captura muy pocos satélites.

= El valor de la mascara de elevacién es demasiado alto (por
encima de 15 grados).
Disminuya el valor de la médscara de elevacién. Consulte la
pégina 3-16 para obtener informacién con respecto a la
configuracion de la méscara de elevacion.
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Problemas del Receptor

= El levantamiento se efectiia cerca de construcciones (copa de
arboles, edificios altos, etc.).

* Verifique que las casillas de reduccion del efecto multipath
se encuentren habilitadas.

1. Conecte su receptor y una computadora e inicie
PC-CDU. Consulte “Conexion del Receptor y una
Computadora” en la pagina 2-21.

2. Haga clic en Configuration » Advanced y en la
pestaiia Multipath Reduction. Habilite las dos casillas
y haga clic en Apply.

» Ubique un drea libre de obstaculos, en caso de ser posible.

El receptor no puede obtener el Codigo Diferencial y/o las
soluciones RTK.

> Se ingresaron coordenadas incorrectas en la base.

Especifique las coordenadas correctas para la estacién Base
utilizando PC-CDU u otro software de coleccion de datos en
campo adecuado.

= El receptor no se configuré como Base o como Rover.

* Si el receptor debe funcionar como Base, asegurese de que
se haya configurado correctamente. Consulte el Capitulo 3
para obtener mds informacién al respecto.

* Si el receptor debe funcionar como Rover, asegurese de que

se haya configurado correctamente. Consulte el Capitulo 3
para obtener mds informacion al respecto.

5> Las opciones correspondientes del receptor pueden estar
desactivadas o haber expirado.

* Consulte “Gestion de las Opciones del Receptor” en la
pagina 5-11 para obtener mds informacién acerca de como
habilitar las opciones actuales.

* Ordene un OAF nuevo con las opciones deseadas activdas
para habilitar o amplair la validez de las opciones
correspondientes del receptor. Pdngase en contacto con su
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Deteccion y Solucion de Fallas

distribuidor o visite el sitio web de TPS donde encontrard
mads informacién al respecto.

* Consulte el Manual de Referencia de PC-CDU para
obtener una descripcion detallada de las opciones.

=> No existen suficientes satélites comunes. Para obtener una
solucion fija, Base y Rover deben rastrear, por lo menos, cinco
satélites comunes.

* Asegurese de que los receptores tanto Rover como Base
utilicen el mismo almanaque actualizado. Consulte
“Coleccién de Almanaques y Efemérides” en
la pagina 2-28.

* Verifique que las méscaras de elevacién de los receptores
Rover y Base; deben ser las mismas. Consulte
la pagina 3-16 donde encontrard informacién con respecto
a la configuracion de la méscara de elevacion.

= Existe una incompatibilidad entre los estdndares diferenciales
utilizados en los receptores Base y Rover.

Asegurese de que los receptores Base y Rover utilicen el

mismo formato de correcciones de entrada/salida:

1. Conecte su receptor y una computadora e inicie
PC-CDU. Consulte “Conexién del Receptor y una
Computadora” en la pagina 2-21.

2. Haga clic en Configuration » Receiver y en la pestafia
Ports. Utilice el mismo formato de entrada/salida para
ambos receptores.

5> Geometria satelital deficiente (valores PDOP/GDOP
demasiado altos).

Efectie el levantamiento cuando los valores PDOP sean
bajos.
= El valor de la mascara de elevacién es demasiado alto (por
encima de los 15 grados).

Disminuya el valor de la mascara de elevacion. Consulte la
pagina la pagina 3-16 donde encontrara informacién con
respecto a la configuracién de la méscara de elevacion.
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Problemas del Receptor

= La baterfa del médem est4 baja.

» Conecte una fuente externa de energia al receptor. Consulte
“Con una Fuente de Alimentacion Auxiliar” en
la pagina 2-18.

* Consulte “Alimentacion del Receptor” en la pagina 2-15
para obtener mds informacion al respecto.

5 La antena de transmisién y/o recepcién podria haberse
conectado en forma incorrecta.

* Verifique que la antena del radio médem se encuentre
firmemente asegurada y correctamente acoplada al
conector de la antena.

* Verifique que la antena del radio médem no se encuentre
dafiada. Si se encuentra dafiada, péngase en contacto con su
distribuidor de TPS para cambiar la antena.

= La velocidad especifica de transferencia en baudios es
incompatible con las velocidades en baudios soportadas por el
mddem.
La velocidad de transferencia en baudios es la velocidad a la
que el receptor transmite mensajes diferenciales al médem y
viceversa.

Cambie la velocidad en baudios por la velocidad que su
moédem soporta. Consulte el manual del médem donde
encontrard informacién al respecto.

5 Los médems Base y Rover utilizan diferentes pardmetros de
radioenlace.

Configure los médems de los radios de la Base y el Rover de
acuerdo con los procedimientos que se enumeran en la
seccién correspondiente.

* Si desea obtener mas informacién con respecto al médem
FH915+, consulte “Configuracién de un Médem de
Espectro Ensanchado” en la pdgina 3-4.

* Si desea obtener mas informacién con respecto a un
médem GSM, consulte “Configuracion de un Radio
Moédem GSM” en la pagina 3-8.
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Deteccion y Solucion de Fallas

= La distancia entre la Base y el Rover es demasiado grande.
* Acorte la distancia entre la Base y el Rover.

» Utilice repetidoras para mejorar la cobertura del radio.

= Podria existir una fuente de interferencia radial que interrumpa
las comunicaciones radiales.

* Cambie el canal de RF (si fuese posible).

» Utilice un analizador de espectro para detectar las
caracteristicas radiales de la sefial que genera interferencia
y cambia la configuracién de sus sistema como
corresponda.

* Elimine la fuente de sefial de interferencia o reubique sus
antenas de radio (si fuese posible).

El receptor no inicia el registro de datos.

= El receptor no tiene instalada la tarjeta SD o la opcién de
memoria se encuentra deshabilitada o ha expirado.

* Verifique que la tarjeta se encuentre insertada
correctamente. Si desea obtener mds informacion al
respecto, consulte “Para instalar la tarjeta SD” en la
pagina 2-8.

* Verifique que la opcién de memoria se encuentre
habilitada. Para obtener mas informacién al respecto,
consulte “Verificacién del OAF del Receptor” en la
pagina 5-11.

= La tarjeta de memoria del receptor no tiene espacio libre.

* Descargue y/o elimine archivos de datos para liberar
espacio para nuevos archivos (consulte “Descarga de
Archivos a una Computadora” en la pagina 5-2 y
“Eliminacion de Archivos de la Tarjeta SD del Receptor”
en la pagina 5-9).

* Utilice la funcién AFRM. Consulte “Pardmetros del Modo
de Rotacién Automatica de Archivos (AFMR)” en la
pagina 3-24.
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Problemas con Bluetooth

Problemas con Bluetooth

Los siguientes son algunos de los mensajes de error y otros problemas
maés frecuentes.

Mensaje de error de BTCONF: Can't find receiver (No es posible
encontrar el receptor).
= El receptor est4 apagado.
Asegtrese de que el receptor se encuentre cargado y
encendido.

=> Si utiliza un cable, los conectores del cable no se han conectado
correctamente.

* Verifique que el conector del cable se encuentre conectado
al puerto serial correcto.

* Desenchufe el cable, luego vuelva a conectarlo
correctamente al receptor.
= Si utiliza un cable, éste se encuentra dafiado.
» Utilice un cable en buen estado.
* Péngase en contacto con su distribuidor de TPS para

adquirir un cable nuevo.

= El puerto COM al que estd conectado el receptor es diferente al
seleccionado en BTCONF.

» Asegurese de que el cable RS232 esté conectado al puerto
COM especificado en la lista de puertos de comunicacién
de BTCONF.

* Consulte “Configuracion del Médulo Bluetooth” en la
pagina 2-24 para obtener mds informacién al respecto.

= El puerto del receptor utilizado para la conexién no estd en el
modo Command.

1. Conecte su receptor y una computadora a través de un
puerto libre (consulte “Conexién del Receptor y una
Computadora” en la pagina 2-21) e inicie PC-CDU.

2. Haga clic en Configuration » Receiver » Ports.
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3. Cambie la Input (Entrada) para el puerto serial utilizado
paa la conexién a “Command”.

Esta es la causa mds comun para este mensaje de
~ crror. Utilice PC-CDU para volver a verificar los
RECOMENDACION) .,
= valores del puerto de conexion.

= Las configuraciones para el Puerto D podrian haber cambiado.

* Las configuraciones para el Puerto D son: velocidad de
transferencia en baudios de 115200, 8 bits de datos, 1 bit de
parada, sin paridad y sin negociacion.

* Intente habilitar la negociaciéon RTS/CTS para el puerto D.
No cambie las demas configuraciones.

= Las opciones correspondientes del receptor podrian estar
deshabilitadas o haber expirado (el puerto serial D debe estar
habilitado).

* Consulte “Gestion de las Opciones del Receptor” en la
pagina 5-11 para obtener mds informacién con respecto a
como habilitar las opciones actuales.

* Ordene un OAF nuevo con las opciones deseadas activadas
para habilitar o ampliar la validez de las opciones
correspondientes del receptor. PGngase en contacto con su
distribuidor o visite el sitio web de TPS donde encontrard
mds informacién al respecto

* Consulte el Manual de Referencia de PC-CDU donde
entorard una descripcion detallada de opciones.

Mensaje de Error de BTCONF: Can’t find Bluetooth (No es
posible encontrar el Bluetooth) .

& La Ranura2(C) del receptor se encuentra desactivada.

1. Consulte “Establecimiento de una Conexién con un
Cable RS232” en la pdgina 2-23 para conectar la
computadora y el receptor.

2. Haga clic en Configuration » Receiver » General.
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Problemas con Bluetooth

3. En el area Turn on/off Slots, habilite la casilla de
habilitacién de la Ranura 2(C).
= El médulo Bluetooth se encuentra vinculado a otro dispositivo.
Cierre la conexién con el dispostivo, y luego conéctelo a su
receptor.
= El receptor no tiene un médulo Bluetooth.

* Continte con otras funciones de configuracion/
levantamiento con un cable serial o USB.

* Pdngase en contacto con su proveedor para adquirir un
receptor con Bluetooth habilitado.

Mensaje de error de BTCONF: Open COM# port failed: Access is
denied (No es posible abrir el Puerto COM#: Acceso denegado).

5 Es posible que otra aplicacion se encuentre utilizando el puerto
de la computadora dedicado a la conexidn.
* Cierre la aplicacion, e intente conectarse.
» Conecte el receptor utilizando otro puerto de la

computadora que no se encuentre en uso.

Después de buscar dispositivos disponibles, no encuentra
ninguno.

5 El receptor no esté recibiendo energia.

* Verifique que el receptor esté alimentandose y se encuentre
encendido.

* Verifique que el cable de alimentacién se encuentre
conectado al puerto marcado “PWR”.

* Desenchufe el cable, luego vuelva a conectarlo
correctamente al receptor.

¢ Si el cable de alimentacidn se encuentra dafiado,
comuniquese con su Distribuidor para adquirir un cable
nuevo.
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= La Ranura 2(C) del receptor se encuentra desactivada.

1. Conecte su receptor y una computadora utilizando un
cable RS232 (consulte “Establecimiento de una
Conexién con un Cable RS232” en la pagina 2-23).

Haga clic en Configuration » Receiver » General.

3. Enel area Turn on/off Slots, habilite la casilla de la
Ranura 2(C).

Puede ver el icono del modulo Bluetooth del receptor en la
pantalla de la computadora, pero no puede conectarse a éste.

= Las configuraciones de seguridad del dispositivo
probablemente sean diferentes.

* Asegurese de que sus dispositivos habilitados en Bluetooth
utilicen las mismas configuraciones de seguridad.
* Consulte “Configuracion del Médulo Bluetooth” en la
pagina 2-24, especificamente la Figure 2-23 en
la pagina 2-27 para obtener mds informacion con respecto
al cambio de configuraciones de seguridad.
= Las configuraciones del médulo Bluetooth podrian haber
cambiado.
1. Si cambi6 las configuraciones de su médulo Bluetooth,
eliminelo de la lista de dispositivos Bluetooth
encontrados con el programa administrador de Bluetooth

(incluido con el dispositivo utilizado para administrar el
receptor).

2. Repita la bisqueda.
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Problemas relacionados con Modem-TPS

Problemas relacionados con
Modem-TPS

El siguiente es el problema relacionado con Modem-TPS que se
encuentra con mayor frecuencia.

Modem-TPS no puede conectarse al receptor.

= El receptor estd apagado.

Asegtrese de que el receptor se encuentre cargado y
encendido.

=> Si utiliza un cable, los conectores del cable no se han conectado
correctamente.
* Verifique que el conector del cable se encuentre conectado
al puerto serial correcto.

* Desenchufe el cable, luego vuelva a conectarlo
correctamente al receptor.

=> Si utiliza un cable, éste se encuentra dafiado.
e Utilice un cable en buen estado.
* Péngase en contacto con su Distribuidor para adquirir un

cable nuevo.

> Si utiliza la tecnologia inaldmbrica Bluetooth, seleccion6 un
puerto incorrecto, o el receptor o la computadora no soporta
Bluetooth.

* Utilice una computadora o un receptor que tenga
habilitada/instalada la tecnologia inaldmbrica Bluetooth.

* Verifique que la computadora y el receptor utilicen los
puertos de comunicacion correctos. Para el receptor GR-3,
es el puerto A.

5> Las opciones correspondientes del médem pueden estar
desactivdas o haber expirado.

* Consulte “Gestion de las Opciones del Receptor” en la
pagina 5-11 para obtener mds informacién con respecto a
como verificar las opciones actuales.

P/N 7010-0736-SP 6-15



Deteccion y Solucion de Fallas

* Ordene un OAF nuevo con las opciones deseadas activadas
para habilitar o ampliar la validez de las opciones
correspondientes del receptor. Pdngase en contacto con su
distribuidor o visite el sitio web de TPS donde encontrara
mads informacién al respecto.

* Consulte el Manual de Referencia de PC-CDU donde
encontrard una descripcion detallada de las opciones.

& El tipo de radio médem se encuentra deshabilitado para
deteccion utilizando Modem-TPS.

1. De ser necesario, haga clic en Cancel en el cuadro de
didlogo Connection o en Stop en el cuadro de didlogo
Connecting to device.

En Modem-TPS, haga clic en Tools » Options.

3. Habilite el tipo de médem instalado en el receptor y
conectado a la computadora. Haga clic en Ok.

4. Haga clic en File » Connect.

Patron de Parpadeo del LED TX
TRX en Condiciones de Error

Para mddems internos FH915+: el LED TX RX parpadea de
color.

= Se ha detectado una condicién de falla.

* Verifique que la antena del radio médem no se encuentre
dafiada. Pongase en contacto con su distribuidor para
cambiar la antena.

* Verifique que la antena del radio médem se encuentre
firmemente asegurada y correctamente acoplada al
conector de la antena.

* Aleje la antena/receptor de objetos conductores (objetos
metélicos grandes, por ejemplo).
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Patrén de Parpadeo del LED TX TRX en Condiciones de Error

> El cable est4 dafiado.
» Utilice un cable en buen estado.
* Pdngase en contacto con su Distribuidor para cambiar el

cable.

Para médems GSM internos: el LED TX RX parpadea de color
anaranjado.

= El Rover utiliza el cédigo PIN incorrecto, o no se seleccioné
ningtn cédigo PIN.
1. En TopSURY, haga clic en Job » Config b Survey.

2. Haga clic en el botén “...” (continue) (continuar) y
presione Next para examinar la pantalla de configuracién
Rover Radio.

3. Presione Configure GSM.
4. Seleccione el PIN de la Estacién Base y presione OK.

= Se produjo un error durante la inicializacion.

* Verifique que la antena del radio médem no se encuentre
dafiada. Péngase en contacto con su distribuidor para
cambiar la antena.

* Verifique que la antena del radio médem se encuentre
firmemente asegurada y correctamente conectada a la
antena en el radomo.

P/N 7010-0736-SP 6-17



Deteccion y Solucion de Fallas

Como Obtener Soporte Técnico

Si los consejos y recomendaciones para detectar y solucionar fallas no
resuelven su problema, sirvase ponerse en contacto con el Servicio al
Cliente de TPS.

Antes de ponerse en contacto con el Servicio de Atencién al Cliente
de TPS por problemas con su receptor, consulte “;Lea Esta
Informacién Primero!” en la pagina 6-1 donde encontrard soluciones
que podrian resolver su problema.

Teléfono

Si desea ponese en contacto con el Servicio de Soporte al Cliente de
TPS, llame a:

1-866-4TOPCON (1-866-486-7266)
de lunes a viernes
7:00am a 5:00pm, hora del Pacifico

Correo electronico

Si desea ponerse en contacto con el Servicio de Soporte al Cliente via
correo electrénico, utilice una de las siguientes direcciones de correo
electrénico (Tabla 6-1).

Tabla 6-1. Correos Electrénicos del Departamento de Soporte Técnico

Para Preguntas relacionadas con... Escriba a...
Hardware (recepotres, antenas, firmware) hardware @topcon.com
GPS+y 3DMC psg@topcon.com
OAF options @topcon.com
RTK rtk @topcon.com
PC-CDU pccdu@topcon.com
En caso de duda... support@topcon.com

Para brindarle un soporte rdpido y eficaz,
QEIEID proporcione una descripcion detallada del problema.
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Coémo Obtener Soporte Técnico

Cuando envie un mensaje al servicio de soporte al cliente de TPS,
proporciona la siguiente informacién que nos permitird ofrecerle una
mejor y mas rapido servicio:

1. El modelo del receptor y los valores de configuracion.

En PC-CDU, haga clic en Help » About y a continuacién, haga
clic en Save to file. Ingrese un nombre para el archivo y guéardelo
en su computadora. Adjunte este archivo a su mensaje.

2. Las especificaciones del sistema/hardware de la computadora en
la que se ejecuta PC-CDU; tales como sistema operativo y
versién, memoria y capacidad de almacenamiento, velocidad del
procesador, etc.

3. Los sintomas y/o cédigos/mensajes de error que aparecieron
antes y después de ocurrir el problema.

4. Los procedimientos que se intentaron cuando ocurri6 el
problema. Si fuese posible, incluya los pasos exactos que se
siguieron cuando ocurri6 el mensaje de error u otro problema.

5. Con cudnta regularidad ocurre el problema.
Por lo general, un representante del servicio de soporte al cliente le

responderd en un lapso de 24 horas, dependiendo de la severidad del
problema.

Sitio web

El sitio web de Topcon Positioning Systems le ofrece informacion
actualizada con respecto a la linea de productos de Topcon. El 4rea de
soporte del sitio web le proporciona acceso a diversas secciones tales
como preguntas mas frecuentes, procedimientos de configuracion,
manuales, soporte via correo electrénico, etc.

Para acceder al sitio web de TPS, vaya a:

WWwWw.topconpositioning.com
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Deteccion y Solucion de Fallas

Notas:
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Anexo A

Especificaciones

Este producto de TPS es un receptor GNSS de 72 canales con un
radio médem interno, un médulo habilitado con la tecnologia
inaldmbrica Bluetooth y una carcasa de magnesio resistente. Ademas,
incluye la MINTER y conectores para cable.

Las especificaciones de desempefio asumen un
@ nimero minimo de 6 satélites GPS a una elevacién
de més de 15 grados y el cumplimiento de los

procedimientos recomedandos en el presente
manual.

En aquellas areas con alto multipath, durante
@ periodos con una gran PDOP (Dilucién de Precisiéon
de la Posicion) asi como durante periodos de mayor

actividad ionosférica, el desempefio del equipo
podria verse afectado.

Utilice procedimientos de verificacion estrictos en
areas con multipath extremo o en caso de follaje
espeso.

®
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Especificaciones

Especificaciones del Receptor

Las siguientes secciones proporcionan especificaciones para el
receptor y sus componentes externos.

Detalles Generales
La Tabla A-1 enumera las especificaciones generales del receptor.

Tabla A-1. Especificaciones Generales del Receptor

Caracteristicas fisicas

Carcasa De magnesio, Extrusién IPX 6, a prueba de lluvia
Color Amarillo Topcon y Gris Topcon
Dimensiones Ancho:156.6 x Alto:234.5 x Profundidad:156.6 mm
Peso 1.78 Kg.
Antena Interna
Bateria Dos externas, desmontables
Controlador Externo
Montaje 5/8-11, dispositivo de desconexién rapida
Sellos Silicio (moldeado en color)
Teclas Dos teclas:
Encendido/Apagado
Funcién — iniciar/detener el registro de datos, cambiar
modo de informacion.
LEDs Seis LEDs:
STAT - estado de satélites y del receptor
REC - estado de grabacion y de datos
RX TX — estado del médem
BT — Estado de conexidn de la tecnologia inaldmbrica
Bluetooth
BATT x 2 — Estado de la bateria
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Especificaciones del Receptor

Tabla A-1. Especificaciones Generales del Receptor (Continuacién)

Medio Ambiente

Temperatura de
operacién

-20 C° a +50 C° con baterias

Temperatura de
almacenamiento

-20 C° a +35 C° con baterias
-40 C° a +75 C° sin baterias

Humedad

95%

Alimentacion

Baterias externas

Litio-ion, 3900 mAh, 7.2 V; 2 baterias, desmontables

Tamafo de las
baterias

132 x 52 x 25 (mm)

Peso de las bateriast

165 g (1 bateria)

Tiempo de
Operacion

Promedio con
Bluetooth
“activado”y 12 SVs
rastreados.

Con baterias nueas
y operando a

* Moddem = apagado — aproximadamente 16 horas

* 915 médem en el modo de sélo recepcion —
aproximadamente 13 horas

* 915 médem en el modo de trasmision a 250 mW —
aproximadamente 11 horas

¢ 915 mdédem en el modo de trasmision a 1 W —
aproximadamente 9 horas

* Baterfas AA insertadas en ambas ranuras para baterias
y médem apagado - aproximadamente 2.5 horas

« Areas urbanas con distancia corta a celdas y GSM/

temperatura

ambiente. GPRS encendido - aproximadamente 12 horas de
servicio continuo

Alimentacién 1 puerto

externa

Tension de entrada

9 a 21V CC (para trabajo)
10 a 21 V CC (para cargar baterias)
Corriente Maxima de Carga <=2 Amperios
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Especificaciones

Tabla A-1. Especificaciones Generales del Receptor (Continuacién)

Consumo ¢ Moddem = apagado — aproximadamente 3.5 W
¢ 915 médem en el modo de sélo recepcion —

Promedio con aproximadamente 4.4 W

Bluetooth

* 915 médem en el modo de trasmisién a 250 mW —

“activa((iio” y125Vs aproximadamente 5.0 W
t .
rastreados * 915 médem en el modo de trasmisién a 1 W —
aproximadamente 6 W
« Areas urbanas con distancia corta a celdas y GSM/
GPRS encendido - aproximadamente 4.2 W
Carga de bateria Conecte el adaptador de CA para cargar la bateria interna.
Carga operativa disponible si se conecta a una bateria
externa.
Tiempo de carga ~6 horas para una carga completa
Baterfa integrada Baterfa de repuesto para guardar fecha y hora y datos de

almanaque, tiempo de operacién minimo: 10 afios

/0 (Entrada/Salida)

Puertos de Un puerto serial RS232 de alta velocidad (con borde
Comunicacién negro), un puerto USB (con borde amarillo) y un puerto
de comunicaciones Bluetooth interno (puerto D).

Especificaciones de | Puerto Serial RS232
los Puertos Velocidad de transferencia en baudios:
460800,230400,115200 (Por defecto),57600,
38400,19200,9600,4800,2400,1200,600, 300
Control de flujo: RTS/CTS
Longitud: 7,8 (por defecto)
Bit de parada: 1 (por defecto), 2
Paridad: Sin paridad (por defecto), Impar, Par
Puerto Bluetooth
Disponible
Puerto USB
Versién 1.1

Conectores Antena del médem (BNC o TNC de polaridad invertida
dependiendo del tipo de médem), PWR (alimentacién),
Puerto Serial RS232, USB

A-4 Manual del Operador del GR-3



Especificaciones del Receptor

Tabla A-1. Especificaciones Generales del Receptor (Continuacién)

MINTER Seis LEDs externos (consulte “LEDs” en la pagina A-2
donde encontrard mas informacidn al respecto)
Entrada de control ON/OFF (botén de encendido/
apagado)

Control de registro de datos (botén de FUNCION)

Caracteristicas de los Datos

Velocidad de actualizacién de hasta 20 Hz para
posicionamiento y datos brutos en tiempo real (c6digo y
portadora)

Fase de c6digo de 10 cm y precision de la portadora de
0.1lmm

RTCM SC104 versién 2.1, 2.2, 2.3,y 3.0 /0

RTCM Base Muiltiple

Modelos Geoidales y de Variacién Magnética

RAIM

Soporta diferentes DATUMs

Salida de coordenadas de cuadricula

Soporta CMR y CMR+
Tecnologia

Mitigacién avanzada Multipath

WAAS

Pardmetros ajustables PLL y DLL
NMEA

Version de NMEA Salida Ver. 2.1, 2.2,2.3,3.0

Mensajes GGA, GLL, GNS, GRS, GSA, GST, GSV, HDT, RMC,
VTG, ZDA, ROT, GMP

Intervalo de salida 1Hz estdndar; 5, 10, 20Hz opcionall

DGPS

Formato de RTCM SC104 Ver 2.1,2.2,2.3y 3.0
correccion

Tipo de mensajes 1, 3,9, 31, 32, 34; seeleccionable por el usuario
RTCM

Intervalo de 1Hz estandar; 5, 10, 20Hz opcional
procesamiento
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Especificaciones

Tabla A-1. Especificaciones Generales del Receptor (Continuacién)

Intervalo de salida
para los datos de
correccion RTCM

1Hz estandar; 5, 10, 20Hz opcional

Mascara de
elevacion

0 a 90 grados (independiente del registro de datos)

DGPS multibase

Modo de seleccién de correccion diferencial: Mas
cercano, Mixto, Mejor (opcional)

RTK
Formato de CMR2/CMR+ (Compatible con Trimble), RTCM SC104
correccion Ver2.2,2363.0

Tipo de mensaje
RTCM

3, 18, 19, 20, 21, 22; seleccionable por el usuario

Inicializacion de

OTF (L1, L1/L2)

ambigiiedad

Longitud de la Hasta 50 Km. en la mafiana y tarde.

Linea de Base Hasta 32km al mediodia.

Tiempo de De 5 segundos a 10 minutos dependiendo de la longitud
inicializacion de la linea de base y de las condiciones multipath

Intervalo de salida
para CMR/RTCM

1Hz estandar; 5, 10, 20Hz opcional

Elevacion

0 a 90 grados (independiente del registro de datos)

Modo de solucién

Retardo (sincronizacién)
Extrapolacién (sin sincronizacién)

Intervalo de
procesamiento

1Hz estandar; 5, 10, 20Hz opcional

Latencia

Modo de retardo — 20 mseg a 20 seg (dependiendo de la
latencia que recibe datos de correccién del receptor base)
Extrapolacién — 20 a 30 mseg

Registro de datos
brutos

El receptor puede grabar datos brutos con otro intervalo
durante la operaciéon RTK

Estado

Fijo, Flotante, DOP, Estado del Enlace de Datos, Latencia
del Mdédem, Satélites Comunes, Porcentaje de Fijacién
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Especificaciones del Receptor

Tabla A-1. Especificaciones Generales del Receptor (Continuacién)

Resultados

Coordenadas RTK, HRMS, VRMS, Matriz de Covarianza

Nivel de fijacion de
ambigiiedad

Umbrales seleccionables
Bajo: 95%; Medio: 99.5%; Alto: 99.9%

Modos de Levantal

miento

Base o Rover

Estético

Cinematico (Stop and Go)

RTK (Cinematico en tiempo real)
DGPS (GPS diferencial)
WASS/EGNOS DGPS

Precision del Levantamiento

Estatico, Estatico
Répido

Para L1+L2 — H: 3mm + 0.5ppm (x longitud de la linea de
base);
V: 5Smm + 0.5ppm (x longitud de la linea de
base)

Cinematico, RTK

Para L1+ L2, L1 — H: 10mm + 1.0ppm (x longitud de la
linea de base);
V: 15mm + 1.0ppm (x longitud de la
linea de base)

DGPS

Post-proceso: menos de 0.25 m (HRMS)
Basado en DGPS/RTCM: menos de 0.25 m (HRMS)

Arranque en Frio
Arranque en
Caliente

Readquisicién

<60 seg
<10 seg
<1seg
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Especificaciones

Detalles de la Tarjeta GPS

La Tabla A-2 enumera las especificaciones generales de la tarjeta

GPS.

Tabla A-2. Especificaciones de la Tarjeta GPS

Tipo de Receptor (configurado al activar el OAF adecuado)

Tarjeta interna:
GR-3

GPS: L1 (C/A & P),L2,L2C, L5
GLONASS: L1, L2 (tanto c6digo como fase)
GALILEO: E2-L1-El, E5a

Tipo de hardware:
pais/regién/de
acuerdo con el
proposito

con FH915+ TX/RX/RP
con FH915+ TX/RX/RP + GSM

Especificaciones de Captura

Canales Estandar

72 canales universales (G, GG, GD, GGD)

Opcional

Dias Cenicienta (consulte la pagina A-9 donde encontrard
mas informacion al respecto)

Sefiales Capturadas

GPS/GLONASS, L1/L2 C/A, LS, GALILEO y Cédigo P
y Portadora, WAAS/EGNOS

Funciones de Captura

Reduccién del Cédigo y Portadora

efecto Multipath

Configuracién PLL/ | Ancho de banda, orden, ajustable
DLL

Intervalo de Cédigo y Portadora

suavizado

WAAS/EGNOS WAAS opcional; EGNOS opcional

Caracteristicas de

los Datos

Formatos

TPS, NMEA, RTCM, CMR, BINEX
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Especificaciones del Receptor

Tabla A-2. Especificaciones de la Tarjeta GPS (Continuacion)

Caracteristicas

Velocidad de actualizacién de hasta 20 Hz para
posicionamiento y datos brutos en tiempo real (c6digo y
portadora)

Fase de codigo de 10 cm y precision de la portadora de
0.1mm

RTCM SC104 versién 2.1, 2.2, 2.3,y 3.0 I/O

RTCM Base Muiltiple

Modelos Geoidales y de Variacién Magnética

RAIM

Soporta diferentes DATUMs

Caracteristicas
(continuacidn)

Salida de coordenadas de cuadricula
Soporta CMR y CMR+

Memoria

Memoria Interna

Tarjeta SD (datos seguros), extraible

Capacidad

Depende de la capacidad de la tarjeta SD(MMC
instalada®, actualmente hasta 1 GB

Tiempo de Registro

53 horas (8 MB, 15 segundos, L1/L2, 7 satélites)

Intervalo de registro

0.05 a 86400 segundos, dependiendo de las opciones
adquiridas

a. SD = Digital Segura; MMC = Tarjeta multimedia

Los dias Cenicienta son una opcién que convierte una frecuencia
simple (receptor GPS) en una frecuencia doble (receptor GPS +
GLONASS) durante 24 horas cada dos martes a la medianoche GPS.
Consulte el sitio web de Topcon para obtener mas informacion al
respecto asi como las fechas Cenicienta especificas.
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Especificaciones

Detalles del Modulo Bluetooth

La Tabla A-3 enumera las especificaciones generales de la tecnologia
inaldmbrica Bluetooth.

Tabla A-3. Especificaciones del M6dulo Bluetooth

Rango hasta 10 m (interiores); hasta 50 m(exteriores)
Tipo Clase 2
Clases de servicio Varias

Perfiles soportados

LM, L2CAP, SDP, SPPP

Cédigo de
Frecuencia del Pais

América del Norte y Europa

Detalles del Médem Interno de
Espectro Ensanchado de TPS

La Tabla A-4 enumera las especificaciones generales del médem
interno de espectro ensanchado de TPS.

Tabla A-4. Especificaciones del M6dem Interno de Espectro Ensanchado de TPS

region/de acuerdo
con el propdsito

Generales
Rango de 902 a 928 MHz, Estados Unidos
frecuencia/pais/ 915 a 925 MHz, Australia

Estructura de la
sefal

Espectro ensanchado con salto de frecuencia

Patrén de salto

5 por banda, seleccionable por el usuario

Canales de salto 128
Ancho de banda 100 KHz
ocupado
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Especificaciones del Receptor

Tabla A-4. Especificaciones del M6dem Interno de Espectro Ensanchado de TPS

Técnica de FSK, 64 Kbps

modulacién de

frecuencia

Ganancia del 135 dB

sistema

Topologia de Red Punto a punto, punto a multipunto

Modo de operacién

trasmisor, Receptor, Repetidora

Protocolo

FHI15, FHO15+

Trasmisor (TX)

Energia de la
Portadora

250 mW (24 dBm)/1 W (30 dBm), seleccionable por el

usuario

Receptor (RX)

Sensibilidad

-105 dBm a 10-4 BER

Rango dindmico

105 dBm

Comunicaciones de datos

Interfaz serial

RS232

Velocidad de datos
seriales

9600, 19200, 38400, 57600 bps, seleccionable por el
usuario

Velocidad efectiva
del radio enlace

9600, 10200, 17000, 51000 bps
Seleccionalbe por el usuario para FH915; seleccién
automadtica para FH915+

Correccién de
errores

FEC (15.7), decodificacién por 16gica mayoritaria

Tipo de Antena

Tipo Cable flexible de 1/2 onda
Conector TNC de polaridad invertida
Ganancia 2.5 dBi
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Especificaciones

Detalles del Modulo GSM/GPRS

Opcional

La Tabla A-5 enumera las especificaciones internas generales para la
conexién del médem intenro para un médulo GSM/GPRS opcional.

Tabla A-5. Especificaciones del M6dulo GSM/GPRS

Sistemas operativos

EGSM: 900/1800 MHz;
GSM: 850/1900 MHz;

Alimentacion de
TX

0.6 W (850 MHz); 2 W (900 MHz); 1 W (1800/1900
MHz);

GPRS Multi-ranura clase 8 (4 de bajada; 1 de subida);
Velocidad de transferencia en baudios mdxima 85.6 Kbps;
Protocolo de multiplexacién Clase B GSM 07.10;
Esquema de codificacion CS1-CS4;

CSD Velocidad de transferencia en baudios maxima 14.4 Kbps;

SMS Modos Texto MO/MT y PDU;

trasmision por celdas;

A-12
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Especificaciones de los Conectores

Especificaciones de los
Conectores

El GR-3 posee un conector de antena para la trasmisién/recepcion de
sefiales de radio y tres conectores de puerto para la alimentacion y
carga/descarga de datos.

Conector RF del Radio (Médem)

El conector del médem (Tabla A-6) es un conector TNC de polaridad
invertida para espectro ensanchado.

Tabla A-6. Especificaciones del Conector de Médem

Médem Tipo T|po~de Dir Detalles
Sefial
Espectro TNC de Moédem I/0 /0 Salida RF/GSM de la
Ensanchad || polaridad antena del médem
o invertida

Conector de Alimentacion

Con borde rojo, el conector de alimentacién (Figura A-1) es un
receptaculo sellado, de 5 pines, con nimero de parte GSOF1C-
T0O5QF00-0000.

@
©
©)

Figura A-1. Conector de Alimentacion
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Especificaciones

La Tabla A-7 presenta las especificaciones del conector de
alimentacion.

Tabla A-7. Especificaciones del Conector de Alimentacién

Ndamero Nombr:e dela Dir Detalles
Sefial
1 Power_INP P Entrada de CC de 9 a 21 voltios
2 Power_INP P Entrada de CC de 9 a 21 voltios
3 Power_GND P Tierra, retorno de energia
4 Power_GND P Tierra, retorno de energia
5 Aux_Power P Entrada de CC de 9 a 21 voltios

Conector Serial C-RS232

Con borde negro, el conector serial RS232 (Figura A-2) es un
receptaculo cerrada, de 7 pines. Numero de Parte ODU G80F1C-
T07QC00-0000.
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Figura A-2. Conector Serial RS232
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Especificaciones de los Conectores

La Tabla A-8 presenta las especificaciones del conector de cables
RS232.

Tabla A-8. Especificaciones del Conector RS232

Namero Nombr:e dela Dir Detalles
Sefial
1 Sin utilizar
2 GND - Tierra de la sefial
3 CTS I Libre para envio
4 RTS (0] Solicitud de envio
5 RXD 1 Recibir datos
6 TXD (0] Transmitir datos
7 Sin utilizar

Conector USB

Con borde amarillo, el conector USB es un conector de cables de
TPS, recepticulo cerrado, de 4 pines (Figura A-3).

Figura A-3. Conector USB para Opciones GGD
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Especificaciones

La Tabla A-9 presenta las especificaciones del conector USB.

Tabla A-9. Especificaciones USB

Namero Nomb~re de Dir Detalles
Sefial
1 USB_PWR P Entrada de alimentacion del bus
2 USB D- 1/0 Datos menos
3 USB D+ 1/0 Datos mas
4 GND - Tierra
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Anexo B

Precauciones de
Seguridad

Precauciones Generales

Para cumplir con los requisitos de la exposicién a la
RF, mantenga una distancia de por lo menos 25cm
entre el usuo y el radio médem.

levantamiento y para usos relacionados con éstos
(es decir, el levantamiento de coordenadas,
distancias, dngulos y profundidades y para registrar
tales mediciones). Este producto nunca debe
utilizarse:

ADVERTENCIA)

' Los receptores de TPS se disefiaron para trabajos de

* Si el usuario no ha compredido a cabalidad el
presente manual.

* Después de desactivar los sistemas de seguridad
o efectuar modificaciones al producto.

* Si el sitio en que se va a efectuar el
levantamiento no ofrece las garantias necesarias.

» Trasgrediendo leyes, reglas y reglamentos
vigentes.

peligrosos. Pueden utilizarse en condiciones de

@ Nunca utilice los receptores de TPS en ambientes
lluvia o nieve pero durante un tiempo limitado.
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Precauciones de Seguridad

Precauciones con respecto al
Paquete de Baterias

&

iNunca intente abrir la carcasa de las baterias
desmontables! jLas baterias de Litio-Ion pueden ser
peligrosas si se manipulan en forma incorrecta!

&

No incinere o caliente el paquete de baterias por
encima de 212 grados Fahrenheit (100 grados
Celsius). Si las baterias se calientan demasiado, es
posible que se produzcan dafios serios e incluso que
explosionen.

La manipulacién de las baterias por parte de los
usuarios finales y/o técnicos no autorizados
invalidard la garantia del receptor.

* No intente abrir o cambiar el paquete de
baterias.

* No desarme el paquete de baterfas.

* No cargue las baterias en condiciones distintas a
las especificadas.

* Cargue las baterfas sélo en la forma indicada.
* No provoque cortocircuitos.

* No aplaste o modifique las baterias.
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Precauciones con respecto al Uso

Precauciones con respecto al

A Si el producto ha sufrido una caida, modificacion o
ey ha sido transportado o enviado sin el embalaje
A . . .
adecuado, o si es sometido a un trato inadecuado,
podria efectuar mediciones incorrectas.
El propietario debe someter a prueba este producto
en forma periddica para garantizar mediciones
precisas.
Si este producto no funciona correctamente,
informe a TPS de inmediato.
A Este producto podri ser revisado o reparado
@fswr»  Unicamente por los centros de servicio autorizados
A

por TPS.
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Precauciones de Seguridad

Notas:
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Anexo C

Informacion
Regulatoria

Las siguientes secciones ofrecen informacién acerca del
cumplimiento de este producto con las regulaciones gubernamentales
para el uso del mismo.

Conformidad con la FCC

Este dispositivo cumple con la Parte 15 de las reglas de la FCC. La
operacion se encuentra sujeta a las siguientes dos condiciones:

1. Este dispositivo no debe causar interferencia peligrosa; y

2. Este dispositivo debe aceptar las interferencias recibidas,
incluyendo aquellas que pudiesen provocar una operacion
indeseada.

Este equipo ha sido sometido a prueba y se ha determinado que
cumple con los limites establecidos para un dispositivo digital, de
conformidad con la Parte 15 de las reglas de la FCC. Estos limites se
establecieron para brindar una proteccion razonable frente a
interferencias peligrosas en instalaciones residenciales. Este eqipo
genera, utiliza y puede emitir energia de radiofrecuencia y en caso de
que no se instale o utilice de conformidad con las instrucciones,
podria causar una interferencia peligrosa a las comunicaciones
radiales. Sin embargo, no se garantiza que ocurra tal interferencia en
una instalacién en particular.

Si este equipo causa interferencia en la recepcién de equipos de radio
o television, lo cual puede determinarse apagando y encendiendo el
equipo, se recomienda al usuario intentar corregir la interferencia
tomando una o mas de las siguientes medidas:

* Reoriente o reubique la antena de recepcion.
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Informacion Regulatoria

* Aleje el equipo del receptor.

* Enchufe el equipo en un tomacorriente en un circuito distinto del
utilizado para alimentar al receptor.

* Consulte con el distribuidor o un técnico experimentado en radio/
television y solicitele sugerencias adicionales.

Cualquier cambio o modificacion al equipo que no
,RE‘:@(,N haya sido expresamente aprobado y que sea
— efectuado por la parte responsable de cumplir con
las regulaciones podria invalidar su autorizacién
para operar dicho equipo.

Conformidad del Producto con
los Requerimientos de la
Comunidad Europea

El producto que se describe en el presente manual cumple con las
directivas de R&TTE y EMC de la Comunidad Europea.
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Directiva WEEE

Directiva WEEE

La siguiente informacion se aplica tinicamente a los estados miembro
de la Unién Europea:

El uso del simbolo indica que este producto no debe tratarse como
desecho doméstico. Si se asegura de que este producto se elimine en
forma correcta, ayudard a evitar consecuencias negativas potenciales
para el medio ambiente y la salud humana que de lo contrario se
generarian como consecuencia de la manipulacién inadecuada de este
producto. Si desea obtener mds informacién con respecto a la
devolucién y reciclado de este producto, por favor pongase en
contacto con el distribuidor que le vendi6 el producto o consulte al
respecto.
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Notas:
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Anexo D

Terminos de la Garantia

Los equipos de posicionamiento laser y electrénico de TPS se
encuentran garantizados contra defectos en los materiales y
fabricacién siempre que los mismos se sometan a un uso normal y a
las aplicaciones que se describen en el presente Manual. El equipo se
encuentra garantizado durante el periodo que se indica en la tarjeta de
garantia que acompaiia al producto, el cual se inicial el dia en que el
producto es vendido al comprador original por los Distribuidores

Autorizados de TPS.!

Durante el periodo de garantia, TPS, segiin estime conveniente,
reparard o cambiard estre producto sin aplicar cargos adicionales. Las
partes reparadas y los repuestos se entregardn una vez que el
comprador devuelva los productos dafiados, y los mismos serdn
reacondicionados o nuevos. Esta garantia limitada no incluye el
servicio de reparacion por dafos sufridos por el producto que se
produzcan debido a un accidente, desastre, uso incorrecto, uso
excesivo o modificacién del producto.

El cliente puede solicitar el servicio de garantia a un distribuidor
autorizado para ofrecer servicios de garantia de TPS. Si el producto se
envia por correo, el comprador se compromete a asegurar el producto
0 a asumir el riesgo de pérdida o dafio durante el transporte, a
prepagar los cargos de embarque al lugar donde se brindaré el
servicio de garantia, a utilizar el empaque de embarque original o un
equivalente del mismo. El paquete debe incluir una carta en la que se
detalle el problema y/o defecto del equipo.

La tnica opcioén que tiene el comprador para cambiar el producto es
la que se especifica lineas arriba. En ningtin caso, TPS se hace
responsable por los dafios u otros reclamos que incluyan lucro

1. La garantia por defectos en una bateria, cargador o cable de Topcon es
de 90 dias.
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Términos de la Garantia

cesante, pérdida de ahorros u otros dafos incidentales o que resulten
del uso o de la incapacidad para utilizar el producto.
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